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Safety

The caution and danger statements that this document contains can be referenced
in the multilingual IBM Safety Information document that is provided with every IBM
TotalStorage DS4000 Storage Server. Each caution and danger statement is
numbered for easy reference to the corresponding statements in the translated
document.

» Danger: These statements indicate situations that can be potentially lethal or
extremely hazardous to you. A danger statement is placed just before the
description of a potentially lethal or extremely hazardous procedure, step, or
situation.

« Caution: These statements indicate situations that can be potentially hazardous
to you. A caution statement is placed just before the description of a potentially
hazardous procedure step or situation.

» Attention: These notices indicate possible damage to programs, devices, or
data. An attention notice is placed just before the instruction or situation in which
damage could occur.

Before installing this product, read the following danger and caution notices.

© Copyright IBM Corp. 2004 iii



Statement 1:

A A

DANGER

Electrical current from power, telephone, and communication cables is
hazardous.

To avoid a shock hazard:

* Do not connect or disconnect any cables or perform installation,
maintenance, or reconfiguration of this product during an electrical
storm.

» Connect all power cords to a properly wired and grounded electrical
outlet.

« Connect to properly wired outlets any equipment that will be attached to
this product.

* When possible, use one hand only to connect or disconnect signal
cables.

* Never turn on any equipment when there is evidence of fire, water, or
structural damage.

» Disconnect the attached power cords, telecommunications systems,
networks, and modems before you open the device covers, unless
instructed otherwise in the installation and configuration procedures.

» Connect and disconnect cables as described in the following table when
installing, moving, or opening covers on this product or attached
devices.

To Connect: To Disconnect:

Turn everything OFF. Turn everything OFF.
First, attach all cables to devices.
Attach signal cables to connectors.
Attach power cords to outlet.

Turn device ON.

First, remove power cords from outlet.
Remove signal cables from connectors.
Remove all cables from devices.
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Statement 3:

A

CAUTION:
When laser products (such as CD-ROMs, DVD drives, fiber optic devices, or
transmitters) are installed, note the following:

* Do not remove the covers. Removing the covers of the laser product could
result in exposure to hazardous laser radiation. There are no serviceable
parts inside the device.

» Use of controls or adjustments or performance of procedures other than
those specified herein might result in hazardous radiation exposure.

A

DANGER

Some laser products contain an embedded Class 3A or Class 3B laser
diode. Note the following.

Laser radiation when open. Do not stare into the beam, do not view directly
with optical instruments, and avoid direct exposure to the beam.

Class 1 Laser statement

Cless 1 Laser Product
Lager Klasse 1

Lasar Klass 1

Luiesmn 1 _Lasaﬂaha

Apparall A Laser de Classs 1

IEC 825-11993 CENELEC EN 60 825
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Statement 4:

A

= 18 kg (39.7 Ib) = 32 kg (70.5 Ib)

= 55 kg (121.2 Ib)

CAUTION:
Use safe practices when lifting.

Statement 5:

A A

CAUTION:

The power control button on the device and the power switch on the power
supply do not turn off the electrical current supplied to the device. The device
also might have more than one power cord. To remove all electrical current
from the device, ensure that all power cords are disconnected from the power

source.

VAN
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Statement 8:

A A

CAUTION:
Never remove the cover on a power supply or any part that has the following
label attached.

& A\

Hazardous voltage, current, and energy levels are present inside any
component that has this label attached. There are no serviceable parts inside
these components. If you suspect a problem with one of these parts, contact
a service technician.

Safety  Vii
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About this document

This document describes procedures for adding new Fibre Channel or SATA hard
drives or new IBM TotalStorage DS4000 drive expansion enclosures containing new
Fibre Channel or SATA hard drives to an existing IBM DS4000 Storage Server
configuration. This document also describes the procedure for migrating either Fibre
Channel hard drives or IBM TotalStorage DS4000 storage expansion enclosures
containing Fibre Channel hard drives from one DS4000 storage subsystem to

another.

FAStT product renaming

IBM is in the process of renaming some FASIT family products.|Table 1|identifies
each new DS4000 product name with its corresponding FAStT product name. Note
that this change of product name only indicates no change in functionality or

warranty. All products listed below with new names are functionally-equivalent and
fully-interoperable. Each DS4000 product retains full IBM service as outlined in
service contracts issued for analogous FAStT products.

Table 1. Mapping of FAStT names to DS4000 Series names

Current FASET Product Name

New DS4000 Product Name

IBM TotalStorage FAStT Storage Server

IBM TotalStorage DS4000

FAStT DS4000

FAStT Family DS4000 Mid-range Disk System
FAStT Storage Manager vX.Y (for example DS4000 Storage Manager vX.y (for example
9.10) v9.10)

FAStT100 DS4100

FAStT600 DS4300

FAStT600 with Turbo Feature DS4300 Turbo

FAStT700 DS4400

FAStT900 DS4500

EXP700 DS4000 EXP700

EXP100 DS4000 EXP100

FAStIT FlashCopy FlashCopy for DS4000

FASIT VolumeCopy VolumeCopy for DS4000

FAStT Remote Mirror (RM)

Enhanced Remote Mirroring for DS4000

FASIT Synchronous Mirroring

Metro Mirroring for DS4000

Global Copy for DS4000
(New Feature = Asynchronous Mirroring
without Consistency Group)

Global Mirroring for DS4000
(New Feature = Asynchronous Mirroring with
Consistency Group)

© Copyright IBM Corp. 2004
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Who should read this document

This document is intended for system administrators who are familiar with the IBM
TotalStorage DS4000 storage subsystem components, terminology, and DS4000
Storage Server administrative tasks.

lHlustrations

lllustrations contained in this document depict general visual characteristics of the
DS4000 Storage Server, storage expansion unit, and fibre channel drive hardware
cited. They are not intended for use as detailed DS4000 storage hardware images.

Using this document

Before you proceed to complete any storage addition or migration procedures
detailed in this publication, familiarize yourself with the principles, prerequisite
instructions at[Chapter 2, “Prerequisites to adding capacity and hard drive]
Imigration,” on page 37,/as well as the following storage addition or migration
procedures applicable to your specific need.

+ [Chapter 3, “Adding one or more new hard drives,” on page 47|

+ [Chapter 4, “Migrating one or more hard drives,” on page 53

+ [Chapter 5, “Adding expansion units containing new hard drives,” on page 61|
+ [Chapter 6, “Migrating expansion units containing hard drives,” on page 79|

+ [Chapter 7, “Upgrading a storage server in a functioning configuration,” on pagel
9

Your familiarity with the principles, preliminary procedures, and detailed steps
described in this document is critical to prevent loss of data availability, and in some
cases, loss of data. If you have questions about the procedures described in this
document, please contact the IBM Help Center in your geography for assistance.

Important:

1. Do not mix SATA and Fibre Channel drives in the same enclosure.
2. Do not place SATA drives in a fibre channel enclosure.

3. Do not place fibre channel drives in a SATA enclosure.
4

Do not mix SATA drive expansion enclosures (EXP100) and Fibre channel drive
enclosures (EXP710 and EXP500) in the same drive loop or the same DS4000
Storage Server unless you purchase the fibre channel/SATA intermix premium

feature entitlement and upgrade the controller firmware to 06.10.11.xx or higher.

DS4000 installation process overview

The following flow chart gives an overview of the DS4000 hardware and the
DS4000 Storage Manager software installation process. Lined arrows in the flow
chart indicate consecutive steps in the hardware and software installation process.
Labeled arrows indicate which current documents provide detailed information about
those steps.
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Install Process Documentation

Plan installation

Install Storage
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A 4

Install Storage
Expansion Unit(s)

v

Make FC Connections

—

SET Link Speed
(1GB or 2GB)
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Install Network
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Network Connection

* FC Planning and
Integration: User's Guide
and Svc Info

DS4000 Storage Manager
Concepts Guide

Connect Power and

Start Server

y

DS4000 Storage Svr
Installation Guide
DS4000 RAID Controller

Enclosure Unit Install
and User's Guide

Verify Server
operation w/ LEDs

DS4000 Storage Server

Installation Guide

DS4000 Hardware
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Determination Guide
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Configure Storage
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DS4000 Storage
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DS4000 Storage Manager
Copy Services
User's Guide

Online Help

sj001046

Figure 1. Installation process flow by current publications

DS4000 Storage Server publications

The following tables present an overview of the DS4500, DS4400, DS4300 Fibre
Channel, and DS4100 SATA Storage Server product libraries, as well as other
related documents. Each table lists documents that are included in the libraries and
what common tasks they address.

You can access the documents listed in these tables at one of the following Web

sites:

www-1.ibm.com/servers/storage/support/disk/]

www.ibm.com/shop/publications/order/|

DS4500 storage server library

[Table 2 on page xx| associates each document in the DS4500 (previously

FAStT900) storage server library with its related common user tasks.

About this document
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Table 2. TotalStorage DS4500 storage server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotalStorage
FAStT900
Installation and
Support Guide,
GC26-7530

IBM TotalStorage
FAStT900 Fibre
Channel Cabling
Instructions,
24P8135

IBM TotalStorage
FAStT900 Storage
Server User’s
Guide, GC26-7534

IBM TotalStorage
FAStT FC2-133 Dual
Port Host Bus
Adapter Installation
and User’s Guide,
GC26-7532

IBM FAStT FC2-133
Host Bus Adapter
Installation and
User’s Guide,
48P9823

IBM TotalStorage
FASIT Rack
Mounting
Instructions,
19K0900

IBM FAStT
Management Suite
Java User’s Guide,
32P0081

IBM TotalStorage
DS4000 Hardware
Maintenance
Manual, GC26-7702

IBM TotalStorage
DS4000 Problem
Determination
Guide, GC26-7703
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DS4400 storage server library

associates each document in the DS4400 (previously FAStT700) storage
server library with its related common user tasks.

Table 3. TotalStorage DS4400 storage server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM FAStT700 Fibre
Channel Cabling
Instructions,
32P0343

IBM FAStT700 Fibre
Channel Storage
Server User’s
Guide, 32P0341

IBM FASIT FC2-133
Dual Port Host Bus
Adapter Installation
and User’s Guide,
GC26-7532

IBM TotalStorage
FASIT FC2-133 Host
Bus Adapter
Installation and
User’s Guide,
48P9823

IBM FAStT
Management Suite
Java User’s Guide,
32P0081

IBM TotalStorage
DS4000 Hardware
Maintenance
Manual, GC26-7702

IBM TotalStorage
DS4000 Problem
Determination
Guide, GC26-7703
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DS4300 storage server library

associates each document in the DS4300 (previously FAStT600) storage
server library with its related common user tasks.

Table 4. TotalStorage DS4300 storage server document titles by user tasks

Title User Tasks

Planning |Hardware Software Configuration |Operation and |Diagnosis and
Installation Installation Administration | Maintenance

IBM TotalStorage
FAStT600 Fibre
Channel Storage
Server Installation
and User’s Guide,
GC26-7531

IBM TotalStorage
DS4000 Hardware
Maintenance
Manual, GC26-7702

IBM TotalStorage
DS4000 Problem
Determination
Guide, GC26-7703

IBM TotalStorage
FAStT FC2-133 Host
Bus Adapter
Installation and
User’s Guide,
48P9823

IBM TotalStorage
FAStT FC2-133 Dual
Port Host Bus
Adapter Installation
and User’s Guide,
GC26-7532

IBM TotalStorage
FAStT600 Rack
Mounting I -
Instructions,
24P8125

IBM TotalStorage
FAST600 Fibre
Channel Cabling 4 I
Instructions,
24P8126

DS4100 storage server library

[Table 5 on page xxiiil associates each document in the DS4100 (previously
FAStT100) storage server library with its related common user tasks.
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Table 5. TotalStorage DS4100 storage server document titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotalStorage
DS4100 Installation,
User’s, and
Maintenance Guide,
GC26-7712

IBM TotalStorage
DS4100 Fibre
Channel Cabling
Instructions,
25R0325

IBM TotalStorage
FAStT FC2-133 Dual
Port Host Bus
Adapter Installation
and User’s Guide,
GC26-7532

IBM FASIT FC2-133
Host Bus Adapter
Installation and
User’s Guide,
48P9823

IBM TotalStorage
DS4000 Hardware
Maintenance
Manual, GC26-7702

IBM TotalStorage
DS4000 Problem
Determination
Guide, GC26-7703
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DS4000-related hardware publications

associates each of the following documents related to DS4000 (previously
FAStT) operations with its related common user tasks.

Table 6. TotalStorage DS4000-related document titles by user tasks

Title User Tasks
Planning |Hardware Software Configuration |Operation and |Diagnosis and
Installation Installation Administration | Maintenance
IBM Safety
Information, %
P48P9741
IBM TotalStorage
FAStT Quick Start [ e

Guide, GC26-7662

IBM TotalStorage
DS4000 Fibre
Channel and Serial
ATA Intermix % e e [
Premium Feature
Installation Overview
GC26-7713

IBM TotalStorage
DS4000 EXP100
Storage Expansion
Unit Installation, P o 1/ o p
User’s, and
Maintenance Guide,
GC26-7694

Fibre Channel
Solutions - IBM
FASIT EXP500
Installation and
User’s Guide,
59P5637

IBM TotalStorage
FAStT EXP700 and
EXP710 Storage
Expansion Units I I e e P
Installation, User’s,
and Maintenance
Guide, GC26-7647

IBM TotalStorage
DS4000 Hard Drive
and Storage
Expansion
Enclosure
Installation and
Migration Guide,
GC26-7704

IBM Fibre Channel
SAN Configuration
Setup Guide,
25P2509

XXiV  Adding and Migrating Drives and Expansion Enclosures to DS4000 Storage Servers



Table 6. TotalStorage DS4000-related document titles by user tasks (continued)

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM FAStT Host
Adapter Installation
and User’s Guide,
59P5712

RS/6000 @server
pSeries Fibre
Channel Planning
and Integration:
User’s Guide and
Service Information,
SC23-4329

DS4000 Storage Manager Version 9 publications
[Table 7] associates each document in the DS4000 Storage Manager (previously

FASIT Storage Manager) library with its related common user tasks.

Table 7. TotalStorage DS4000 Storage Manager Version 9 titles by user tasks

Title

User Tasks

Planning

Hardware
Installation

Software
Installation

Configuration

Operation and
Administration

Diagnosis and
Maintenance

IBM TotalStorage
DS4000 Storage
Manager Version 9
Installation and
Support Guide for
Windows
2000/Server 2003,
NetWare, ESX
Server, and Linux,
GC26-7706

IBM TotalStorage
DS4000 Storage
Manager Version 9
Installation and
Support Guide for
AlIX, UNIX, Solaris
and Linux on
POWER,
GC26-7705

IBM TotalStorage
DS4000 Storage
Manager Version 9
Copy Services
User’s Guide,
GC26-7707

IBM TotalStorage
FASItT Storage
Manager Version 9
Concepts Guide,
GC26-7661

About this document
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How to send your comments

Your feedback is important to help us provide the highest quality of information. If
you have any comments about this document, please either fill out the Readers’
comments form (RCF) at the back of this document and give it to an IBM
representative, or submit it in one of the following ways:

e E-mail

Submit your comments over the Internet to:

[starpubs @ us.ibm.com|
— Submit your comments over IBMLink™ from the U.S.A. to:

STARPUBS at SUIEVM5
— Submit your comments over IBMLink from Canada to:

STARPUBS at TORIBM
— Submit your comments over IBM Mail Exchange to:

USIB3WD at IBMMAIL

Be sure to include the name and order number of the document and, if
applicable, the specific location of the text that you are commenting on, such as
a page or table number.

+ Mall
Complete the Readers’ comments form (RCF) at the back of this document and

return it by mail. If the RCF Business Reply Mailer has been removed, you may
address your comments to:

International Business Machines Corporation
Information Development

Dept. GZW

9000 South Rita Road

Tucson, Arizona 85744-0001

U.S.A.
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Chapter 1. Introduction

Scalability is a primary attribute of the IBM TotalStorage DS4000 Storage Server
family. Whenever the need arises, you can expand a DS4000 Storage Server from
its minimum to its maximum capacity configuration. To expand DS4000 Storage
Server configurations you can purchase additional equipment or, in some cases,
migrate equipment from DS4000 Storage Server configurations previously deployed.

The typical DS4000 Storage Server drive connects to both Controller A and
Controller B. Taken together, these connections represent a dual drive loop or a
redundant drive loop pair. You must connect drive loops in pairs to enable
redundant drive loop configurations (two data paths per drive enclosure).

provides a list of the maximum allowable number of drives and drive loop
pairs for each DS4000 Storage Server by machine type and model number. It also
specifies storage expansion enclosure license requirements.

— Important:
Do not intermix fibre channel devices (such as the DS4300 Storage Server
and EXP500 storage expansion enclosure) and SATA devices (such as the
DS4100 Storage Server and EXP100 storage expansion enclosure) in the
same storage subsystem environment unless you purchase the fibre
channel/SATA intermix premium feature entitlement and upgrade the DS4000
Storage Server controller firmware to 06.10.11.xx or higher. See f‘lntermix
instructions for SATA and fibre channel storage expansion enclosures” on
page 14_1|for more information.

Table 8. Maximum allowable drives and drive loop pairs in DS4000 storage servers

Maximum Storage
Maximum number of |expansion unit
Machine | Model number of |drive loop |license
Product name type number |drives pairs requirement
IBM TotalStorage 1724 1SC 14 0 None
DS4100 Storage
Server (Single
Controller model)
IBM TotalStorage 1724 100 56 1 None
DS4100 Storage
Server
IBM TotalStorage 3542 1RU 38 1 None
FAStT200 Fibre 1RX
Channel Storage
Server
IBM TotalStorage 2RU 66 1 None
FAStT200 High 2RX
Availability (HA)
Fibre Channel
Storage Server’
IBM TotalStorage 3552 1RU 224 2 None
FAStT500 Fibre 1RX
Channel Storage
Server?
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Table 8. Maximum allowable drives and drive loop pairs in DS4000 storage

servers (continued)

Maximum | Storage
Maximum number of |expansion unit
Machine | Model number of |drive loop |license
Product name type number |drives pairs requirement
IBM TotalStorage 1722 60X 56 1 Purchase
DS4300 Fibre 60U storage
Channel Storage expansion unit
Server entitlements in
increments up to
three storage
expansion units
per DS4300
Storage Server.
IBM TotalStorage 112 1 None. The
DS4300 Fibre DS4300 (with
Channel Storage Turbo option)
Server (with Turbo includes a
option) seven storage
expansion unit
entitiement.
IBM TotalStorage 6LU 14 0 None. The
DS4300 Fibre 6LX DS4300 Single
Channel Storage Controller
Server (Single Storage Server
Controller model) does not
support storage
expansion
enclosure
attachment.
IBM TotalStorage 1742 1RU 224 2 None
DS4400 Fibre 1RX
Channel Storage
Server?
IBM TotalStorage 1742 90X 224 2 None
DS4500 Fibre 90U

Channel Storage
Server?

Notes:

1. The maximum number of drives supported by the FAStT200 HA Storage Server
(models 2RU and 2RX) assumes attachment to 4 14-drive storage expansion
enclosures containing 56 fibre channel drives.

2. The maximum number of drives supported by FAStT500, DS4400, and DS4500
storage servers assumes their attachment to 16 14-drive storage expansion

enclosures.

Intermixing storage expansion enclosures

Information on the following subjects appears in this section:

« [Intermixing EXP500 and EXP700 storage expansion enclosures|

« [Intermixing EXP700 or EXP100, and EXP710 storage expansion enclosures|

« [Intermix instructions for SATA and fibre channel storage expansion enclosures|

— [Compatible storage servers|
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— [Grouping storage expansion enclosure types|
— [DS4300 Turbo intermix configuration restriction|
« [Intermix scenarios and procedures for SATA/fibre channel

For hardware compatibility, ensure that the environmental service module (ESM)
firmware for each storage expansion enclosure and the storage server controller
firmware are either at or above the levels that are recommended in
lpage 39 and|Table 25 on page 40|

DS4000 storage servers support the addition of external drive enclosures by:

+ providing additional storage capacity (as in the case of DS4400 and DS4500
storage servers).

» enabling the expansion of a storage subsystem’s capacity beyond that of a given
DS4000 Storage Server chassis (as in the case of DS4100 and DS4300 storage
servers)

When increasing the capacity of your storage subsystem in either of these ways,
you might choose to add external drive enclosures of the same model and type or
of different types. IBM does not support the combination of every DS4000 external
drive enclosure type and model in every DS4000 Storage Server configuration.
Restrictions on the connection of drive enclosures that differ by model and type to
DS4000 storage servers are documented in this section.

indicates what DS4000 expansion enclosures may coexist in the same
redundant drive loop of a DS4000 storage subsystem by model.

Table 9. Mixed DS4000 expansion enclosure compatibility in storage subsystems by model

DS4000 expansion DS4000 DS4000 DS4000 DS4000

enclosure EXP100 EXP500 (Fibre |EXP700 (Fibre |EXP710 (Fibre
(SATA) Channel) Channel) Channel)

IBM TotalStorage - »HA e 2 |

DS4000 EXP100

(SATA)

IBM TotalStorage e 4 | v

DS4000 EXP500 (Fibre (1 Gbps only) | (1 Gbps only)

Channel)

IBM TotalStorage »HA v v +»B

DS4000 EXP700(Fibre (1 Gbps only)

Channel)

IBM TotalStorage +»HA B +»B

DS4000 EXP710 (Fibre

Channel)
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Table 9. Mixed DS4000 expansion enclosure compatibility in storage subsystems by
model (continued)

Requires controller firmware 05.41.xx.xx (DS4300, Base model), 05.42.xx.xx (DS4100),
or 06.10.11.xx (DS4300 with Turbo option, DS4400, and DS4500) or higher.

Note: There are versions of 05.41.xx.xx controller firmware that also provide DS4000
EXP100 support for DS4300 (with Turbo option), DS4400, and DS4500 storage servers.
However, IBM recommends that you use controller firmware version 06.10.xx.xx for the
DS4300 (with Turbo option), DS4400, and DS4500 storage servers, instead.

H Supported only with fibre channel/SATA intermix entitlement purchase and controller
firmware version 06.10.11.xx or higher.

E Requires controller firmware 05.2x.xx.xx or higher.
B Requires controller firmware 04.xx.xx.xx or higher.

B Requires controller firmware 06.10.11.xx or higher.

indicates what DS4000 expansion enclosures may attach to DS4000
storage servers by model.

Table 10. DS4000 expansion enclosure compatibility with DS4000 storage servers by model

DS4000 storage DS4000 DS4000 DS4000 EXP700 | DS4000 EXP710

device EXP100 EXP500 (Fibre |(Fibre Channel) |(Fibre Channel)
(SATA) Channel)

DS4100 Storage I

Server (Base

model, SATA)

DS4100 Storage
Server (Single
Controller model,

SATA)

FAStT200 Storage I 4
Server (Fibre (1 Gbps only) (1 Gbps only)
Channel)

FAStT500 Storage I I
Server (Fibre (1 Gbps only) (1 Gbps only)
Channel)

DS4300 Storage - v
Server (Base

model, Fibre

Channel)

DS4300 Storage
Server (Single
Controller model,
Fibre Channel)

DS4300 Storage A H »A Al
Server (Turbo

option, Fibre
Channel)

DS4400 Storage +»HH I »HA Al
Server (Fibre (1 Gbps only)
Channel)
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Table 10. DS4000 expansion enclosure compatibility with DS4000 storage servers by
model (continued)

DS4500 Storage »HA e A Al
Server (Fibre (1 Gbps only)
Channel)

While the DS4300 Storage Server (Base model) will support fibre channel or SATA
drives, it will not support both in a mixed environment. It will, however, support SATA drives
in an attached storage enclosure (only), but never in the DS4300 Storage Server, itself. In
addition, before the DS4300 Storage Server (Base model) will support a DS4000 EXP100
drive enclosure, it is necessary to remove all fibre channel drives from the DS4300 chassis,
which will require controller firmware 05.41.5x.xx.

H The intermix of DS4000 EXP700 and EXP710 fibre channel drive enclosures with
DS4000 EXP100 SATA drive enclosures in a given DS4000 Storage Server is supported
only with fibre channel/SATA intermix entitlement purchase and controller firmware version
06.10.11.xx or higher.

DS4000 storage servers require the following firmware to manage EXP100 expansion
enclosures.

DS4300 Turbo and DS4500
Either 05.41.5x.xx or 06.1x.xx.xx. Version 06.1x.xx.xx or higher is recommended.

DS4400
06.10.xx.xx or higher

B Requires controller firmware version 06.1x.xx.xx or higher.

Currently, IBM supports three different storage expansion enclosure models -
EXP100, EXP700 and EXP710.Iists those drive expansion enclosure
models that are considered of the same storage enclosure type for the purpose
grouping together in an intermixed SATA/fibre channel storage expansion enclosure
loop configuration.

Table 11. DS4000 drive expansion enclosure models compatible in intermixed loop
configurations only when contiguously grouped

Group-compatible EXP100 Group-compatible EXP700 Group-compatible
models models EXP710 models
1710-10X 1740-1RU 1740-710
1710-10U 1740-1RX 1740-1RU"
1724-1XP 1740-1RX"

1. Consider and treat this EXP700 model as an EXP710 for grouping purposes only once
upgraded with the DS4000 EXP700 field upgrade to switched ESMs.

You can mix DS4000 TotalStorage EXP500 (which operates only at 1 Gbps) and
DS4000 TotalStorage EXP700 (which operates at either 1 Gbps or 2 Gbps) storage
expansion enclosures in the same redundant drive loop pair in all DS4400 and
DS4500 Storage Server configurations. You cannot, however, mix these enclosures
in the same redundant drive loop pair in DS4100 and DS4300 Storage Server
configurations.

The DS4300 Storage Server (models 60X and 60U) support only 2 Gbps fibre
channel storage expansion enclosures, such as the DS4000 EXP700 or the
DS4000 EXP100. See [Table 10 on page 4| There is no restriction to the physical
sequence of mixed EXP700 and EXP500 expansion units in the same redundant
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drive loop pair. See [‘Intermixing EXP500 and EXP700 storage expansion|
fenclosures” on page 7| for additional information.

When connecting the DS4000 EXP500 and EXP700 enclosures in the same
DS4000 Storage Server, although the EXP700 storage expansion enclosure is
capable of operating at 2 Gbps, you must set the fibre channel speed of drive loops
in a mixed storage expansion enclosure environment to the lowest fibre channel
speed supported by all hardware in the loop, which is 1 Gbps. If one of the drive
loops in a DS4000 Storage Server configuration is set to 1 Gbps, you must set all
of the drive loops to 1 Gbps. This speed restriction applies to all four drive loops in
either the DS4400 or DS4500 Storage Server configuration, even where some of
the drive loops consist only of EXP700 storage expansion enclosures that might
otherwise operate at 2 Gbps.

Although you can intermix DS4000 EXP700 storage expansion enclosures and
DS4000 EXP100 with EXP710 storage expansion enclosures in the same
redundant drive loop pair in a DS4000 Storage Server configuration, you must
group together all DS4000 EXP710 storage expansion enclosures in the redundant
drive loop. See [Intermixing EXP700 or EXP100, and EXP710 storage expansion|
fenclosures” on page 8/ and|[Table 11 on page 5|for additional information.

Do not intermix DS4000 EXP500 (which operates only at 1 Gbps) and DS4000
EXP710 or EXP100 (which operate only at 2 Gbps) storage expansion enclosures
in the same redundant drive loop pair. Also, do not attach these storage expansion
enclosures to the same controller.

Though there are no restrictions against cabling DS4000 EXP100 and DS4000
EXP700 storage expansion units together. For ease of future maintenance and
possible troubleshooting, however, IBM recommends that you group or plan your
configuration to allow for grouping of all DS4000 drive expansion enclosures by
type in a DS4000 Storage Server redundant drive loop, if possible.

Important:
Even though IBM supports intermixing different drive expansion enclosure
models in the same redundant drive loop, we recommend use of a single drive
expansion enclosure model (for example, EXP100, EXP500, EXP700, or
EXP710) in a given redundant drive loop. This is the best practice.

Important: Do not change the speed of a drive loop while the DS4000 Storage
Server is powered on. Such a speed change will cause unpredictable results. To
change the speed of a drive loop:

__Step 1. Prepare applications for DS4000 Storage Server shutdown.
__Step 2. Shutdown the DS4000 Storage Server.

__ Step 3. Shutdown the DS4000 storage expansion enclosures.
__Step 4. Change the fibre channel speed settings.

__ Step 5. Power on the DS4000 storage expansion enclosures.
__Step 6. Power on the DS4000 Storage Server.

__Step 7. Restore DS4000 Storage Server host application operations.

Note: For additional information on turning a storage server on and off, see the

appropriate DS4000 Storage Server installation and user’s guide. For more
information on these guides, see the following Web site:
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www.ibm.com/servers/storage/support/disk/|

See ['DS4000 Storage Server drive loop schemes” on page 25| and [‘Setting|
fenclosure IDs” on page 30| for details on cabling DS4000 storage servers and
storage expansion enclosures together as well as setting their enclosure IDs.

Intermixing EXP500 and EXP700 storage expansion enclosures

illustrates cabling of DS4000 TotalStorage EXP500 and EXP700 storage
expansion enclosures in a mixed configuration.

Minihub speed
must be set to

STeTOTO v v Vv v 1 ?bpsdf(.)r all
@ @ @ @ ZDZ %g:] @ @ @ @ minihubs
0o S EEEannn
wlislislin ——~ |\f|eHali
o |o |o |o RN

DS4400 Storage Server
Drive loop
A

ﬁn. [= Dnm.m/; ‘r

[ ] o/ [ ] OD(D)DH
7/0 /éouuuuu

gessa 0 o = e 0 © =
VA VA

i e |

Drive loop
+«—B

!

=]

[]

l EXP500 and

j.g é.% EXP700 drive
H H H enclosures are

() in the same

[ ] ] o | EB L] o DDDHHH drive loop
o | M- 10000

DS4000 EXP700

Figure 2. DS4000 EXP500 and EXP700 cabling in a mixed configuration

There are maximum limits to the number of fibre channel hard drives that you can
configure in redundant drive loop pairs. The maximum number of drives dictates a
fixed number of supported EXP500 and EXP700 drive enclosure
combinations|Table 12 on page 8|lists the numbers of EXP500 and EXP700 storage
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expansion enclosures that you can combine for use in a single redundant drive loop
pair. assumes that a DS4000 Storage Server is generally capable of
addressing the maximum of 112 fibre channel hard drives for each redundant drive
loop pair.

Important: IBM supports only those EXP500 and EXP700 Storage Expansion Unit
combinations listed in|Table 12

Table 12. Supported EXP500 and EXP700 combinations per maximum redundant drive loop

pair drives
Total number of

Total number of EXP700 Maximum number of | Maximum number
EXP500 enclosures enclosures per storage expansion of drives per
per redundant drive |redundant drive units per redundant |redundant drive
loop pair loop pair drive loop pair loop pair

11 0 11 110

10 0 10 100

9 1 10 104

8 2 10 108

7 3 10 112

6 3 9 102

5 4 9 106

4 5 9 110

3 6 9 114

2 6 8 104

1 7 8 108

0 8 8 112

Note: The combination of three EXP500 and six EXP700 storage expansion
enclosures has the maximum number of 114 drives per redundant drive loop
pair. You can have this maximum number of hard drives per drive loop pair
only in this mixed EXP500 and EXP700 configuration.

Intermixing EXP700 or EXP100, and EXP710 storage expansion
enclosures

Attention: Before intermixing EXP710 and EXP100 drive expansion enclosures in
a DS4000 Storage Server you must purchase IBM TotalStorage DS4000 SATA and
fibre channel storage expansion enclosure intermix entitlement and carefully read
this section as well as ['Intermix instructions for SATA and fibre channel storage]
fexpansion enclosures” on page 14

It is possible to intermix EXP700 or EXP100, and EXP710 storage expansion
enclosures in the same drive loop. To do so, however, you must group all of the
EXP710 storage expansion enclosures together to enable the EXP710 Reliability
and Serviceability (RAS) features and to optimize the data transfering between the
EXP710 enclosures. [Figure 3 on page 10| through [Figure 4 on page 11 illustrate two
acceptable EXP700 and EXP710 intermixing cabling configurations in which all
EXP710 storage expansion enclosures are grouped together. [Figure 5 on page 12|
shows an acceptable configuration that is not recommended because it may later
present cabling problems when you may choose to add new EXP710 drive
enclosures to a redundant drive loop that is already configured. [Figure 6 on page|
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and [Figure 7 on page 14| show two unacceptable intermixed configurations in
which all EXP710 storage expansion enclosures are not grouped together.

These intermixing requirements must also be met if you are upgrading some (but
not all) of the EXP700 storage expansion enclosures in a drive loop with the
EXP700 Models 1RU/1RX Switched-ESM Option Upgrade Kit (P/N 25R0166). Once
upgraded, these EXP700 drive expansion enclosures are considered EXP710 drive
expansion enclosures, even though the machine type and models may be still be
shown as EXP700 machine types and models.

Important:
IBM does not support any configuration in which EXP710 drive expansion
enclosures are not grouped together.

[Figure 3 on page 10|though [Figure 5 on page 12|show three acceptable EXP700
and EXP710 intermixing cabling configurations in which all EXP710 storage
expansion enclosures are grouped together. Note that in|Figure 5 on page 12} the
EXP710 storage expansion enclosures are grouped together, even though the
EXP700 storage expansion enclosures are not grouped together.

Although illustrations [Figure 3 on page 10| through [Figure 7 on page 14|incorporate
the DS4000 DS4300 Storage Server for the sake of example, other DS4000
storage servers may be acceptable replacements. The DS4000 EXP100 would also
intermix successfully with an EXP710 when substituted for an EXP700 in an
equivalent loop configuration.
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Figure 3. Acceptable intermixed EXP700 (or EXP100) and EXP710 loop configuration (1 of 3)
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Figure 4. Acceptable intermixed EXP700 (or EXP100) and EXP710 loop configuration (2 of 3)
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Figure 5. Acceptable (not recommended) intermixed EXP700 (or EXP100) and EXP710 loop
configuration (3 of 3)

In|Figure 6 on page 13|and|Figure 7 on page 14} the intermixed configurations
shown are not supported because the EXP710 storage expansion enclosures in the
redundant drive loop are not grouped together. When substituting a DS4000
EXP100 for an EXP700 enclosure in an equivalent drive loop cabling configuration,
the intermixed drive loop cabling is also not supported.
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Figure 6. Unacceptable intermixed EXP700 (or EXP100) and EXP710 loop configuration (1 of
2)
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Figure 7. Unacceptable intermixed EXP700 (or EXP100) and EXP710 loop configuration (2 of
2)

Intermix instructions for SATA and fibre channel storage expansion
enclosures
1. To use the SATA/fibre channel intermix storage expansion enclosure premium
feature upgrade, perform the following steps:

a. Purchase an IBM TotalStorage DS4000 SATA and fibre channel storage
expansion enclosure intermix entitlement. Contact your IBM reseller or
representative for additional information.

b. Upgrade your DS4000 ESM firmware to the level that is compatible with
each particular enclosure type.

14  Adding and Migrating Drives and Expansion Enclosures to DS4000 Storage Servers



Attention: Complete any required ESM code upgrades before you perform
any other code upgrades.

able 13|indicates the ESM firmware level currently supported for each
enclosure type:

Table 13. Storage expansion enclosure ESM firmware levels

Storage expansion enclosure

type ESM firmware Level
EXP100 9554

EXP700 9326"

EXP710 9627

1.

You must upgrade the EXP700 ESM firmware to the 9326 level before you upgrade the
DS4000 Storage Server controller firmware to version 06.1x.xx.xx.

If necessary, upgrade your host software to DS4000 Storage Manager version 9.10, or
higher.

If necessary, upgrade your host software to DS4000 Storage Manager version
9.10 or later.

Upgrade your DS4000 storage server controller firmware to version 06.10.11.xx
or later to use with DS4000 Storage Manager host software version 9.10 or
later.

The controller firmware and the host software are available for download over
the Internet from the DS4000 Storage Manger Version 9.1 web page:

[www-1.ibm.com/servers/storage/support/disk/]

To implement the fibre channel/SATA Intermix feature, download the appropriate
NVSRAM file from the DS4000 Storage Server NVSRAM Support for DS4000
FC/SATA Enclosure Intermix CD that is associated with your host operating
system. The file is located on the CD in a directory associated with your
DS4000 model as follows:

e \nvsram\ds4300turbo
e \nvsram\ds4400
* \nvsram\ds4500

The DS4000 fibre channel/SATA Intermix premium feature is entitled and
requires the use of a feature key to enable the option. IBM requires the feature
activation code printed on the IBM SATA/Fibre Channel intermix premium
feature activation card in order to assign a feature key identifier. IBM also
requires the controller unit’s IBM serial number printed on the label on the rear
of each DS4000 Storage Server.

Attention: Although the IBM premium feature key is usually needed to
activate a premium feature, for this release, the fibre channel/SATA Intermix
premium feature is activated when you download the NVSRAM file.
Nevertheless, you must generate the premium feature key and retain it because
you will need it to activate the fibre channel/SATA Intermix premium feature in
future releases.

If you try to use the premium feature activation key with controller firmware
version 6.10.11.xx, you will receive an error message stating that the premium
feature that this key is intended to enable is not compatible with version
6.10.11.xx of the firmware.

For more information on how to enable the premium feature or the feature key,
read the activation instructions that accompany the feature or contact your IBM
representative.
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Fibre channel/SATA storage expansion enclosure intermix restrictions

Note: When you add drive expansion enclosures of different types, if the grouping
of the enclosure types forces the new enclosures to be cabled in the middle
of the drive loop, it is strongly recommended that you power down the
configuration or schedule your installations during off-peak 1/O periods. You
can use the performance monitor function in the DS4000 Storage Manager
Subsystem Management window to determine off-peak 1/O periods.

If you cannot power down the configuration to install a new enclosure in the
middle of the loop, you must use the DS4000 Storage Manager Subsystem
Management window to verify that the interrupted drive loop is up and in
optimal state before you modify the other drive loop. This minimizes the
chance that arrays will fail because both drive loops in a redundant drive
loop pair are modified/disconnected preventing the DS4000 Storage Server
controllers from accessing certain drives in the redundant drive loop.

Therefore, it is also important to plan for additions to the configuration prior
to your initial installation. It is not necessary, however, to take these same
precautions when you add new enclosures to either end of the redundant
drive loop.

The following restrictions apply to the use of the DS4000 fibre channel/SATA
Intermix premium feature:

Compatible storage servers
* Only the following DS4000 storage servers support the SATA/fibre channel
intermix feature:
— DS4300 Turbo
— DS4400
— DS4500

Contact IBM for information regarding future DS4000 Storage Server support.

Grouping storage expansion enclosure types
Attention: Configurations that do not follow the DS4000 storage expansion
enclosures’ grouping restriction are not supported.

You must group similar DS4000 storage expansion enclosure types in adjacent
positions on the fibre channel loop when they are intermixed in a DS4000 Storage
Server redundant drive loop configuration. [Figure 8 on page 17|illustrates both the
correct and incorrect ways to group DS4000 storage expansion enclosures.
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Figure 8. Correct and incorrect way to group DS4000 storage expansion enclosures in a
redundant drive loop

You must group similar enclosure models together as the configuration on the left
illustrates. In the configuration on the left, the EXP700s are grouped together at the
top of the loop, followed by the EXP710s, which are grouped together at the middle
of the loop, followed by the EXP100s which are grouped together adjacent to the
controller. (Notice the expansion unit model names indicated in the lower right
corner of each enclosure.) In the (incorrect) configuration on the right, the
enclosures are cabled in a random order and are not properly grouped.

lists those drive expansion enclosure models that are considered of the
same storage enclosure type for the purpose grouping together in an intermixed
SATA/fibre channel storage expansion enclosure loop configuration.

Table 14. DS4000 drive expansion enclosure models compatible when contiguously grouped
in intermixed loop configurations

Group-compatible EXP100 Group-compatible EXP700 Group-compatible
models models EXP710 models
1710-10X 1740-1RU 1740-710
1710-10U 1740-1RX 1740-1RU"
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Table 14. DS4000 drive expansion enclosure models compatible when contiguously grouped
in intermixed loop configurations (continued)

1724-1XP | 1740-1RX"

1. Consider and treat this EXP700 model as an EXP710 for grouping purposes only once
upgraded with the DS4000 EXP700 field upgrade to switched ESMs.

Do not mix drive types
Arrays must consist exclusively of either fibre channel or SATA drives. Do not mix
drive architecture types in an array.

Do not mix fibre channel and SATA drives in the same DS4000 Storage Server or
storage expansion enclosure. |Table 15| lists DS4000 storage servers and storage
expansion enclosures according to their drive architecture types.

Table 15. DS4000 storage servers and storage expansion enclosures by drive architecture
type and machine model

Storage Expansion
Drive architecture type Storage server models Enclosure models
SATA DS4100 DS4000 EXP100
Fibre Channel DS4300 Turbo DS4000 EXP700
DS4400 DS4000 EXP710
DS4500

Do not intermix drive types for hot spares
SATA drives can function as hot spares only for SATA drive architecture types.

Fibre channel drives can function as hot spares only for fibre channel drive
architecture types.

DS4300 Turbo intermix configuration restriction

In DS4300 Turbo intermix configurations, when there are drives in the storage
server’s drive slots, IBM supports a maximum of seven expansion enclosures in a
drive loop.

For additional information, see [‘Intermix scenarios and procedures for SATA/fibrel|

Intermix scenarios and procedures for SATA/fibre channel

Note: For any DS4000 configuration, always plan the rack installation to allow for
future addition of storage enclosures to either end of the drive loop and to
conform with storage expansion enclosure type grouping procedures
recommended by IBM.

This section describes a number of DS4000 product upgrade or installation
scenarios that might arise with purchase ot the Fibre Channel/SATA intermix option.
Following the scenarios are detailed procedures necessary to address each
DS4000 product installation and upgrade scenarios.

Fibre channel/SATA intermix scenarios
The possible scenarios for DS4000 fibre channel/SATA intermixing include:
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Existing DS4000 configurations with EXP500 fibre channel expansions
enclosures only. The fibre channel/SATA intermix option does not support
EXP500 enclosures. Backup data in the EXP500 enclosures and remove them
from the DS4000 configuration before completing a fibre channel/SATA intermix.
This is necessary because EXP100 SATA drive expansion enclosures and
EXP710 fibre channel drive expansion enclosures do not support the EXP500
enclosure’s 1 Gbps fibre channel loop speed.

Existing DS4000 configurations with EXP500 and EXP700 fibre channel
expansions enclosures only. Follow the steps in [‘Fibre channel/SATA intermixi
to complete the fibre channel/SATA intermix.

Existing DS4000 configurations with EXP700 and/or EXP710 fibre channel
expansion enclosures only. Follow the steps in [‘Fibre channel/SATA intermix|
to complete the fibre channel/SATA intermix.

Existing DS4000 configurations with EXP100 SATA expansion enclosures only.

Follow the steps in f‘Fibre channel/SATA intermix procedure 1”| to complete the
fibre channel/SATA intermix.

New DS4000 configurations with both fibre channel and SATA expansion
enclosures. The DS4000 Storage Server controller firmware version is specified
as default or is specified as fibre channel controller firmware. For configurations
involving DS4400 and DS4500 storage servers, install and connect together the
DS4000 Storage Server and the fibre channel DS4000 EXP700 and/or EXP710
drive expansion enclosure with two fibre channel drives inserted only. For
configurations involving DS4300 storage servers, install two fibre channel drives
in the DS4300 Storage Server drive slots only. Do not connect any SATA or any
other fibre channel drive expansion enclosures until you load the correct
controller firmware and enable the Fibre Channel/SATA Intermix Premium
Feature. Follow the steps in[‘Fibre channel/SATA intermix procedure 17 to
complete the fibre channel/SATA intermix.

New DS4000 configurations with intermixed fibre channel/SATA expansion
enclosures where the DS4000 Storage Server controller firmware version has
been properly specified at the factory for shipment with SATA controller
firmware. You need only install and connect together the DS4000 Storage
Server and the SATA DS4000 EXP100 drive expansion enclosures. Do not
connect any additional fibre channel enclosure or insert any fibre channel drives
into the DS4300 storage server’s drive slots until you load the correct controller
firmware and enable the Fibre Channel/SATA Intermix Premium Feature. Follow
the steps in [‘Fibre channel/SATA intermix procedure 1’| to complete the fibre
channel/SATA intermix.

New DS4000 configurations with intermixed fibre channel/SATA expansion
enclosures, where the DS4000 Storage Server controller firmware version is
unknown. Because you do not know what level of firmware is loaded in the
controller, follow the steps in |“Fibre channel/SATA intermix procedure 2” on page|
to verify and, if necessary, upgrade the firmware to the correct level.

Fibre channel/SATA intermix procedure 1

Follow these instructions to install or upgrade an existing DS4000 Storage Server
configuration with the Fibre channel/SATA intermix option when you know the
firmware version installed on the DS4000 controller.

1.

Save the DS4000 storage subsystem profile using the DS4000 Storage
Manager Client program. Make sure that the system is in optimal state using
the DS4000 Storage Management Client program before proceeding to step
Use the recovery guru menu option to repair any problems that
place the DS4000 configuration in non-optimal state.
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2.

3.

This step applies only to scenario|2 on page 19| of [Fibre channel/SATA intermix
I there are any EXP500 drive enclosures in the DS4000
configuration, you must backup the data in the EXP500, if required, and
remove them from the DS4000 configuration because the fibre channel/SATA
intermix option does not support the EXP500 drive expansion enclosure’s 1
Gbps fibre channel speed.

Important:

a. Schedule downtime to switch the drive loop speed settings from 1 Gbps to
2 Gbps. Switching drive loop speeds requires a power cycle of DS4000
expansion enclosures.

b. Do not insert fibre channel hard drives that were removed from EXP500
drive expansion enclosures into new EXP700 orEXP710 drive expansion
enclosures or DS4300 storage servers without first assuring that they are
capable of running at 2 Gbps and have the correct 2 Gbps drive firmware
installed. See [‘Upgrading drive firmware levels” on page 41| for related
information.

This step applies only to scenario |2 on page 19 of [Fibre channel/SATA intermix

Re-cable the fibre channel drive loop. The removal of EXP500

enclosures may also necessitate rearrangement of the remaining EXP700

drive expansion enclosures prior to fibre channel/SATA intermix. Do not add
the new enclosures to the configuration yet.

Note: The new drive enclosures and their inserted drives may or may not be
displayed in the DS4000 Storage Subsystem window if the controller
firmware is not at the minimum level required for their support. In such
cases, the drive enclosure icon may display with no drives and incorrect
enclosure IDs in the Physical view of the DS4000 Storage Subsystem
window.

This step applies only to scenario [2 on page 19 of |[Fibre channel/SATA intermix|
Power up the configuration and use the DS4000 Storage
Management Client program to assure that the system is in optimal state
before proceeding to step E Use the Recovery Guru menu option to correct
any problems that may place the DS4000 configuration in non-optimal state.

Upgrade your DS4000 EXP700, EXP710 and EXP100 ESM firmware to the
level that is compatible with each particular DS4000 drive expansion enclosure
type. See [‘Verifying controller, NVSRAM, and ESM firmware file levels” on|
|page 3§| for related information.

Attention: Unlike the existing/standard DS4000 firmware upgrade procedure,

perform any ESM code upgrades that are required before you perform any
other code upgrades (for example, a DS4000 controller firmware upgrade).

able 16|indicates which ESM firmware levels are compatible with each
enclosure model:

Table 16. ESM firmware levels by storage expansion enclosure model

Storage expansion enclosure model ESM firmware level
EXP100 9554
EXP700 9326'
EXP710 9627

1.

You must upgrade the EXP700 ESM firmware to the 9326 level before you upgrade the
DS4000 Storage Server controller firmware to version 06.1x.xx.xx.

If necessary, upgrade your host software to DS4000 Storage Manager version 9.10, or
higher.
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10.

11.

If necessary, upgrade your host software to DS4000 Storage Manager version
9.10, or later.

Upgrade your DS4000 Storage Server controller firmware to version
06.10.11.xx, or later. The minimum level of firmware that supports the fibre
channel/SATA intermix option is 06.10.11.xx. If you upgraded from firmware
level 05.xx.xx.xx to firmware level 06.10.11.xx, you must perform the upgrade
with no concurrent I/O. For any changes to the firmware version and
downloading requirements, see the DS4000 controller firmware readme that is
included in the latest DS4000 controller firmware web packages, or supplied
on the DS4000 Storage Manager CDs. The controller firmware and host
software are available for download over the Internet from the DS4000 Storage
Manger Version 9.1 web page at:

www-1.ibm.com/servers/storage/support/disk/|

To implement the Fibre Channel/SATA Intermix Premium Feature, download
the appropriate NVSRAM file from the DS4000 Storage Server NVSRAM
Support for the DS4000 Fibre Channel/SATA Enclosure Intermix CD that is
associated with your host operating system. See[“Verifying controller,|
[NVSRAM, and ESM firmware file levels” on page 38 for related information.
The appropriate NVSRAM file for a given storage server can be found in one
of the following directories:

* \NVSRAM\DS4300_FAStT600turbo
* \NVSRAM\DS4400_FAStT700
* \NVSRAM\DS4500_FAStT9006

The DS4000 Fibre Channel/SATA Intermix Premium Feature is entitled and
requires the use of a feature key to enable the option. To obtain the feature
key identifier, you need a feature activation code which is printed on the IBM
premium feature activation card. You also need the controller unit’s IBM serial
number which is printed on the label on the rear of your DS4000 Storage
Server.

Attention: Although the IBM premium feature key is usually needed to
activate a premium feature, for this release, the fibre channel/SATA Intermix
premium feature is activated when you download the NVSRAM file. Because
you will need it to activate the Fibre Channel/SATA Intermix Premium Feature
for future releases, however, you must generate the premium feature key and
retain it. If you try to use the premium feature activation key with controller
firmware version 6.10.11.xx, you will receive an error message stating that the
premium feature which this key is intended to enable is not compatible with
version 6.10.11.xx of the controller firmware.

Connect new expansion enclosures to the DS4000 configuration using the
guidelines described in [Intermix instructions for SATA and fibre channel
torage expansion enclosures” on page 14| as well as the appropriate
procedures in
“Migrating one or more hard drives,” on page 53,/Chapter 5)
‘Adding expansion units containing new hard drives,” on page 61, or
Chapter 6, “Migrating expansion units containing hard drives,” on page 79,|
depending on your situations.

Note: See |“Grouping storage expansion enclosure types” on page 16|for
related information.

If required, restore the data from EXP500 drives to the newly created logical
drives.

Chapter 1. Introduction 21


http://www-1.ibm.com/servers/storage/support/disk/

Fibre channel/SATA intermix procedure 2

Follow these instructions only when, in the case of a new DS4000 installation, you
do not know the firmware version installed on the DS4000 controller.

1.

For DS4400 and DS4500 storage servers, connect the storage server and one
of the fibre channel drive expansion enclosures with two inserted fibre channel
drives together. For the DS4300 Storage Server, insert two drives into the
DS4300 drive slots.

Remove controller B blade from the DS4000 Storage Server. For DS4400 and
DS4500 storage servers, controller B is the bottom controller when you are
facing the front of the storage server. For the DS4300 Storage Server,
controller B blade is the one on the right when you are facing the rear of the
storage server.

Power up the configuration.

Upgrade your host software to DS4000 Storage Manager software version
9.10, or later.

If connected, upgrade your DS4000 EXP700 or EXP710 ESM firmware to the
level that is compatible with each particular DS4000 drive expansion enclosure
type. See [‘Verifying controller, NVSRAM, and ESM firmware file levels” on|
|Qage 3§| for related information.

Attention: Unlike the existing/standard DS4000 firmware upgrade procedure,

perform any required ESM code upgrades before you perform other code
upgrades, such as DS4000 controller firmware upgrades.

[Table 16 on page 20|indicates the ESM firmware level currently supported for
each enclosure type. See also [Table 11 on page 5|

Note: Upgrade EXP700 ESM firmware to the 9326 level before you upgrade
the DS4000 Storage Server controller firmware to version 06.1X.XX.XX.

If necessary, upgrade your DS4000 Storage Server controller firmware to
version 06.10.11.xx, or later. The minimum level of firmware that supports the
fibre channel/SATA intermix option is 06.10.11.xx. The controller firmware and
the host software are available for download over the Internet from the
DS4000 Storage Manger software version 9.1 web page at:

www-1.ibm.com/servers/storage/support/disk/|

Note: In some cases, the DS4000 Storage Server entry will display in the
DS4000 Storage Manager Client Enterprise window as an Unresponsive
device after you load the new DS4000 controller firmware. If this
occurs, remove the storage server (controller A) entry from the DS4000
Enterprise Management window. If managing in-band, scan for new
devices; then, restart the DS4000 Storage Manager agent service.
Rediscover the storage server in the Enterprise Management window
using either the controller IP addresses or the IP address of the host
server with the DS4000 Storage Manager agent service.

To implement the Fibre channel/SATA Intermix Premium Feature, download the
appropriate NVSRAM file that is associated with your host operating system
from the DS4000 Storage Server NVSRAM Support located on the DS4000
Fibre channel/SATA Enclosure Intermix CD. See [‘Verifying controller
|NVSRAM, and ESM firmware file levels” on page 38| for related information.
The appropriate NVSRAM file for a given storage server can be found in one
of the following directories:

a. \NVSRAM\DS4300_FAStT600turbo
b. \NVSRAM\DS4400_FAStT700
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C. \NVSRAM\DS4500_FAStT9006

8. The DS4000 Fibre Channel/SATA Intermix Premium Feature is entitled and
requires use of a feature key to enable the option. You will require a feature
activation code which is printed on the IBM premium feature activation card to
obtain the feature key identifier. You will also need your controller unit’s IBM
serial number, which is printed on the label on the back of your DS4000
Storage Server.

Attention: Although the IBM premium feature key is normally required to
activate a premium feature, for this release, the Fibre Channel/SATA Intermix
Premium Feature activates when you download the NVSRAM file.
Nonetheless, because you will need it to activate the Fibre Channel/SATA
Intermix Premium Feature in future releases, you must generate and retain the
premium feature key. If you attempt to use the premium feature activation key
with controller firmware version 6.11.xx.xx, you will receive an error message
stating that the premium feature which this key is intended to enable is not
compatible with firmware version 6.11.xx.xx.

9. Re-insert controller blade B into the DS4000 Storage Server chassis. Wait at
least 5 minutes for controller B to synchronize firmware with controller A.

10. Close the DS4000 Subsystem Management window. Remove the storage
server (controller A) entry from the DS4000 Enterprise Management window. If
managing in-band, scan for new devices; then, restart the DS4000 Storage
Manager agent service. Rediscover the storage server in the Enterprise
Management window using either the controller IP addresses of both
controllers or the IP address of the host server with the DS4000 Storage
Manager agent service. The storage server should be displayed as a single
entity and will not display a missing controller warning message when one tries
to manage it. Otherwise, repeat steps and If the problem persists,
contact your IBM support representative.

11. Open the DS4000 Subsystem Management window and verify that the
firmware and NVSRAM versions on both controllers are correct. Reloaded the
firmware and NVSRAM, if needed. See [*Verifying controller, NVSRAM, and|
[ESM firmware file levels” on page 38| for related information.

12. Insert additional fibre channel drives into the empty drive slots of either the
DS4300 Storage Server or the fibre channel drive expansion enclosure. Then,
connect new expansion enclosures to the DS4000 configuration using the
procedures as described in [Intermix instructions for SATA and fibre channel
Istorage expansion enclosures” on page 14.]

Note: See [‘Grouping storage expansion enclosure types” on page 16| for
related information.

Fibre channel/SATA intermix troubleshooting

lists possible causes and corrective actions you may take in conjunction
with various known fibre channel/SATA intermix issues.

Table 17. Possible causes, and resolutions to fibre channel/SATA intermix issues

Issue | Possible cause Possible resolution
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Table 17. Possible causes, and resolutions to fibre channel/SATA intermix issues (continued)

Some of the drive
enclosures display
with empty drive
slots, even though
there are drives
inserted in the
slots. In addition,
the enclosure IDs
of these storage
expansion
enclosures are
displayed with the
same values,
even though the
enclosure ID of
each storage
expansion
enclosure is
uniquely set.

Enclosure 1D
conflict LEDs are
also illuminated
on these drive

The controller firmware and
NVSRAM on your system may
be down-level.

Upgrade the DS4000 Storage Server

with each of the following:

1. The latest controller firmware that
can be downloaded from the DS4000
support Internet site:

www-1.ibm.com/servers/storage|
support/disM

2. The appropriate NVSRAM file on the

Fibre Channel/SATA Enclosure

Intermix CD.

See [*Verifying controller, NVSRAM |

and ESM firmware file levels” on
age 38| for related information.

expansion

enclosures.

A Mixed drive An incorrect version of Load the appropriate fibre channel/SATA
types not NVSRAM is installed. intermix enable NVSRAM file.

supported error
displayed when
clicking on the
Recovery Guru
menu icon in the
DS4000
subsystem
management
window

Normally, the premium feature
is enabled through the
premium feature key file. In
the first release of fibre
channel/SATA intermix
support, however, the
appropriate NVSRAM file was
required to be loaded into the
storage server controller,
instead.

The appropriate NVSRAM file
has the character "I” as the
prefix, that is,
11742F700R910V04.d1p and is
included in the NVSRAM file
in the appropriate folder for
each DS4000 Storage Server
on the Fibre Channel/SATA
Enclosure Intermix CD.

Note: Because later versions of DS4000
controller firmware will require this file to
enable the fibre channel/SATA intermix
premium feature, it is necessary that you
take care to retain the fibre
channel/SATA intermix premium feature
key file.
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Table 17. Possible causes, and resolutions to fibre channel/SATA intermix issues (continued)

In a newly
configured
DS4000 setup,
the DS4000
Storage Server
displays as two
entries in the
DS4000
Enterprise
Management
domain.

When trying to
manage the
DS4000 Storage
Server using
either entry, a
missing controller
warning window
displays before
the DS4000
subsystem
management
window displays.

When the DS4000
subsystem
management
window displays,
the DS4000 may
be shown with no
drive expansion
enclosures or
drive expansion
enclosures or with
no drives installed
in its drive slots.

Assure that the fibre channel
connections between the
DS4000 Storage Server and
the drive expansion
enclosures are optimal, that is,
the port bypass LEDs are not
illuminated.

It is also possible that the
controller firmware and
NVSRAM are down-level to
support the new drive
expansion enclosures.

Perform the steps in [‘Fibre|

channel/SATA intermix procedure 2” on|

page 22| to upgrade both the controller
and NVSRAM firmware.

DS4000 Storage Server drive loop schemes

Although a variety of cable loop schemes may function acceptably, IBM
recommends consistent use of only one such scheme when connecting DS4000
storage servers and expansion enclosures. [Figure 9 on page 26| illustrates the only
cable loop scheme that IBM recommends when connecting DS4000 storage servers
and expansion enclosures.
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Figure 9. Cable loop scheme advised when connecting DS4000 storage devices

Legend:

Integrated drive/controller DS4000 Storage Server (for example, DS4300 or
DS4100)

2 Controller only DS4000 Storage Server (for example, DS4400 or DS4500)

IBM recommends against inconsistent use of any cable loop scheme. IBM also
recommends against the use of cable loop schemes illustrated in [Figure 10 on page]
through|Figure 13 on page 30[when connecting DS4000 storage servers and
expansion enclosures because they are not standardized for IBM DS4000 Support.
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Figure 10. Alternate cable loop schemes possible but not recommended when connecting
DS4000 storage devices (1 of 4)

Legend:

Integrated drive/controller DS4000 Storage Server (for example, DS4300 or
DS4100)

2 | Controller only DS4000 Storage Server (for example, DS4400 or DS4500)
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Figure 11. Alternate cable loop schemes possible but not recommended when connecting
DS4000 storage devices (2 of 4)

Legend:

Integrated drive/controller DS4000 Storage Server (for example, DS4300 or
DS4100)

2 Controller only DS4000 Storage Server (for example, DS4400 or DS4500)
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Figure 12. Alternate cable loop schemes possible but not recommended when connecting
DS4000 storage devices (3 of 4)

Legend:

Integrated drive/controller DS4000 Storage Server (for example, DS4300 or
DS4100)

2| Controller only DS4000 Storage Server (for example, DS4400 or DS4500)
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Figure 13. Alternate cable loop schemes possible but not recommended when connecting
DS4000 storage devices (4 of 4)

Legend:

Integrated drive/controller DS4000 Storage Server (for example, DS4300 or
DS4100)

2| Controller only DS4000 Storage Server (for example, DS4400 or DS4500)

Setting enclosure IDs

Each drive enclosure in a DS4000 storage subsystem drive loop must have a
unique drive enclosure ID. DS4000 controllers use a combination of the enclosure
ID and the number of the physical slot that a hard drive occupies to create a unique
loop address or arbitrated loop physical address (AL_PA) for each drive in a drive
loop. The enclosure ID consists of two digits, a tens (x10) digit and a ones (x1)
digit. The possible values for the tens and the ones digits are 0-9 for FAStT500
drive enclosures, and 0-7 for DS4400 drive enclosures.

It is recommended as best practice that you give each drive expansion enclosure in
a redundant drive loop a unique ones digit ID. This setting will enforce hard AL_PAs
(unchangeable between Loop Initializations [LIPs]) for the drives and facilitate drive
loop problem troubleshooting in the event of an error. If the ones digits are not
unique, two or more devices will have the same hard AL_PA. In such a case, the
controller will use soft AL_PAs for the devices that have identical hard AL_PAs.

The problem with soft addressing is that addresses may change between LIPs. This
possibility increases the difficulty of troubleshooting drive loop problems because it
is difficult to ascertain whether the same device with a different address or a
different device may be causing a problem. Since the DS4000 storage server can
support more enclosures than available values of the enclosure ID ones digit,

[Table 18 on page 31|through [Table 22 on page 33| suggest enclosure ID settings for
various drive expansion enclosure families to minimize soft addressing in a drive
loop.
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Table 18. EXP500 Storage Expansion Enclosure ID settings

Storage expansion
enclosure

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop if
applicable/supported

1st unit

(storage expansion enclosure
or storage server with internal
drive slots)

00

x0
(where x is 2-7)

2nd unit 01 x1
(EXP500) (where x is 2-7)
3rd unit 02 X2
(EXP500) (where x is 2-7)
4th unit 03 x3
(EXP500) (where x is 2-7)
5th unit 04 x4
(EXP500) (where x is 2-7)
6th unit 05 x5
(EXP500) (where x is 2-7)
7th unit 06 X6
(EXP500) (where x is 2-7)
8th unit 07 X7
(EXP500) (where x is 2-7)
9th unit 08 x8
(EXP500) (where x is 2-7)
10th unit 09 x9
(EXP500) (where x is 2-7)
11th unit 10 x0
(EXP500) (where x is 3-7)

Note: Drives in the 11th enclosures of each drive loop

AL_PAs.

in will have soft

suggests enclosure ID settings that minimize soft addressing for EXP100
storage expansion enclosures in a drive loop.

Table 19. EXP100 Storage Expansion Enclosure ID settings

Storage expansion
enclosure (unmixed)

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop if
applicable/supported

1st unit

(EXP100 Expansion
Enclosure or DS4000 Storage
Server with internal drive
slots)

00

x0
(where x is 2-7)

2nd unit 01 x1
(EXP100) (where x is 2-7)
3rd unit 02 X2
(EXP100) (where x is 2-7)
4th unit 03 x3
(EXP100) (where x is 2-7)
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Table 19. EXP100 Storage Expansion Enclosure ID settings (continued)

Storage expansion
enclosure (unmixed)

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop if
applicable/supported

5th unit 04 x4

(EXP100) (where x is 2-7)
6th unit 05 x5

(EXP100) (where x is 2-7)
7th unit 06 X6

(EXP100) (where x is 2-7)
8th unit 07 X7

(EXP100) (where x is 2-7)
9th unit 11

(EXP100, where the first unit
is a DS4300 only)

Note: All drives in drive loops described in[Table 19 on page 31|will be assigned

hard AL_PAs.

suggests enclosure ID settings that minimize soft addressing for EXP700

or EXP710 storage expansion enclosures in a drive loop.

Table 20. EXP700 or EXP710 Storage Expansion Enclosure ID settings

Storage expansion
enclosure (unmixed)

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop if
applicable/supported

1st unit

(storage expansion enclosure
or DS4000 Storage Server
with internal drive slots)

00

x0
(where x is 2-7)

2nd unit 01 x1
(EXP700) (where x is 2-7)
3rd unit 02 x2
(EXP700) (where x is 2-7)
4th unit 03 x3
(EXP700) (where x is 2-7)
5th unit 04 x4
(EXP700) (where x is 2-7)
6th unit 05 x5
(EXP700) (where x is 2-7)
7th unit 06 X6
(EXP700) (where x is 2-7)
8th unit 07 X7
(EXP700) (where x is 2-7)

Note: All drives in drive loops described in will be assigned hard AL_PAs.

[Table 21 on page 33|suggests enclosure ID settings that minimize soft addressing
for the EXP500 and EXP700 Storage Expansion Enclosure when intermixed in a
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redundant drive loop.

Table 21. Intermixed EXP500 and EXP700 Storage Expansion Enclosure ID settings

Storage expansion
enclosure models
(intermixed)

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop

1st unit

(storage expansion enclosure
or DS4000 Storage Server
with internal drive slots)

00

x0
(where x is 2-7)

2nd unit 01 x1
(EXP500 or EXP700) (where x is 2-7)
3rd unit 02 x2
(EXP500 or EXP700) (where x is 2-7)
4th unit 03 x3
(EXP500 or EXP700) (where x is 2-7)
5th unit 04 x4
(EXP500 or EXP700) (where x is 2-7)
6th unit 05 x5
(EXP500 or EXP700) (where x is 2-7)
7th unit 06 X6
(EXP500 or EXP700) (where x is 2-7)
8th unit 07 X7
(EXP500 or EXP700) (where x is 2-7)
9th unit 10 x0
(EXP500 or EXP700) (where x is 2-7)
10th unit 1 x1

(EXP500 or EXP700)

(where x is 2-7)

Note: The drives in the 9th and 10th enclosures in each drive loop described in

able 21| will have soft AL_PAs.

suggests enclosure ID settings that minimize soft addressing for the
EXP700 and EXP710 Storage Expansion Enclosure when intermixed in a redundant

drive loop.

Table 22. Intermixed EXP700 and EXP710 Storage Expansion Enclosure ID settings

Storage expansion
enclosure models
(intermixed)

Enclosure ID setting for
enclosure in the first
redundant drive loop

Enclosure ID setting for
enclosure in the second
redundant drive loop

1st unit

(storage expansion enclosure
or DS4000 Storage Server
with internal slots)

00

x0
(where x is 2-7)

2nd unit 01 x1
(EXP700 or EXP710) (where x is 2-7)
3rd unit 02 X2
(EXP700 or EXP710) (where x is 2-7)
4th unit 03 x3
(EXP700 or EXP710) (where x is 2-7)
5th unit 04 x4

(EXP700 or EXP710)

(where x is 2-7)
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Table 22. Intermixed EXP700 and EXP710 Storage Expansion Enclosure 1D
settings (continued)

Storage expansion Enclosure ID setting for | Enclosure ID setting for
enclosure models enclosure in the first enclosure in the second
(intermixed) redundant drive loop redundant drive loop
6th unit 05 x5

(EXP700 or EXP710) (where x is 2-7)

7th unit 06 X6

(EXP700 or EXP710) (where x is 2-7)

8th unit 07 X7

(EXP700 or EXP710) (where x is 2-7)

Note: The drives in the 9th and 10th enclosures in each drive loop described in
[Table 22 on page 33| will have soft AL_PAs.

Determining firmware levels

There are two different methods to determine DS4000 Storage Server, expansion
unit, drive, and ESM firmware versions. Each method uses the DS4000 Storage
Manager client that manages the DS4000 storage subsystem with the attached
expansion unit.

Method one:

For controllers with firmware version 6.1x.xx.xx or later, go to the Subsystem
Management window and select Storage Subsystem » View Profile. For
controllers with firmware version 5.xx.xx.xx.xx or earlier select View » Storage
Subsystem Profile. When, under either circumstance, the Storage Subsystem
Profile window opens, select the All tab and scroll through the Profile For Storage
Subsystem to locate the following information.

Note: The Profile For Storage Subsystem contains all the profile information for
the entire subsystem. Therefore, it may be necessary to scroll through a
large amount of information to locate the firmware version numbers.

DS4000 Storage Server

* NVSRAM version
» Appware version (Appware is a reference to controller firmware).
» Bootware version (Bootware is a reference to controller firmware.)

See the following example or snapshot of profile information.

Controller in Enclosure 0, Slot A
Status: Online

Current configuration

Firmware version: 06.10.07.00
Appware version: 06.10.07.00
Bootware version: 06.10.07.00
NVSRAM version: 1722F600R910V05

Drives
e Firmware version

ESM
e ESM card firmware version
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Method two:

Select the appropriate procedure from the following options and complete it to
obtain the specified firmware version.

To obtain the controller firmware version:
Right click the Controller icon in the Physical View pane of the Subsystem
Management window and select Properties. The Controller Enclosure
properties window opens and displays the properties for that controller.

You must perform this step for each individual controller.

To obtain the drive firmware version:
Right Click the Drive icon in the Physical View pane of the Subsystem
Management window and select Properties. The Drive Properties window
opens and displays the properties for that drive.

You must perform this step for each individual drive.

To obtain the ESM firmware version:

1. In the Physical View pane of the Subsystem Management window, click
the Drive Enclosure Component icon (which is the icon furthest to the
right). The Drive Enclosure Component Information window opens.

2. Click the ESM icon in the left pane. The ESM information displays in the
right pane of the Drive Enclosure Component Information window.

3. Locate the firmware version of each ESM in the drive enclosure.

To obtain the drive enclosure component firmware version:

1. Click the Drive Enclosure Component icon (the icon located furthest to
the right) in the Drive Enclosure frame in the Physical View pane of the
Subsystem Management window. The Drive Enclosure Component
Information window opens.

2. Click the ESM icon in the left pane. The ESM information displays in the
right pane of the Drive Enclosure Component Information window.

3. Locate the firmware version of each ESM in the drive enclosure.
You must perform this step for each drive expansion enclosure.

Determining a drive’s product ID and model

You can determine a drive’s product ID and model from the storage server profile
through the menu option in the DS4000 Subsystem Management window. To get
the profile, in the DS4000 Subsystem Management window, either click View »
Storage Subsystem Profile (if the controller firmware version is 05.xx.xx, or
earlier) or Storage Subsystem » View Profile (if the controller firmware version is
06.xx.xx, or later). When the Storage Subsystem Profile window displays, click on
the Drives tab and scroll down to the information about the drive which product ID
and model you want to verify. See [Table 23 on page 36|for a sample profile
indicating the product ID of the drive in slot 1 of enclosure ID 1 as ST3146807FC.
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Table 23. Snapshot of profile information identifying the product ID of the drive in slot 1 of
enclosure ID 1 as ST3146807FC

HOT SPARE COVERAGE:
The following arrays are not protected: 1, 2

Total hot spare drives: 0
Standby: 0
In use: 0

DETAILS:

Drive at Enclosure 1, Slot 1
Drive port: 1, Channel: 1; ID: 8/0xD9
Drive port: 2, Channel: 2; ID: 8/0xD9
Drive path redundancy: OK
Status: Optimal
Raw capacity: 136.732 GB
Usable capacity: 136.732 GB
Current data rate: 2 Gbps
Product ID: ST3146807FC 1#
Firmware version: B350
Serial number: 3HY062YKOO0O7309FAT1
Vendor: IBM-ESXS
Date of manufacture: May 29, 2002
World-wide name: 20:00:00:04:cf:56:43:fb
Drive type: fibre channel
Speed: 10033 RPM
Mode: Assigned
Associated array: 1

Drive at Enclosure 1, Slot 2

Drive port: 1, Channel: 2; ID: 9/0xD9
Drive port: 2, Channel: 1; ID: 9/0xD9
Drive path redundancy: OK

Status: Optimal

Raw capacity: 136.732 GB

Usable capacity: 136.732 GB

Current data rate: 2 Gbps

DS4000 Storage Manager installation and support guides

This publication frequently cites IBM TotalStorage DS4000 Storage Manager
installation and support guides supporting various versions and operating system
environments. There are currently two, namely:

* IBM TotalStorage DS4000 Storage Manager Installation and Support Guide for
AlIX, HP-UX, Solaris and Linux on Power

* IBM TotalStorage DS4000 Storage Manager Installation and Support Guide for
Intel-based Operating System Environments

Visit the following Web site to access documentation related to your particular
operating system and DS4000 Storage Manager version.

www.ibm.com/servers/storage/support/disk/|

See ['DS4000 Storage Server publications” on page xix|for more information.
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Chapter 2. Prerequisites to adding capacity and hard drive

migration

© Copyright IBM Corp. 2004

Perform the preliminary steps detailed in this chapter before you add storage

capacity or migrate hard drives. After you meet these prerequisite requirements,
proceed to any of the following sections to address your particular storage hardware
addition or migration requirements:

« [Chapter 3, “Adding one or more new hard drives,” on page 47|

[Chapter 5, “Adding expansion units containing new hard drives,” on page 61|
[Chapter 4, “Migrating one or more hard drives,” on page 53]

* |Chapter 6, “Migrating expansion units containing hard drives,” on paw

+ |Chapter 7, “Upgrading a storage server in a functioning configuration,” on page|

95)

Failure to perform the steps listed in this section might result in loss of data
availability, and in some cases, loss of data. Perform the following steps on the
DS4000 Storage Server to which you will migrate or add new hard drives:

__Step 1. Complete a full backup of all data residing on the DS4000 Storage
Server.

__ Step 2. Verify that the backup was successful.

___Step 3. Verify that the DS4000 Storage Server has the latest controller
firmware, non-volatile storage random access memory (NVSRAM), and
ESM firmware.

Attention: If your DS4000 Storage Server has controller firmware
version 04.01.02.29 or lower, download and install controller firmware
version 4.01.02.33 or higher before you download and install controller
firmware version 5.30.xx.xx or higher. There are certain minimum
controller firmware version requirements associated with various drive
expansion enclosures. See|Table 9 on page 3 and|Table 10 on page 4|
for related information.

__ Step 4. Verify that the drive firmware is at the latest level. If it is not, see
[‘Upgrading drive firmware levels” on page 41

__Step 5. Verify that the DS4000 Storage Server to which you will migrate the
hard drives is in optimal state. If it is not, perform the appropriate steps
listed in the Recovery Guru to bring the storage server into optimal
state.

__Step 6. Use the Read_Link_Status function of the Storage Manager client
program and the DS4000 Storage Server management event log (MEL)
to verify that the drive loops are in optimal state. If the DS4000 storage
subsystem controller firmware is version 06.10.xx.xx or higher, use the
drive channel diagnostics to determine if the drive loop is optimal.

__Step 7. Investigate and resolve any errors that reported in the DS4000 Storage
Server MEL.

__ Step 8. Save and store the storage subsystem profile of the DS4000 Storage
Server.

___Step 9. Itis necessary to purchase the fibre channel/SATA intermix premium
feature option and follow the associated instructions to activate the fibre
channel/SATA premium feature.
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Important: Do not store DS4000 Storage Server profiles in the same location as
the logical drives defined on your DS4000 Storage Server. Should you do so, and a
RAID array failure occurs during subsequent migration, the data will be lost.

If you are migrating drives from another DS4000 Storage Server, you must also
perform the preceding stepsthrough on the DS4000
Storage Server from which you intend to migrate hard drives. You must also
perform the following steps to flush server-cached 1/O to disks.

__Step 1. Stop all programs, services or processes in the host servers that
access the logical drives defined in the migrated hard drives.

__Step 2. Verify that there are no programs, services, or processes running in the
background that might write data to the logical drives. (For example,
Microsoft® MSCS service periodically writes to the “Quorum” disk.)

__ Step 3. Unmount the file systems to flush 1/O from the server cache to disk.

Notes:

a. In a Microsoft Windows® environment, it is also necessary for you to
remove the drive letter or the mount points of the mapped LUNs
instead of unmounting the file systems.

b. Consult documentation associated with your particular operating
system for detailed information regarding the unmount procedure.

After you meet prerequisites described in this section, proceed to any of the
following sections to address your particular drive migration requirements.

+ [Chapter 3, “Adding one or more new hard drives,” on page 47|

+ [Chapter 5, “Adding expansion units containing new hard drives,” on page 61|
+ [Chapter 4, “Migrating one or more hard drives,” on page 53

+ [Chapter 6, “Migrating expansion units containing hard drives,” on page 79

+ [Chapter 7, “Upgrading a storage server in a functioning configuration,” on page|
9

Verifying controller, NVSRAM, and ESM firmware file levels

The controller firmware and NVSRAM of the DS4000 Storage Server to which you
will migrate hard drives, and the ESM firmware in the DS4000 storage expansion
enclosures must be at the levels indicated in|Table 24 on page 39 to ensure
firmware compatibility between the migrating and original hardware. Additionally,
DS4000 Storage Manager version 8.3 or higher client software, in conjunction with
the controller firmware level 5.30.xx.xx or higher, allows you to upgrade the ESM
firmware while the storage server receives I/O from the host server.

Note: Always check the readme document included with the DS4000 Storage
Server controller firmware package for any "no 1/0Os” requirement during the
controller firmware download. Certain controller firmware upgrade scenarios
may require that you first quiesce host I/Os.

Tip: Even though you can upgrade the DS4000 Storage Server and ESM firmware
while it processes 1/0O from the host server, schedule upgrades to occur during time
periods of low I/O between the DS4000 storage servers and host servers.

[Table 24 on page 39| lists IBM DS4000 machine types and model numbers, as well
as their current firmware (AppWare or BootWare) and NVSRAM versions.
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Table 24. Compatible controller firmware and NVSRAM version by machine type and model

number

Firmware version
Product Machine | Model |(AppWare /
name/model type number | BootWare) NVSRAM version
IBM TotalStorage 1724 1SC 05.42.10.00 N1724F10LR842V01
DS4100 Storage
Server (Single
Controller model)
IBM TotalStorage 1724 100 05.42.10.xx N1724F100R842V07
DS4100 Storage
Server
IBM TotalStorage 3542 1RU 05.30.20.00 N3542-1RUR830V09
FAStT200 Fibre 1RX
Channel Storage
Server
IBM TotalStorage 2RU 05.30.20.00 N3542-2RUR830V12
FAStT200 HA Fibre 2RX
Channel Storage
Server
IBM TotalStorage 3552 1RU 05.30.20.00 N3552F500R830V05
FAStT500 Fibre 1RX (Appware)
Channel Storage 05.30.03.00
Server (Bootware)
IBM TotalStorage 1722 60X 05.34.07.00 N1722F600R834V01
DS4300 Fibre 60U
Channel Storage
Server
IBM TotalStorage 06.10.11.00 N1722F600R910V03
DS4300 Fibre
Channel Storage
Server (with Turbo
option)
IBM TotalStorage 6LU 05.34.07.00 N1722F600R910V03
DS4300 Fibre 6LX (non-intermixed)
Channel Storage 11722F600R910V05
Server (Single (intermixed)
Controller model)
IBM TotalStorage 1742 1RU 06.10.11.00 N1742F700R910V03
DS4400 Fibre 1RX (Appware) (non-intermixed)
Channel Storage 06.10.03.00 11742F700R910V04
Server (Bootware) (intermixed)
IBM TotalStorage 1742 90X 06.10.11.00 N1742F900R910V03
DS4500 Fibre 90U (Appware) (non-intermixed)
Channel Storage 06.10.03.00 11742F900R910V04
Server (Bootware) (intermixed)

Note: Visit the following Web site either to verify software version levels or to
identify possible interim updates to firmware and NVSRAM file versions

described in[Table 24

www-1.ibm.com/servers/storage/support/disk/
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Update the DS4000 controller firmware and NVSRAM to the levels indicated in
[Table 24 on page 39| (or higher) before you upgrade the ESM firmware on the
storage expansion enclosures to versions indicated in [Table 25

lists IBM DS4000 storage expansion enclosure models by name, machine
type, model number, and current ESM firmware version.

Table 25. Compatible expansion unit ESM firmware version by machine type and model

number
DS4000 Storage Expansion Unit Machine Model ESM firmware
product name/model type number version
IBM TotalStorage DS4000 EXP100 1710 10U 9554
IBM TotalStorage DS4000 EXP500 3560 1RU 9166
1RX
IBM TotalStorage DS4000 EXP700 1740 1RU 9326
1RX
IBM TotalStorage DS4000 EXP710 1740 710 9627

Perform the following steps to upgrade ESM firmware for a down-level controller:

__Step 1. Upgrade the DS4000 Storage Manager software to the latest version.
That is DS4000 Storage Manager version 9.1x. For additional
information, see the IBM TotalStorage DS4000 Storage Manager
installation and support guide for the appropriate server operating
system environment at:

|www-1 .ibm.com/servers/storage/support/disk/l

Note: To ensure the highest level of software compatibility, update the
host server's multi-path software (Redundant Disk Array
Controller [RDAC], IBMSAN.CDM, or Linux failover adapter
driver) to the level that is either supported by or released with
the controller firmware that you intend to download. See the
following Web site for current details on software compatibility:

[www-1.ibm.com/support/docview.wss?uid=psg1MIGR-50176|

__Step 2. Upgrade the controller firmware and NVSRAM. See [Table 24 on page
and the web site listed earlier in conjunction with stegi]

Note: See the readme file in the DS4000 Storage Manager controller
firmware package associated with the appropriate host operating
system environment for a support statement about the
concurrent controller firmware download (that is, downloading
code to the DS4000 Storage Server while it is processing 1/0
from the host server).

__ Step 3. Upgrade the storage expansion enclosure ESM firmware. With DS4000
Storage Manager version 8.3 or higher and controller firmware version
05.3x.xx.xx or higher, you can update the ESM firmware while the
DS4000 Storage Server is processing I/O from the host server if the
ESM firmware download is performed to only one storage expansion
enclosure at a time. If you select multiple entries in the ESM firmware
download window for ESM firmware download, you must quiesce 1/Os
from the host servers before starting the ESM firmware download
process.
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Important: Even though the DS4000 Storage Server supports controller
and ESM firmware upgrade while the DS4000 Storage Server
processes I/O from the host server, schedule controller and ESM
firmware upgrades to occur during time periods of low I/O between the
DS4000 storage servers and host servers.

Upgrading drive firmware levels

Attention: 1 Gbps fibre channel drives will not operate correctly in a 2 Gbps fibre
channel drive loop. Always make certain that a fibre channel drive can operate at
the fibre channel speed of the drive loop involved before inserting it into the drive
slots in a DS4000 Storage Server configuration. In needed, contact IBM support to
ensure the compatibility of your drives before migrating them from one DS4000
configuration to another.

Before you begin migration, upgrade the drive firmware to the latest level. Do not
move or migrate fibre channel drives from a 1 Gbps fibre channel environment to a
2 Gbps fibre channel environment unless you have installed the latest firmware
documented to enable their operation in a 2 Gbps fibre channel environment.

Downloading drive firmware

— Important:
The following procedures assume you using controller firmware at version
6.10.xx.xx or above, if you are using an earlier version refer to the following
IBM web site for the appropriate firmware version documentation:

www-1.ibm.com/servers/storage/support/disk/

This section provides instructions for downloading DS4000 drive firmware. See the
online help for additional information.

Important:

1. IBM supports firmware download with 1/0, sometimes referred to as "concurrent
firmware download”. This feature is not supported for drive firmware.
2. Before starting the drive firmware download process:

» Stop all I/0 activity before downloading drive firmware to a DS4000 Storage
Server.

*  Unmount the file systems on all logical drives accessing the drives that you
select for firmware upgrade.

* Complete a full backup of all data residing on the drives that you select for
firmware upgrade.

Downloading Storage Manager version 9.10 drive firmware
To download drive firmware for DS4000 Storage Manager version 9.10, perform the
following steps:

1. From the Enterprise Management window, select a storage subsystem.

2. On the Enterprise Management window’s menu bar, click Tools + Manage
Device. The Subsystem Management window opens.

3. On the Subsystem Management window’s menu bar, click Advanced »
Maintenance » Download » Drive Firmware/Mode pages .... The Download
Drive Firmware wizard window opens to the Introduction page. Read the
instructions displayed and click Next.
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10.

11.

12.

13.

14.

15.

16.

Note: Storage Manager version 9.10 offers you the option to download and
update up to four different firmware file types simultaneously. Previous
Storage Manager versions did not offer this capability.

Click Browse to locate the server directory that contains the firmware that you
plan to download.

Select the firmware file that you plan to download and click OK. The file
appears listed in the "Selected Packages” window pane.

Select the firmware file for any additional drive types that you intend to
download and click OK. Additional files appear listed in the "Selected
Packages” window pane. A maximum total of four drive types are possible.

Click Browse to repeat step E| until you have selected each firmware file that
you plan to download.

When you have finished specifying the firmware packages for download, select
Next.

The Select Drive window opens, containing two tabs, a Compatible Drives tab
and an Incompatible Drives tab. The Compatible Drives tab contains a list
of the drives compatible to the firmware package types that you selected. From
that list, select the drives to which you plan to download the drive firmware that
you selected in steps [g and EI

Note: The firmware that you propose to download should be listed on the
Compatible Drives tab. If your particular drives’ product ID matches
the firmware type, however, and it is not listed as compatible on the tab,
contact your IBM technical support representative for additional
instructions.

Select the Compatible Drives tab.

Press and hold the Ctrl key while using your mouse to select multiple drives
individually, or press and hold the shift key while using your mouse to select
multiple drives listed in series. The compatible firmware that you selected in
steps |5|and [g will download to the drives that you select.

Click Finish to initiate download of the drive firmware to each compatible drive
that you selected in step@

The Download Drive Firmware warning opens and prompts: "Do you want to
continue?” Type yes and click OK to start the drive firmware download.

The Download Progress window opens. Do not intervene until the download
process completes.

Every drive scheduled for firmware download will be designated as in
progress until successful or failed.

Note: Complete the following two steps if you receive a failure.
a. Click the Save as button to save the error log.

b. On the Subsystem Management window’s menu bar, click
Advanced »Trouble Shooting » Open Event Log and complete
the following tasks necessary to save the storage subsystem event
log before contacting your IBM Service Representative and
proceeding to step
1) Click the Select all button.

2) Click Save the Storage Subsystem Event Log.

When the Close button appears active, the drive firmware download process is
complete.

Click Close to exit the Download Progress window.
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17. Use either of the following procedures to determine or verify what level of drive
firmware resides on a particular drive:

* Right-click on that drive in the Logical/Physical View in the Subsystem
Management window and click Properties. The associated drive firmware
version will be listed in the drive properties table.

* Right-click on Storage Subsystem » View Profile in the Logical/Physical
View of the Subsystem Management window.

Downloading Storage Manager version 8.x drive firmware
To download drive firmware for DS4000 Storage Manager version 8.x, perform the
following steps:

1. From the Enterprise Management window, select a storage subsystem.
2. Click Tools » Manage Device. The Subsystem Management window opens.

3. Click Advanced » Download » Drive Firmware. The Download Drive
Firmware window opens. It presents a list of all installed drives.

4. From the list of all installed drives, select the drive to which you plan to
download drive firmware.
Press and hold the Ctrl key while using your mouse to select multiple drives
singly, or press and hold the shift key while selecting multiple drives in series
by using your mouse pointer.

5. Click Browse to identify the directory that contains the drive firmware that you
intend to download.

6. Select the file containing the drive firmware that you intend to download.
7. Select Start. The Confirm Download window appears.

8. Type yes when the Confirm Download window prompts: Are you sure you
want to continue?

9. The download begins and the Status window indicates progress. Do not
intervene until the download process completes.

10. When the Cancel button appears active, the download process is complete.
Press Cancel to close the Status window.

11. To determine or verify the level of drive firmware residing on a particular drive,
click View » Subsystem Profile in the Logical/Physical View of the Subsystem
Management window.

Bringing storage subsystems and drive loops into optimal state

Note: For additional information on how to make this determination, see the
DS4000 Problem Determination Guide associated with your particular
DS4000 hardware model.

After you have updated or verified that a DS4000 Storage Server is using the latest

firmware and NVSRAM:

__Step 1. Bring the DS4000 Storage Server to its optimal state before
reconfiguring it with new hardware.

__Step 2. Use the DS4000 Storage Manager client program to display the status
of the DS4000 Storage Server and to correct any problems that might
cause the DS4000 Storage Server to enter its Needs Attention state.

__Step 3. Verify that all indicator lights on the storage subsystem are in their
optimal state.

__Step 4. In addition, use the Read_Link_Status function of the DS4000 Storage
Manager client program and the DS4000 Storage Server MEL to verify
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that all components in the drive loop are in their optimal states (that is,
there are no drive loop component errors in the event log and no errors
in the Read_Link_Status window.) If you are using controller firmware
06.10.xx.xx, use the drive channel diagnostics to determine if the drive
loop is optimal. See the DS4000 Storage Manager Client program
Subsystem Management window Online help for more information on
the RLS and drive channel diagnostics if they are supported by the
installed version of your controller firmware.

Drive channel diagnostics are only available if you are using controller
firmware version 06.10.xx.xX.

__Step 5. If the arrays are in degraded state due to a failed drive, correct the
problem before migration.

If necessary, contact the IBM Help Center in your geography for assistance with
event log interpretation.

It is necessary for certain tasks to complete before proceeding to add drives or
enclosures. Before you add drives or enclosures, verify that the storage subsystem
involved is not performing any of the following tasks.

» Dynamic logical drive capacity expansion (dynamic volume expansion [DVE] or
dynamic capacity expansion [DCE])

» Logical drive segment size modification

* Array RAID-level modification

* User-initiated array redundancy checking (menu option Array » Check
Redundancy in the Subsystem Management window)

* Remote mirror logical drive synchronization
+ FlashCopy® or VolumeCopy logical drive creation

» Logical drive reconstruction or copyback. This action is sometimes referred to as
logical drive sparing.

Saving the storage subsystem profile

Use the DS4000 Storage Manager client program to save a DS4000 Storage
Server profile. Such a profile is necessary to restore a storage subsystem
configuration in the event of a catastrophic failure. Migration from one DS4000
Storage Server configuration to another will require that you save both DS4000
Storage Server configuration profiles involved. For details on this procedure, see
one of the following:

* DS4000 Storage Manager client program Client Subsystem Management window
online help

» IBM TotalStorage DS4000 Storage Manager installation and support guide
associated with your particular operating system environment located at:

[www-1.ibm.com/servers/storage/support/disk/]

» Saving a module profile report and state capture information to help prevent data
loss located at:

|www-3.ibm.com/pc/support/site.wss/document.do?lndocid:MIGR-4VVPEF|

Important: Do not store DS4000 Storage Server profiles in the same location as
the logical drives defined on your DS4000 Storage Server. Should you do so, and a
RAID array failure occurs during subsequent migration, the data will be lost.
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Handling static-sensitive devices

Attention: Static electricity can damage electronic devices and your system. To
avoid damage, keep static-sensitive devices in their static-protective packages until
you are ready to install them.

To reduce the possibility of electrostatic discharge (ESD), observe the following
precautions:

Limit your movement. Movement can cause static electricity to build up around
you.

Handle the device carefully, holding it by its edges or its frame.

Do not touch solder joints, pins, or exposed printed circuitry.

Do not leave the device where others can handle and possibly damage the
device.

While the device is still in its static-protective package, touch it to an unpainted
metal part of the system unit for at least two seconds. This drains static electricity
from the package and from your body.

Remove the device from its package and install it directly into your system unit
without setting it down. If it is necessary to set the device down, place it in its
static-protective package. Do not place the device on your system unit cover or
on a metal table. Take additional care when handling devices during cold weather
because heating reduces indoor humidity and increases static electricity.
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Chapter 3. Adding one or more new hard drives

While adding a hard drive to either a controller or a drive expansion enclosure,
observe these important rules:

» Observe proper electrostatic discharge (ESD) procedures when handling
electronic equipment. See [‘Handling static-sensitive devices” on page 45| for
additional information.

* Never alter the physical configuration of a DS4000 Storage Server while it is
powered off unless you are instructed to do so as part of a DS4000 configuration
procedure. Specifically, never attach storage components to or remove storage
components from a configured DS4000 Storage Server while it is powered off.

* Any hard drive, whether new or old, might contain configuration data. Unless you
intend to migrate a drive from another DS4000 Storage System (retaining its
configuration data), always use the following procedure to add one or more hard
drives to a functioning DS4000 Storage Server configuration.

» The following DS4000 storage server devices support only 2 Gbps fibre channel
hard drives:

— DS4000 EXP700 storage expansion units
— DS4000 EXP710 storage expansion units
— DS4300 storage servers

* 1 Gbps fibre channel drives will not work properly when you insert them into the
drive slots of the aforementioned DS4000 storage devices.

Attention: Always make certain that a fibre channel drive can operate at the
fibre channel speed of the drive loop involved before inserting it into the drive
slots in a DS4000 Storage Server configuration. In needed, contact IBM support
to ensure the compatibility of your drives before migrating them from one
DS4000 configuration to another.

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine
its ID or Model Number. Hard drives with ID or Model Number values that end
with “04FC” or “O3FC” are 1 Gbps fibre channel drives. For example,
“ST173404FC”, “ST318203FC” and “ST136403FC” are model numbers that
appear on several 1 Gbps fibre channel hard drives. 1 Gbps fibre channel drives
might also be mounted in a tray with the front bezel that is about .75” wider than
the 2 Gbps drive tray bezel.

You may also obtain the drive product model and ID through the DS4000 Storage
Server profile. For information on how to do so, see [‘Determining a drive’s|
[product ID and model” on page 35.|

* Do not mix SATA and fibre channel drives or enclosures together in the same
drive loop.

* Do not install SATA drives in fibre channel device enclosures.
¢ Do not install fibre channel drives in SATA device enclosures.

The following procedure outlines the steps necessary to add one or more new hard
drives to empty drive slots in either DS4100, FAStT200, or DS4300 controllers or in
EXP100, EXP500, EXP700, or EXP710 storage expansion enclosures. If you plan
to add a used drive, be sure that there is no configuration data on the drive that you
need to preserve. Add drives to a DS4000 Storage Server only while it is powered
on and in optimal state. See the DS4000 Problem Determination Guide associated
with your particular DS4000 hardware model or [‘Bringing storage subsystems and|
drive loops into optimal state” on page 43| for additional information on how to make
this determination.
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Activity 1: Disabling the drive migration settings

Before you add drives to the subsystem, perform this activity to remove any
configuration data that they may contain.

__Step 1. Open the Storage Manager client program’s Enterprise Management
window.

__Step 2. Right-click on the name of the DS4000 storage subsystem to which you
intend to add drives and click Execute Script.

__ Step 3. A script editor window opens. Click File » Load Script.

__ Step 4. A Load Script file selection window opens. Locate and select the file
named DisableDriveMigration.scr and click OK. The
DisableDriveMigration.scr file is normally located in the SCRIPTS
directory of the IBM DS4000 Storage Manager Installation Compact
Disc (CD). Use this file to reset the DS4000 storage subsystem setting
to ignore configuration data that might reside on newly discovered hard
drives. [Figure 15 on page 51|provides a listing of the
DisableDriveMigration.scr file.

__Step 5. Click Tools » Verify and Execute to run the script.

__ Step 6. When the script completes execution, reset both DS4000 controllers to
enable the DS4000 drive migration setting.

If you used the DisableDriveMigration.scr script associated with this
document and described in [Figure 14 on page 50} it is not necessary
for you to perform this step because the last two commands in that
script file automatically reset the controllers.

To reset the controllers, open the Storage Subsystem Management
window and sequentially (one at a time) reset each controller by clicking
Advanced » Reset Controller. Then, follow the instructions in the
Reset Controller window when it opens.

Activity 2: Inserting drives

___Step 1. Insert drives as pairs (two at a time) into the empty drive slots.

__ Step 2. Wait until each drive pair has fully spun up and displayed in the
DS4000 Storage Subsystem Management window before inserting the
next drive pair.

Activity 3: Re-enabling the drive migration settings

Perform this activity to re-enable the drive migration settings if you performed
[‘Activity 1: Disabling the drive migration settings”|to disable DS4000 storage
subsystem drive migration settings. If you do not, whenever you might
subsequently, even momentarily remove a drive from the storage subsystem for any
reason, its configuration data will be cleared. When the storage subsystem next
recognizes such a drive, it will display it as unconfigured.

Attention: In order to prevent data loss, set the DS4000 Storage Server drive
migration to enable after you complete the hard drive addition process.

__Step 1. Open the Storage Manager client program Enterprise Management
window.

__ Step 2. Right-click on the name of the DS4000 storage subsystem to which you
want to add drives and click Execute Script.

__ Step 3. A script editor window opens. Click File » Load Script.
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__ Step 4.

__Step 5.
__Step 6.

A Load Script file selection window opens. Locate, and select the file
named EnableDriveMigration.scr and click OK. The file
EnableDriveMigration.scr is normally located in the SCRIPTS directory of
the IBM DS4000 Storage Manager Installation CD. Use this file to reset
the DS4000 storage subsystem setting in order to check for
configuration data that might reside on newly discovered hard drives.

|Figure 14 on page 50| provides a listing of the EnableDriveMigration.scr

file.
Click Tools » Verify and Execute to run the script.

When the script completes execution, reset both DS4000 controllers to
enable the DS4000 drive migration setting.

If you use the EnableDriveMigration.scr script associated with this
document and described in [Figure 14 on page 50} it is not necessary
for you to perform this step because the last two commands in that
script file automatically reset the controllers.

To reset the controllers, open the Storage Subsystem Management
window and sequentially (one at a time) reset each controller by clicking
Advanced » Reset Controller, and then following the instructions in
the Reset Controller window when it opens.

Result: The newly added drives are ready for you to configure and map
to host servers.

The next two figures list the EnableDriveMigration.scr and DisableDriveMigration.scr

files.
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// Name: Enable Drive Migration

//

// Date: 05-08-2004

// Revision: 1.3

// Comments:

// This script is intended to work with controllers at Firmware 05.30.xx.xx and
// higher only.

//

// This script returned the FAStT to it's default operation of importing
// configuration informration from disks.

//

// This script will reboot both controllers in the FAStT unit. If your
// hosts are configured for multi-path support, this can be done with I1/0
// running to the controllers. If your hosts are not configured for

// redundant access you must schedule downtime before running this

// script.

//

// See the directions at the bottom of this script if you do not have multi
// path software installed and wish to prevent the controller restarts
//

// Show the current state of Drive Migration

show "Showing the current state of Drive Migration (80=0ff, 82=0n)";
show controller[a] nvsrambyte[0x35];

show controller[b] nvsrambyte[0x35];

//

// Setting Drive Migration to Enable

show "Setting Drive Migration to Enable";

set controller[a] nvsrambyte[0x35] = 0x02,0x00;

set controller[b] nvsrambyte[0x35] = 0x02,0x00;

show controller[a] nvsrambyte[0x35];

show controller[b] nvsrambyte[0x35];

//

// Reset Controllers to make changes active. Note:

// To prevent the controllers from restarting, add '//' to the beginning
// of each of the lines below. This will comment out the restart of the
// controllers. Important: The controllers will have to be restarted for the
// changes in this script to take effect.

//

show "Resetting controller A";

reset Controller [a];

show "Resetting controller B";

reset Controller [b];

show "Drive Migration is now enabled.";

Figure 14. EnableDriveMigration.scr file listing
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// Name: Disable Drive Migration

// Date: 05-08-2004

// Revision: 1.3

// Comments:

// This script is intended to work with controllers at Firmware 05.30.xx.xx and
// higher only.

// This script allows the addition of disk drives while the system is running
// and by clearing the configuration of any drives as unused capacity

// regardless of past configuration of these drives.

// Attention: This setting should not be Teft active after the new disks have
// been added to the subsystem. Leaving this setting active could

// cause the configuration for the FAStT to be lost if the FAStT is

// power cycled incorrectly. Please run the EnableDriveMigration.scr

// after all the disks are added.

// This script will reboot both controllers in the FAStT unit. If your

// hosts are configured for multi-path support, this can be done with I1/0
// running to the controllers. If your hosts are not configured for

// redundant access you much schedule downtime before running this

// script.

// Show the current state of Drive Migration

show "Showing the current state of Drive Migration (80=0ff, 82=0n)";
show controller[a] nvsrambyte[0x35];

show controller[b] nvsrambyte[0x35];

//

// Setting Drive Migration to Disable

show "Setting Drive Migration to Disable";

set controller[a] nvsrambyte[0x35] = 0x02,0x02;

set controller[b] nvsrambyte[0x35] = 0x02,0x02;

show controller[a] nvsrambyte[0x35];

show controller[b] nvsrambyte[0x35];

//

// Reset Controllers to make changes active

// To prevent the controllers from restarting, add '//' to the beginning
// of each of the lines below. This will comment out the restart of the
// controllers. Important: The controllers will have to be restarted for
// the changes in this script to take effect.

show "Resetting controller A";

reset Controller [a];

show "Resetting controller B";

reset Controller [b];

//

show "Drive Migration is now disabled. Add the new drives to the subsystem,";
show "then execute the EnableDriveMigrationScript.scr to re-enable drive ";
show "migration.";

Figure 15. DisableDriveMigration.scr file listing
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Chapter 4. Migrating one or more hard drives

Note: When migrating hard drives from multiple DS4000 storage servers to a

single DS4000 Storage Server, move all of the hard drives from the first
DS4000 Storage Server as an independent ’set’ to the destination DS4000
Storage Server. Before moving hard drives as a ’set’ from subsequent
DS4000 storage servers, ensure that all of the hard drives from the previous
’set’ have been successfully transferred to the destination DS4000 Storage
Server. If you do not transfer hard drives as ’sets’ to the destination DS4000
Storage Server, the newly relocated array may not appear in the Subsystem
Management window.

While migrating a hard drive to either a controller or a drive expansion enclosure,
observe these important rules:

© Copyright IBM Corp. 2004

Observe proper ESD procedures when handling electronic equipment. See
[‘Handling static-sensitive devices” on page 45 for additional information.

Never alter the physical configuration of a DS4000 Storage Server while it is

powered off unless you are instructed to do so as part of DS4000 configuration
procedure. Specifically, never attach storage components to or remove storage
components from a configured DS4000 Storage Server while it is powered off.

Any hard drive, whether new or old, might contain configuration data. Use this
procedure to preserve the configuration and user data in one or more hard drives
that you will migrate to a functioning DS4000 Storage Server configuration. Do
not use this procedure if you are unsure of the quality of the data on the hard
drives.

The following DS4000 storage server devices support only 2 Gbps fibre channel
hard drives:

— DS4000 EXP700 storage expansion units
— DS4000 EXP710 storage expansion units
— DS4300 storage servers

1 Gbps fibre channel drives will not work properly when you insert them into the
drive slots of the aforementioned DS4000 storage devices.

Attention: Always make certain that a fibre channel drive can operate at the
fibre channel speed of the drive loop involved before inserting it into the drive
slots in a DS4000 Storage Server configuration. In needed, contact IBM support
to ensure the compatibility of your drives before migrating them from one
DS4000 configuration to another.

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine
its ID or Model Number. Hard drives with ID or Model Number values that end
with “04FC” or “03FC” are 1 Gbps fibre channel drives. For example,
“ST173404FC”, “ST318203FC” and “ST136403FC” are model numbers that
appear on several 1 Gbps fibre channel hard drives. 1 Gbps fibre channel drives
might also be mounted in a tray with the front bezel that is about .75” wider than
the 2 Gbps drive tray bezel.

You may also obtain the drive product model and ID through the DS4000 Storage
Server profile. For information on how to do so, see [‘Determining a drive’s]
[product 1D and model” on page 35.|

Do not mix SATA and fibre channel drives or enclosures together in the same
drive loop.

Do not install SATA drives in fibre channel device enclosures.
Do not install fibre channel drives in SATA device enclosures.
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Activity 1: Preliminary activities

The following procedure describes the steps that you must perform to migrate one
or more drives from a functioning DS4000 Storage Server configuration to another
DS4000 Storage Server configuration. Drives described in the following steps are
those that contain configuration data that you want to preserve. Add such drives to
a DS4000 Storage Server only while it is powered on and in its optimal state. See
the DS4000 Problem Determination Guide associated with your particular DS4000
hardware model or|“Bringing storage subsystems and drive loops into optimal state”l
for additional information on how to assess the state of a DS4000
Storage Server.

Tip: Before you attempt to complete the drive migration procedure, review and
perform the steps documented in [Chapter 2, “Prerequisites to adding capacity and|
|hard drive migration,” on page 37

The procedure for migrating hard drives which contain configuration data that you
want to preserve is as follows:

Before you remove drives from a functioning DS4000 Storage Server, perform the
following steps to ensure that you successfully migrate the drives to the destination
DS4000 Storage Server.

__Step 1. Perform a backup of the logical drives defined in the hard drives that
you plan to migrate.

___Step 2. Stop all programs, services or processes in the host servers that
access the logical drives defined in the migrated hard drives. Make
sure that there are not any running background programs, services or
processes that write data to the logical drives. (For example, the
Microsoft MSCS service periodically writes to the “Quorum” disk.)

__Step 3. Unmount the file systems to flush I/O from the server cache to disks.

Notes:

a. In a Microsoft Windows environment, remove the drive letter or the
mount points of the mapped LUNs instead of unmounting the file
systems.

b. Consult documentation associated with your particular operating
system for detailed information regarding the Unmount procedure.

__ Step 4. Verify that the DS4000 Storage Server controller and NVSRAM of both
the source and destination systems are at or above levels described in
[Table 24 on page 39|

__Step 5. Verify that the names of the logical drives that are associated with
hard drives on both the source and destination systems are unique. If
they are not, make the necessary changes.

__Step 6. In addition to array configuration information, any storage partitioning
configuration data that may reside on drives you plan to migrate will
migrate with those drives when installed on another DS4000 Storage
Server. For this reason, take the following precautions to facilitate the
migration process and prevent problems in storage partitioning
configuration data migration.

a. If a DS4000 storage partitioning premium feature has been
enabled both on a drive’s original and destination DS4000 storage
servers, assure that the defined host ports, hosts, and host group
names are unique to each DS4000 storage server involved in the
migration.
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__ Step 7.
__Step 8.

__Step 9.

__ Step 10.

__ Step 11.

__ Step 12.

__ Step 13.

b. If you must use identical names on both DS4000 storage servers,
make the names unique before you perform the drive migration.

If necessary, customize the storage partitioning information on the
DS4000 storage server to which you have migrated the drives after
you complete the migration.

Delete any flashcopies of the logical drives defined on the drives that
you plan to migrate.

Remove any remote mirror relationships using the logical drives
defined on the drives that you plan to migrate.

Ensure that the arrays and logical drives are in optimal state before
starting the migration process. See the DS4000 Problem
Determination Guide associated with your particular DS4000 hardware
model or [‘Bringing storage subsystems and drive loops into optimal|
|state” on page 43/ for additional information on how to make this
determination.

Place the arrays defined in the hard drives that you plan to migrate in
offline state. To do so, right-click on the name of the array in the
Storage Subsystem Management window and click Place » Offline.

If you migrate drive expansion enclosures from a 1 Gbps fibre channel
environment to a 2 Gbps fibre channel environment, verify that the
fibre channel hard drives that you plan to migrate are each capable of
2 Gbps operation and that you have installed the latest firmware
enabling them to work properly in a 2 Gbps fibre channel environment.

Save the DS4000 storage subsystem profile of the functioning DS4000
Storage Server configuration to which the migration will occur in a
location other than that of the logical drives you plan to migrate.

If you migrate the drives to a single controller DS4000 Storage Server
(for example, DS4300 Storage Server, model 6LU or 6LX), change the
logical drive’s preferred owner to Controller A using the DS4000
Storage Manager client program before taking it offline and removing it
from the DS4000 Storage Server. To set Controller A as the logical
drive preferred owner, right-click the logical drive entry in the
Subsystem Management window and select Change »
Ownership/Preferred Path » Controller A.

Activity 2: Removing the drives to be migrated

While the functioning DS4000 Storage Server is still powered on, remove the hard
drives that you plan to migrate one at a time using the following steps:

__ Step 1.
__Step 2.

__ Step 3.
__ Step 4.

__Step 5.

Press on the inside of the bottom of the tray handle to release the blue
latch.

Lift the closed latch to its open position. (The latch is at a 90-degree
angle to the front of the drive when open.)

Using the handle, slowly pull the drive %-inch out of its drive slot.

Wait at least 20 seconds to allow the hard drive to spin down before
fully removing it from the drive slot.

Place the hard drive into an ESD bag or container before moving it to
the new DS4000 Storage Server.
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Figure 16. Drive CRU assembly
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Attention: Orient drives horizontally and place them in appropriate ESD
bags or containers before relocation. When in transit, use only moving
equipment that prevents shock to the drives. Never stack drives.

Activity 3: Inserting the drives to be migrated

Note: When migrating hard drives from multiple DS4000 storage servers to a
single DS4000 Storage Server, move all of the hard drives from the first
DS4000 Storage Server as an independent "set’ to the destination DS4000
Storage Server. Before moving hard drives as a 'set’ from subsequent
DS4000 storage servers, ensure that all of the hard drives from the previous
'set’” have been successfully transferred to the destination DS4000 Storage
Server. If you do not transfer hard drives as ’sets’ to the destination DS4000
Storage Server, the newly relocated array may not appear in the Subsystem
Management window.

__Step 1. While the destination DS4000 Storage Server is powered on, insert the
migrating drives into the empty drive slots in pairs. Wait until the
inserted drive pair is fully spun up and displayed in the DS4000 Storage
Subsystem Management window before inserting the next drive pair.

__Step 2. As the DS4000 Storage Server recognizes the drives, it reads and
displays the array and logical drive information in the Logical/Physical
view of the DS4000 Storage Subsystem Management window. The
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__ Step 3.

__ Step 4.

__Step 5.

storage subsystem represents arrays in off1line state until it recognizes
that you have inserted all of the drives that comprise an array.

After you migrate all of the drives, manually change the state of the
arrays and logical drives involved from optimal to online state if it has
not changed automatically. To do so, right-click on the array name in the
Storage Subsystem Management window and select Place » Online. If
any of the following conditions persist, contact the IBM Help Center in
your geography for assistance:

* The empty drive slot icon ( 1) displayed for the drive slot into which
you inserted the migrating drive.

» The Failed unconfigured drive icon ( @ ) or the Failed configured

drive icon ( g ) displayed for the drive slot into which you inserted
the migrating drive.

» Array configuration data on the drives you have added is incomplete.
* You cannot bring the array online.

Attention: Do not initialize a drive that you want to keep (by
right-clicking its icon and selecting Initialize from the pull-down menu) if
it contains configuration or user data. Initializing any drives in a defined
array causes all hard drives known to comprise that array to return to
the Unconfigured Capacity storage pool, deleting their array definitions
from the DS4000 Storage Server configuration. The user data on such
drives is lost.

Result: Once the arrays are online, they are ready to for you to
configure and map to host servers. You might also then recreate
flashcopies of the logical drives.

Use the DS4000 Storage Manager program to view the storage
partitioning definitions and make any necessary corrections.

The DS4000 Storage Server that the drives are migrated from will
display the logical drives that are defined in these drives as “missing
LUNSs”. In order to remove these “missing LUNSs” entries, right-click on
each entry and select Delete from the pull-down menu.

Migrating arrays within storage subsystems

Important:

1. Assure that your controller firmware is at or above the level documented in

[Table 24 on page 39, Do not rearrange more than two or three arrays at a time.

2. Unmount the file systems to flush I/O from the server cache to disks.

Notes:

a. In a Microsoft Windows environment, remove the drive letter or the mount
points of the mapped LUNs instead of unmounting the file systems.

b. Consult documentation associated with your particular operating system for
detailed information regarding the Unmount procedure.

Using the configuration data on existing drives, it is possible to redistribute the
drives that made up an RAID array across a storage subsystem to which you may
be adding expansion enclosures. |Figure 17 on page 58] illustrates a storage array
distributed across three drives on a single storage device before and after
reordering. When you redistribute each drive to a different position in the same
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storage enclosure as recommended, the array automatically redistributes

accordingly.
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Figure 17. Manner recommended for reordering a defined array using empty slots in one
storage enclosure

illustrates a storage array distributed across three drives on a single
storage device before reordering across two storage devices. When the drives are
redistributed across an additional storage enclosure in the storage subsystem as
recommended, the array automatically redistributes accordingly.
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Figure 18. Manner recommended for reordering a defined array using empty slots in two
storage enclosures

Figure 19]illustrates two arrays distributed across five drives and two storage
enclosures before and after reordering the same drives across other drive slots in
the same two storage enclosures.

Important: Before you attempt to reinsert any of the drives from either enclosure,
place the array into offline state using the DS4000 Storage Manager client and
completely remove all of the drives of both arrays from both storage enclosures and
wait for the storage manager to mark the arrays/logical drives as missing. After you
insert the drives associated with the first array, wait until that array comes online in
a DS4000 Storage Manager Subsystem Management window before you insert the
drives associated with the second array.
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Figure 19. Reordering multiple defined arrays across previously used slots in two storage
enclosures

Perform the following steps to ensure success when you reorder drives that make
up arrays across different drive slots in the same DS4000 Storage Server
configuration.

1. Start the DS4000 Storage Manager Client program and open the Subsystem
Management window (for the DS4000 Storage Subsystem which drives you
intend to reorder).
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Set the arrays that you plan to move offline.

Mark the drives in the arrays.

Unlatch the drives from their respective slots. Wait at least 2 minutes for each
drive to spin down.

Slowly and carefully remove the drives from their slots.

Assure that all of the drives that made up the arrays are completely removed
from their slots.

Wait for the storage manager to mark the arrays/logical drives as missing in
the Subsystem Management window. See [Figure 20} Do not proceed to step [g]

until all of the defined logical drives in the array(s) whose drives are removed
from the DS4000 enclosures display as missing.
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Figure 20. Subsystem Management Logical/Physical View of Missing Logical Drives

8.

10.

11.

Carefully reinsert all of the drives that made up a single array into the empty

slots of the storage enclosure. Do not insert the drives into empty slots that are

part of another array definition whose drives are still inserted in the storage
enclosures. Data on the drives you insert will be replaced with the
reconstructed data from the previously installed RAID array.

The system will recognize the array and bring it online when you finish
inserting all of the drives.

Repeat steps and|§|for each of the arrays that were removed from the
storage enclosure.

Save the storage subsystem profile. See [‘Saving the storage subsystem|
[profile” on page 44| for information on performing this activity.

Note: Do not reinsert drives from multiple arrays in random order into the
storage enclosures.

Chapter 4. Migrating one or more hard drives
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Chapter 5. Adding expansion units containing new hard
drives

While adding storage expansion enclosures containing new hard drives, observe
these important rules:

» Observe proper ESD procedures when handling electronic equipment. See
[‘Handling static-sensitive devices” on page 45 for additional information.

* Never alter the physical configuration of a DS4000 Storage Server while it is
powered off unless you are instructed to do so as part of DS4000 Storage Server
configuration procedure. Specifically, never attach storage components to or
remove storage components from a configured DS4000 Storage Server while it is
powered off.

* Any hard drive, whether new or old, might contain configuration data. Unless you
intend to migrate drives from another DS4000 Storage System (retaining their
configuration data), always use the following procedure to add one or more
storage expansion enclosures containing one or more hard drives to a
functioning DS4000 Storage Server configuration.

» The following DS4000 Storage Server devices support only 2 Gbps fibre channel
hard drives:

— DS4000 EXP700 storage expansion units
— DS4000 EXP710 storage expansion units
— DS4300 storage servers

* 1 Gbps fibre channel drives will not work properly when you insert them into the
drive slots of the aforementioned DS4000 storage devices.

Attention: Always make certain that a fibre channel drive can operate at the
fibre channel speed of the drive loop involved before inserting it into the drive
slots in a DS4000 Storage Server configuration. In needed, contact your IBM
support representative to ensure the compatibility of your drives before migrating
them from one DS4000 configuration to another.

To identify a 1 Gbps fibre channel drive, locate the product’s label and examine
its ID or Model Number. Hard drives with ID or Model Number values that end
with “04FC” or “03FC” are 1 Gbps fibre channel drives. For example,
“ST173404FC”, “ST318203FC” and “ST136403FC” are model numbers that
appear on several 1 Gbps fibre channel hard drives. 1 Gbps fibre channel drives
might also be mounted in a tray with the front bezel that is about .75” wider than
the 2 Gbps drive tray bezel.

You may also obtain the drive product model and ID through the DS4000 Storage
Server profile. For information on how to do so, see [‘Determining a drive’s
[product ID and model” on page 35.|

* Do not mix SATA and fibre channel drives or enclosures together in the same
drive loop unless you have met the fibre channel/SATA intermix requirements.
See [‘Intermixing storage expansion enclosures” on page 2 for that information.

« Do not install SATA drives in fibre channel device enclosures.
e Do not install fibre channel drives in SATA device enclosures.

The following procedure describes the steps required to add one or more DS4000
storage expansion enclosures containing new drives to a functioning DS4000
Storage Server configuration.
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Activity 1: Preliminary activities

Add a new DS4000 storage expansion enclosure as follows:

__Step 1.

__Step 2.

__ Step 3.

__ Step 4.

Verify that the DS4000 Storage Server is both powered on and in
optimal state. See the DS4000 Problem Determination Guide
associated with your particular DS4000 hardware model or|“Brinqina
|storage subsystems and drive loops into optimal state” on page 43 for
additional information on how to make this determination. You can
perform this process while the DS4000 Storage Server is processing
I/0 from or to the host server. However, because the drive loops are
interrupted momentarily during the addition process, schedule additions
to occur during time periods of low 1/O between the DS4000 storage
servers and host servers.

Note: Though there are no restrictions against cabling EXP100 and
EXP700 storage expansion units together, for ease of future
maintenance and possible problem troubleshooting, IBM
recommends that you group or plan your configuration to allow
for grouping of the drive expansion enclosures by type in a
DS4000 storage server redundant drive loop, if possible.

Review the readme and the IBM TotalStorage DS4000 Storage

Manager installation and support guide associated with the operating

system environment of the host servers that connect to the DS4000

Storage Server for any additional restrictions or required preparation

tasks specific to your particular operating system environment. You will

find the IBM TotalStorage DS4000 Storage Manager installation and
support guides at:

[www-1.ibm.com/servers/storage/support/disk/

If the new storage expansion enclosure is not the same type as the
existing storage expansion enclosures (some or all) see [‘Intermixing
[storage expansion enclosures” on page 2| for intermix information.
Unpack and mount any additional storage expansion enclosures in the

rack using the mounting hardware supplied with each storage
expansion enclosure.

Important: Do not fully insert hard drives into the enclosures at this
time. Keep them unlatched and no less than %-inch away from their full
insertion points in the drive slots.

Set the enclosure ID of the additional storage expansion enclosures.
Each drive enclosure in the DS4000 Storage Server drive loop must
have a unique drive enclosure ID. In a EXP500 storage expansion
enclosure, there is an enclosure ID switch mounted on each of two
ESM canisters. Set each ESM canister’s enclosure ID switch in the
EXP500 drive enclosure to the same unique number in the drive loop.
In a EXP700 storage expansion enclosure, the only enclosure ID switch
is mounted between the power supplies. See the appropriate DS4000
storage expansion unit installation and user’s guide for additional
information. [Figure 21 on page 63 illustrates the location of speed
switches on the EXP100, EXP700, EXP710, and EXP500 storage
enclosures.
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Figure 21. EXP100, EXP500, EXP700, and EXP710 enclosure ID and speed switches

If the DS4000 Storage Server to which the storage expansion enclosure
will attach is either a FAStT200 or DS4300, the enclosure IDs of
additional storage expansion enclosures must differ from the FAStT200
or DS4300 Storage Server enclosure IDs, which are normally set to “0”
at the factory.

__Step 5. Verify that the EXP700 Storage Expansion Unit speed switch is set to
the correct drive loop speed.

Note: If a fibre channel enclosure speed switch was originally set to 1
Gbps, do not automatically set it to 2 Gbps unless you are sure
that each fibre channel hard drive that it now contains is capable
of 2 Gbps operation and that you have installed the latest
firmware enabling their operation in a 2 Gbps fibre channel
environment.

Activity 2: Cabling new storage expansion units

To complete addition of DS4000 storage expansion enclosures, cable the new
storage expansion enclosures to the end of the functioning storage expansion
enclosure drive loop to which you are migrating them. Add only one enclosure at a
time to a functioning drive loop if you intend to attach multiple storage expansion
enclosures.

It is possible to connect new storage expansion enclosures at either end of a
functioning storage expansion enclosure drive loop. The two options are:

1. the beginning, closest to the controller (at the top, directly attached to controller
A) as described in [Connecting new storage expansion units at the beginnind
[(top) of a drive loop|

2. the end, furthest from the controller (at the bottom, directly attached to controller
B) as described in|Connecting new storage expansion units at the end (bottom)|
|of a drive Ioop|

Of the two options, IBM recommends only option Ig connection to the end (at the
bottom) of a functioning storage expansion enclosure drive loop, directly attached to
controller B. This is recommended because if the existing DS4000 storage server
configuration is not planned for cabling in new storage expansion enclosures at the
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top of the drive loop, cluttered or entangle fibre channel drive loop cabling may
hinder drive loop troubleshooting or cause fibre channel cabling errors. With this in
mind, and depending on your requirements, however, follow either of the instruction
sets at [‘Connecting new storage expansion units at the end (bottom) of a drive]
loop”| or[“Connecting new storage expansion units at the beginning (top) of a drive]
loop” on page 68|

Connecting new storage expansion units at the end (bottom) of a drive

loop

Cabling instructions in the steps that follow are based on the cable routing scheme
that is documented in IBM TotalStorage DS4000 Storage Manager installation and
support guides. The cabling instructions illustrated in |Figure 22 on page 66|,

[Figure 23 on page 67} and [Figure 24 on page 68|describe cabling a DS4000
EXP700 Storage Expansion Enclosure to the end (bottom) of a redundant drive
loop of a functioning DS4300 Storage Server (model 60X or 60U). Again, IBM
recommends that you add storage expansion enclosures only in this manner.

The general cabling scheme for DS4000 external drive enclosures is described in
the IBM TotalStorage DS4000 Fibre Channel Cabling Guide available at:

www-3.ibm.com/pc/support/site.wss/document.do?Indocid=MIGR-4KELS5|

See also [‘DS4000 Storage Server drive loop schemes” on page 25

__Step 1. Insert the small form-factor pluggables (SFPs) or gigabit interface
converters (GBICs) into only those ports you intend to use. Do not
leave GBICs or SFPs inserted into port slots without connecting them to
other ports using cables.

__Step 2. Extend one of the drive loops (that is, drive loop A) in a DS4000
Storage Server redundant drive loop pair by connecting the 0UT port of
the last storage expansion enclosure to the IN port of the new storage
expansion enclosure as shown in [Figure 22 on page 66,

Warning: Carefully reconfigure only one drive loop at a time, making
sure that the drive loop that you modify is properly connected and in
optimal state before you attempt to reconfigure another drive loop.
Take this precaution to prevent the arrays from being inadvertently
failed by the DS4000 Storage Server controllers. This happens when
two or more drives in the arrays cannot be reached through either drive
loop in the redundant drive loop pair.

__Step 3. Power on the newly added storage expansion enclosure unit.

__ Step 4. Wait a few seconds; verify that the port bypass LEDs of all of the ports
in drive loop A, now extended to the new storage expansion enclosure,
are not lit. Using the DS4000 Storage Manager Client Subsystem
Management window, verify that the new storage expansion enclosure
is added and displayed in the Logical/Physical view of the window.

Correct any errors before proceeding to step[5 on page 65| For port

bypass:
__a. Verify that the SFPs and GBICs or fibre cables are in good
condition.

Remove and reinsert SFPs, GBICs and fibre cables.

Make sure the new drive expansion enclosure speed switch is
set to the same speed as the existing drive expansion
enclosures and the DS4000 Storage Server speed setting.
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__ Step 5.

__Step 6.

__Step 7.

__Step 8.

__d. Verify that the ESM is good by physically removing and
swapping it with the other ESM in the same drive expansion
enclosure. For enclosure ID conflict, set the drive expansion
enclosure ID switch to values unique from the current settings in
the existing drive expansion enclosures and storage server.

Contact the IBM Help Center in your geography for assistance if the
problems persist.

In the other drive loop (that is, drive loop B) in a DS4000 Storage
Server redundant drive loop pair, remove the connection from the
DS4000 Storage Server drive loop port to the OUT port of the last
storage expansion enclosure and connect it to the OUT port of the new
drive enclosure as shown in [Figure 23 on page 67

Wait a few seconds; verify that the port bypass LEDs of the two ports in
the connection between the DS4000 Storage Server drive loop port and
the OUT port of the new drive enclosure are not lit. Using the DS4000
Storage Manager Client Subsystem Management window, verify that
the new drive enclosure does not indicate the drive enclosure lost

redundancy path error. See the preceding step for

possible corrective actions, if needed.

Note: The existing storage expansion enclosures will be shown with
drive enclosure Tost redundancy path errors until you make
the fibre channel cabling connection described in step |2|

In drive loop B, cable the new drive enclosure’s IN port to the OUT port
of the last enclosure in the already functioning storage expansion
enclosure drive loop as shown in [Figure 24 on page 68|

Wait a few seconds; verify that the port bypass LEDs of all of the ports
in drive loop B to which you have added a new connection are not lit.
Using the DS4000 Storage Manager Client Subsystem Management
window, verify that all of the drive enclosures in the DS4000 redundant
drive loop pair to which the new enclosure was added does not report
the drive enclosure lost redundancy path error.
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Connecting new storage expansion units at the beginning (top) of a

drive loop

It is possible to add new storage expansion enclosures to either the beginning (top)
or end (bottom) of a functioning storage expansion enclosure drive loop. The
cabling instructions illustrated in [Figure 25 on page 70} [Figure 26 on page 71|, and
[Figure 27 on page 72| describe cabling a DS4000 EXP700 Storage Expansion
Enclosure to the beginning (top) of a redundant drive loop of a functioning DS4300
Storage Server (model 60X or 60U). IBM recommends that you refrain from adding
storage expansion enclosures in this manner, especially if there is insufficient rack
space to allow the methodical, uncluttered, and uniform fibre channel cabling of
such new enclosures. Without proper planning, disadvantages of adding expansion
units in this manner include cable management issues that contribute to avoidable
troubleshooting difficulties. See [Figure 30 on page 76 for the diagram of a properly
planned new expansion enclosure addition at the beginning (top) of a functioning
storage expansion enclosure drive loop.
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The general cabling scheme for DS4000 external drive enclosures is described in
the IBM TotalStorage DS4000 Fibre Channel Cabling Guide available at:

www-3.ibm.com/pc/support/site.wss/document.do?Indocid=MIGR-4KELS5

See also [‘DS4000 Storage Server drive loop schemes” on page 25)

__Step 1.

__Step 2.

__Step 3.
__ Step 4.

__ Step 5.

__Step 6.

Insert the small form-factor pluggables (SFPs) or gigabit interface
converters (GBICs) into only those ports you intend to use. Do not
leave GBICs or SFPs inserted into port slots without connecting them to
other ports using cables.

Extend one of the drive loops (that is, drive loop B) in a DS4000
Storage Server redundant drive loop pair by connecting the IN port of
the first (existing) storage expansion enclosure to the OUT port of the
new storage expansion enclosure as shown in |Figure 25 on page 70,

Warning: Carefully reconfigure only one drive loop at a time, making
sure that the drive loop that you modify is properly connected and in
optimal state before you attempt to reconfigure another drive loop.
Take this precaution to prevent the arrays from being inadvertently
failed by the DS4000 Storage Server controllers. This happens when
two or more drives in the arrays cannot be reached through either drive
loop in the redundant drive loop pair.

Power on the newly added storage expansion enclosure unit.

Wait a few seconds; verify that the port bypass LEDs of all of the ports
in drive loop B, now extended to the new storage expansion enclosure,
are not lit. Using the DS4000 Storage Manager Client Subsystem
Management window, verify that the new storage expansion enclosure
is added and displayed in the Logical/Physical view of the window.

Correct any errors before proceeding to step For port bypass:

__a. Verify that the SFPs and GBICs or fibre cables are in good
condition.

b. Remove and reinsert SFPs, GBICs and fibre cables.

Make sure the new drive expansion enclosure speed switch is
set to the same speed as the existing drive expansion
enclosures and the DS4000 Storage Server speed setting.

d. Verify that the ESM is good by physically removing and
swapping it with the other ESM in the same drive expansion
enclosure. For enclosure ID conflict, set the drive expansion
enclosure ID switch to values unique from the current settings in
the existing drive expansion enclosures and storage server.

Contact the IBM Help Center in your geography for assistance if the
problems persist.

In drive loop A, remove the connection from the DS4000 Storage
Server drive loop port to the IN port of the first storage expansion
enclosure and connect it to the IN port of the new drive enclosure as
shown in [Figure 26 on page 71}

Wait a few seconds; verify that the port bypass LEDs of the two ports in
the connection between the DS4000 Storage Server drive loop port and
the IN port of the new drive enclosure are not lit. Using the DS4000
Storage Manager Client Subsystem Management window, verify that
the new drive enclosure does not indicate the drive enclosure lost
redundancy path error. See the preceding stepfor possible corrective
actions, if needed.
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__Step 7. In drive loop A, cable the new drive enclosure’s 0UT port to the IN port
of the first enclosure in the already functioning storage expansion
enclosure drive loop as shown in[Figure 27 on page 72}

__ Step 8. Wait a few seconds; verify that the port bypass LEDs of all of the ports
in drive loop A to which you have added a new connection are not lit.
Using the DS4000 Storage Manager Client Subsystem Management
window, verify that all of the drive enclosures in the DS4000 redundant
drive loop pair to which the new enclosure was added does not report
the drive enclosure lost redundancy path error.
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Activity 3: Disabling DS4000 Storage Server drive migration settings

When you have completed cabling the new storage expansion enclosures, disable
DS4000 Storage Server drive migration settings as follows:

__Step 1. Open the Storage Manager Client program Enterprise Management
window.

__Step 2. Right-click on the name of the DS4000 Storage Server to which you
want to add drives, and select Execute Script.

__Step 3. A script editor window opens. Click File » Load Script.

___Step 4. A Load Script file selection window opens. Locate and select the
DisableDriveMigration.scr file and click OK. The file
DisableDriveMigration.scr file is normally in the SCRIPTS directory of the
IBM DS4000 Storage Manager Installation CD. This file is used to reset
the DS4000 Storage Server setting, in order to treat all
newly-discovered hard drives as “new” drives, and to ignore any
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__ Step 5.
__Step 6.

configuration information that might exist in the new hard drives.
[Figure 15 on page 51| contains the DisableDriveMigration.scr file listing.

Click Tools » Verify and Execute to run the script.

When the script execution completes, reset both DS4000 controllers to
make the disable drive migration settings effective. If you used the
DisableDriveMigration.scr file described in this document in
, you do not need to perform this step because the last two
commands in the script file automatically reset the controllers. To reset
the controllers, open the Storage Subsystem Management window and
alternately (one at a time) reset each controller by clicking Advanced -
Reset Controller and following the instructions in the Reset Controller
window when it opens.

Activity 4: Inserting drives and cabling additional storage expansion

units

Once you have disabled DS4000 Storage Server drive migration settings, insert
drives and connect additional storage expansion enclosures to complete the
installation process as follows:

__Step 1.

__Step 2.

Insert the appropriate drives into empty drive slots in the new enclosure
in pairs (two at a time). Wait until the inserted drive pair fully spins up
and displays in the DS4000 Storage Server Management window
before inserting the next drive pair.

To connect additional storage expansion enclosures to the functioning
drive loop pair, perform|Activity 1: Preliminary activities| step[3 on page]
62 through step [1 on page 64} and[Activity 2: Cabling new storage]
expansion units| steps as follows:

» If you are connecting additional storage expansion enclosures to the
end (bottom) of a drive loop, complete step2 on éaée 6§| through
step[7 on page 65 and step[i] (immediately preceding this step) for
each additional storage expansion enclosure that you intend to add.
(See|Figure 28 on page 74!)

» If you are connecting additional storage expansion enclosures to the
beginning (top) of a drive loop, complete ste2 on page 69 through
step , and step [1] (immediately preceding this step) for
each additional storage expansion enclosure that you intend to add.
(See|Figure 29 on page 75|) If you are willing to plan your connection
of additional storage expansion enclosures to the beginning (top) of a

drive loop, see [Figure 30 on page 76| for alternate cabling
instructions.
When you have completed adding enclosures, proceed to|Activity 5:|
[Re-enabling drive migration settings| sted1 on page 76| to re-enable the
drive migration settings.
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Figure 29. Cabling a second drive enclosure to the beginning of a functioning drive loop
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Figure 30. Recommended connection: Planned cabling of additional drive enclosures to the
beginning of a functioning drive loop

Activity 5: Re-enabling drive migration settings

If you performed steps [1 on page 72| through [6 on page 73| of[Activity 3: Disabling]
[DS4000 Storage Server drive migration settings|to disable DS4000 Storage Server
drive migration settings, perform the following steps [1] through to
re-enable the drive migration settings. If you should ever momentarily remove a
drive from the DS4000 Storage Server, the storage subsystem clears its

configuration data when it later recognize it. When this happens, the drive displays
as unconfigured.

Attention: In order to prevent data loss, set the DS4000 Storage Server drive
migration setting to enable after you complete the hard drive addition process.

__Step 1. Open the Storage Manager Client program Enterprise Management
window.

__Step 2. Right-click on the name of the DS4000 Storage Server to which you
want to add drives and click Execute Script.

__ Step 3. A script editor window opens. Click File » Load Script.
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__ Step 4.

__Step 5.
__ Step 6.

__ Step 7.

A Load Script file selection window opens. Locate and select the
EnableDriveMigration.scr file and click OK. The file
EnableDriveMigration.scr file is normally in the SCRIPTS directory of the
IBM DS4000 Storage Manager Installation CD. Use this file to reset the
DS4000 Storage Server setting in order to check for any configuration
data that might exist on the newly discovered hard drives.

Click Tools » Verify and Execute to run the script.

When the script execution completes, reset both DS4000 controllers to
make the setting effective.

If you use the EnableDriveMigration.scr script associated with this
document and described in|Figure 14 on page 50[ it is not necessary
for you to perform this step because the last two commands in that
script file automatically reset the controllers. To reset the controllers,
open the Storage Subsystem Management window and alternately (one
at a time) reset each controller by clicking Advanced » Reset
Controller and following the instructions in the Reset Controller window
when it opens.

Verify (and update, if needed) the DS4000 Storage Expansion
Enclosure ESM firmware and drive firmware with the latest version from
the following IBM DS4000 support web site.

[www-1.ibm.com/servers/storage/support/disk/

Result: The newly added drives are now ready for you to configure and map to
host servers.

Note: Listings of the EnableDriveMigration.scr and DisableDriveMigration.scr
files are found in [Figure 14 on page 50| and [Figure 15 on page 51|
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Chapter 6. Migrating expansion units containing hard drives

Note: When migrating hard drives from multiple DS4000 storage servers to a
single DS4000 Storage Server, move all of the hard drives from the first
DS4000 Storage Server as an independent ’set’ to the destination DS4000
Storage Server. Before moving hard drives as a ’set’ from subsequent
DS4000 storage servers, ensure that all of the hard drives from the previous
’set’ have been successfully transferred to the destination DS4000 Storage
Server. If you do not transfer hard drives as ’sets’ to the destination DS4000
Storage Server, the newly relocated array may not appear in the Subsystem
Management window.

While migrating a fibre channel or SATA hard drive to either a controller or a drive
expansion enclosure, observe these important rules:

» Observe proper ESD procedures when handling electronic equipment. See
[‘Handling static-sensitive devices” on page 45 for additional information.

* Never alter the physical configuration of a DS4000 Storage Server while it is
powered off unless you are instructed to do so as part of DS4000 configuration
procedure. Specifically, never attach storage components to or remove storage
components from a configured DS4000 Storage Server while it is powered off.

» Use this procedure to preserve the configuration and user data in one or more
fibre channel hard drives that you will migrate to a functioning DS4000 Storage
Server configuration. Do not use this procedure if you are unsure of the quality of
the data on the hard drives. Import of incorrect configuration data from hard
drives could cause a DS4000 Storage Server failure.

Use this procedure to migrate one or more DS4000 storage expansion enclosures
containing hard drives which themselves contain configuration data from a
functioning DS4000 Storage Server configuration to another DS4000 Storage
Server configuration.

Attention: Make additions to the DS4000 Storage Server only while it is powered
on and in optimal state. See [‘Bringing storage subsystems and drive loops into|
foptimal state” on page 43 for additional information on how to make this
determination. You can complete this process while the DS4000 Storage Server is
receiving I/O from the host server. However, because the drive loops are interrupted
momentarily during the addition process, schedule the addition to occur during time
periods of low 1/O between the DS4000 storage servers and host servers.

Review the readme and the IBM TotalStorage DS4000 Storage Manager installation
and support guides associated with the operating system environment of the host
servers that connect to the DS4000 Storage Server for information about any
operating system-specific restrictions in addition to those detailed in this document.
You will also find preliminary tasks that you may be required to complete detailed in
that documentation. IBM TotalStorage DS4000 Storage Manager installation and
support guides are located at the following Web site:

www-1.ibm.com/servers/storage/support/disk/

Tip: Before proceeding with the migration procedure, review and perform the steps
outlined in [Chapter 2, “Prerequisites to adding capacity and hard drive migration,”|
Ign page 37.|
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The procedure for migrating a new DS4000 storage expansion enclosure is as

follows:

Activity 1: Preliminary activities

Before disconnecting any storage expansion enclosures from a DS4000 Storage
Server, to ensure a successful migration of your drives to the DS4000 Storage
Server, perform the following steps:

__Step 1.

__ Step

__ Step

__ Step

__ Step

__ Step

__ Step

__Step

If the migrated storage expansion enclosure is not the same type as
some or all of the existing storage expansion enclosures, review
[‘Intermixing storage expansion enclosures” on page 2|

Verify that both the functioning source and the destination DS4000
Storage Servers’ controller firmware and NVSRAM are at the levels
recommended in[Table 24 on page 39|

Verify that the firmware of the ESMs in the storage expansion

enclosures that you plan to migrate are at the levels recommended in
[Table 25 on page 40
Verify that the firmware of the ESMs in the storage expansion

enclosures attached to the DS4000 Storage Server to which you will
rate your drives is at the levels recommended in{Table 25 on page]

If you migrate storage expansion enclosures from a 1 Gbps fibre
channel environment to a 2 Gbps fibre channel environment, verify
that the fibre channel hard drives that you plan to migrate are each
capable of 2 Gbps operation and that you have installed the latest
firmware enabling them to work properly in a 2 Gbps fibre-channel
environment.

Verify that the names of the logical drives that are created using the
hard drives in the migrated storage expansion enclosures are unique
in the DS4000 Storage Server to which these storage expansion
enclosures will migrate. If they are not unique, make any necessary
changes.

If you migrate the drives to a single controller DS4000 Storage Server
(for example, DS4300 Storage Server, model 6LU or 6LX), change the
logical drive’s preferred owner to Controller A using the DS4000
Storage Manager Client program before taking it offline and removing
it from the DS4000 Storage Server. To set Controller A as the logical
drive preferred owner, right-click the logical drive entry in the
Subsystem Management window and select Change »
Ownership/Preferred Path » Controller A.

In addition to array configuration information, any storage partitioning
configuration data that may reside on drives you plan to migrate will
migrate with those drives when installed on another DS4000 Storage
Server. For this reason, take the following precautions to facilitate the
migration process and prevent problems in storage partitioning
configuration data migration.

a. If a DS4000 storage partitioning premium feature has been
enabled both on a drive’s original and destination DS4000 storage
servers, assure that the defined host ports, hosts, and host group
names are unique to each DS4000 storage server involved in the
migration.

b. If you must use identical names on both DS4000 storage servers,
make the names unique before you perform the drive migration.
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__ Step 9.

__Step 10.

If necessary, customize the storage partitioning information on the
DS4000 storage server to which you have migrated the drives after
you complete the migration.

Delete any flashcopies of logical drives defined in the hard drives that
you plan to migrate.

Remove any remote mirror relationships that involve the logical drives
defined on the drives that you plan to migrate.

Activity 2: Preparing and backing up the drives

__Step 1.

__Step 2.

__ Step 3.

__ Step 4.

__ Step 5.

__Step 6.

__Step 7.

__Step 8.

If the arrays and logical drives involved are not in optimal state,
perform the steps necessary to bring these arrays and logical drives to
their optimal state before attempting migration. See |“Bringing storage|
|subsystems and drive loops into optimal state” on page 43|for additional
information on how to make this determination.

If the drive enclosures that you plan to migrate are not in optimal state,

perform the steps necessary to bring them to their optimal state before

attempting migration. See|“Bringing storage subsystems and drive loops]
[into optimal state” on page 43|for additional information on how to make
this determination.

Perform a backup of the logical drives defined in the storage expansion
enclosures that you plan to migrate.

Monitor the DS4000 Storage Server event log for any errors in the drive
loop or its components for several days before migrating storage
expansion enclosures.

Stop all programs, services or processes in the host servers that
access the logical drives defined in the migrated hard drives. Make sure
that there are not any running background programs, services or
processes that write data to the logical drives. (For example, Microsoft
MSCS service periodically writes to the “Quorum” disk.)

Unmount the file systems to flush 1/O from the server cache to disks.

Notes:

a. In a Microsoft Windows environment, remove the drive letter or the
mount points of the mapped LUNs instead of unmounting the file
systems.

b. Consult documentation associated with your particular operating
system for detailed information regarding the Unmount procedure.

Place the arrays defined in the storage expansion enclosures that you
plan to migrate in off1ine state. In the Storage Subsystem
Management window, right-click on the name of the array and click
Place ~» Offline.

Save the DS4000 storage subsystem profile of the functioning DS4000
Storage Server configuration to which the migration will occur in a
location other than that of the logical drives you plan to migrate.

Activity 3: Shutting down and moving the storage expansion unit

__Step 1.

Because removing a storage expansion enclosure from a functioning
DS4000 Storage Server will disrupt its drive loops, shutdown the
functioning destination DS4000 Storage Server while you remove its
storage expansion enclosures for reconfiguration. If you cannot
shutdown the DS4000 Storage Server, carefully reconfigure only one
drive loop, making sure that the drive loop that you modify is connected
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__Step 2.

correctly and in optimal state before you attempt to reconfigure the
other drive loop. For additional information on making this
determination, see [‘Bringing storage subsystems and drive loops into
[optimal state” on page 43

Take this precaution to prevent the arrays from being inadvertently
failed by the DS4000 Storage Server controllers because two or more
drives in the arrays cannot be reached through either drive loop in the
redundant drive loop pair.

Perform the following steps to verify that the drive loops are in optimal
state:

__Stepa. Physically trace the actual cable connections making sure
that connections are properly modified and that the cable
connectors are firmly inserted into the SFPs or GBICs.

__ Step b. Verify that the following LEDs are not lit or briefly flashed in
the modified drive loop:

* ESM Fault
* port bypass
e |ID conflict

__ Stepc. Verify that the controller drive loop LED remains lit. If the
controller drive loop LED becomes unlit momentary, there
are problems in the drive loop and the Loop Initialization
Primitives (LIPs) are generated by the DS4000 Storage
Server controller.

__Stepd. Inthe DS4000 Storage Manager Client Subsystem
Management window, verify that there are no 1oss of ESM
path redundancy errors in the storage expansion enclosures
that are not migrated.

Do not modify the second drive loop in the redundant drive
loop pair until you are sure that the first modified drive loop
is operating optimally.
Power down the storage expansion enclosures and move them to the
DS4000 Storage Server to which you plan to migrate them.

Notes:

* A storage expansion enclosure with 14 drives weighs up to 100 Ibs.
(45 kg). If necessary, remove the drives and other storage expansion
enclosure components to reduce the weight of the unit for easier
handling. Mark each drive before removing it in order to return it to
the same drive slot when you reassemble the components at the
destination location.

* Move drives only in a horizontal position using an appropriate ESD
bag or container and moving equipment that prevents shock to the
drives during transit. Never stack drives.

Activity 4: Installing and setting storage expansion unit IDs and

speeds

__ Step 1.

Once the storage expansion enclosures and drives are at the location
of DS4000 Storage Server to which they will be migrated, install them
into the rack. If the drives were removed during transit, return them to
the slots from which they were removed, unlatched and no less than
%-inch away from their full insertion points in the drive slots. If the drives
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were not removed, unlatch and pull them out no less than %-inch away
from their full insertion points in the drive slots.

__Step 2. See|Figure 21 on page 63 for an illustration of how to set the enclosure
ID of the storage expansion enclosures. Each drive enclosure in the
DS4000 storage subsystem drive loop must have a unique drive
enclosure ID. In a EXP500 Storage Expansion Unit, there is an
enclosure ID switch mounted on each of two ESM canisters. Set each
ESM canister’s enclosure ID switch in the EXP500 drive enclosure to
the same unique number in the drive loop. In a EXP700 Storage
Expansion Unit, the only enclosure ID switch is mounted between the
power supplies. To access the appropriate DS4000 storage expansion
unit installation and user’s guide for additional information, use the
following Web link:

[www.storage.ibm.com/disk/fastt/index.html

Important: If the DS4000 Storage Server to which you will attach
migrating hard drives is either a FAStT200 or DS4300 (model 60X or
60U), the enclosure IDs of additional storage expansion enclosures
must differ from the FAStT200 or DS4300 storage servers’ enclosure
IDs. These IDs are normally set to “0” at the factory.

__ Step 3. Verify that you set the enclosure speed switch of the DS4400 to the
correct drive loop speed.

If the enclosure speed switch was originally set to 1 Gbps, do not
automatically set it to 2 Gbps unless you are sure that each fibre
channel hard drive it now contains is capable of 2 Gbps operation and
that you have installed the latest firmware enabling their operation in a
2 Gbps fibre-channel environment.

Activity 5: Cabling, powering on, and verifying storage expansion unit

operation

It is possible to connect new storage expansion enclosures at either end of a
functioning storage expansion enclosure drive loop. The two options are:

1. the beginning, closest to the controller (at the top, directly attached to controller
A) as described in[Connecting new storage expansion units at the beginning
[(top) of a drive loop|

2. the end, furthest from the controller (at the bottom, directly attached to controller
B) as described in [Connecting new storage expansion units at the end (bottom)|

|of a drive Ioop|

Of the two options, IBM recommends only option B connection to the end (at the
bottom) of a functioning storage expansion enclosure drive loop, directly attached to
controller B. This is recommended because if the existing DS4000 storage server
configuration is not planned for cabling in new storage expansion enclosures at the
top of the drive loop, cluttered or entangle fibre channel drive loop cabling may
hinder drive loop troubleshooting or cause fibre channel cabling errors. With this in
mind, and depending on your requirements, however, follow either of the instruction
sets at I“Connecting new storage expansion units at the end (bottom) of a drivel

loop” on page 84] or [‘Connecting new storage expansion units at the beginning (top)|

of a drive loop” on page 88|
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Connecting new storage expansion units at the end (bottom) of a drive

loop

Cabling instructions in the steps that follow are based on the cable routing scheme
that is documented in IBM TotalStorage DS4000 Storage Manager installation and
support guides. The cabling instructions illustrated in |Figure 31 on page 86|,

[Figure 32 on page 87, and [Figure 33 on page 88|describe cabling a DS4000

EXP700 Storage Expansion Enclosure to the end (bottom) of a redundant drive
loop of a functioning DS4300 Storage Server (model 60X or 60U). Again, IBM
recommends that you add storage expansion enclosures only in this manner.

The general cabling scheme for DS4000 external drive enclosures is described in
the IBM TotalStorage DS4000 Fibre Channel Cabling Guide available at:

www-3.ibm.com/pc/support/site.wss/document.do?Indocid=MIGR-4KELS5|

See also[‘DS4000 Storage Server drive loop schemes” on page 25

__Step 1.

__Step 2.

__ Step 3.
__ Step 4.

Insert the small form-factor pluggables (SFPs) or gigabit interface
converters (GBICs) into only those ports you intend to use. Do not
leave GBICs or SFPs inserted into port slots without connecting them to
other ports using cables.

Extend one of the drive loops (that is, drive loop A) in a DS4000
Storage Server redundant drive loop pair by connecting the OUT port of
the last storage expansion enclosure to the IN port of the new storage
expansion enclosure as shown in [Figure 31 on page 86,

Warning: Carefully reconfigure only one drive loop at a time, making
sure that the drive loop that you modify is properly connected and in
optimal state before you attempt to reconfigure another drive loop.
Take this precaution to prevent the arrays from being inadvertently
failed by the DS4000 Storage Server controllers. This happens when
two or more drives in the arrays cannot be reached through either drive
loop in the redundant drive loop pair.

Power on the newly added storage expansion enclosure unit.

Wait a few seconds; verify that the port bypass LEDs of all of the ports
in drive loop A, now extended to the new storage expansion enclosure,
are not lit. Using the DS4000 Storage Manager Client Subsystem
Management window, verify that the new storage expansion enclosure
is added and displayed in the Logical/Physical view of the window.

Correct any errors before proceeding to step[5 on page 85| For port
bypass:

a. Verify that the SFPs and GBICs or fibre cables are in good
condition.

Remove and reinsert SFPs, GBICs and fibre cables.

Make sure the new drive expansion enclosure speed switch is
set to the same speed as the existing drive expansion
enclosures and the DS4000 Storage Server speed setting.

d. Verify that the ESM is good by physically removing and
swapping it with the other ESM in the same drive expansion
enclosure. For enclosure ID conflict, set the drive expansion
enclosure ID switch to values unique from the current settings in
the existing drive expansion enclosures and storage server.

Call the IBM Help Center in your geography for assistance if the
problems persist.
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__ Step 5.

__Step 6.

__ Step 7.

__Step 8.

In the other drive loop (that is, drive loop B) in a DS4000 Storage
Server redundant drive loop pair, remove the connection from the
storage subsystem drive loop port to the OUT port of the last storage
expansion enclosure and connect it to the OUT port of the new drive
enclosure as shown in [Figure 32 on page 87}

Wait a few seconds; verify that the port bypass LEDs of the two ports in
the connection between the storage subsystem drive loop port and the
0UT port of the new drive enclosure are not lit. Using the DS4000
Storage Manager Client Subsystem Management window, verify that
the new drive enclosure does not indicate the drive enclosure Tost
redundancy path error. See the preceding step for
possible corrective actions, if needed.

Note: The existing storage expansion enclosures will be shown with
drive enclosure Tost redundancy path errors until you
establish the fibre channel cabling connection described in step

In drive loop B, cable the new drive enclosure’s IN port to the OUT port

of the last enclosure in the already functioning storage expansion

enclosure drive loop as shown in [Figure 33 on page 88|

Wait a few seconds; verify that the port bypass LEDs of all of the ports
in drive loop B to which you have added a new connection are not lit.
Using the DS4000 Storage Manager Client Subsystem Management
window, verify that all of the drive enclosures in the DS4000 redundant
drive loop pair to which the new enclosure was added does not report
the drive enclosure lost redundancy path error.
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Figure 31. Cabling a single drive enclosure to the end of a functioning drive loop (step 1 of 3)
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Figure 32. Cabling a single drive enclosure to the end of a functioning drive loop (step 2 of 3)
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Connecting new storage expansion units at the beginning (top) of a
drive loop

It is possible to add new storage expansion enclosures to either the beginning (top)
or end (bottom) of a functioning storage expansion enclosure drive loop. The
cabling instructions illustrated in [Figure 34 on page 91| [Figure 35 on page 92, and
[Figure 36 on page 93| describe cabling a DS4000 EXP700 Storage Expansion
Enclosure to the beginning (top) of a redundant drive loop of a functioning DS4300
Storage Server (model 60X or 60U). IBM does not recommend that you add
storage expansion enclosures in this manner, especially if there is insufficient rack
space to allow the methodical, uncluttered, and uniform fibre channel cabling of
such new enclosures. Without proper planning, disadvantages of adding expansion
units in this manner include cable management issues that contribute to avoidable
troubleshooting difficulties. (For the diagram of a properly planned addition of a new
expansion enclosure at the beginning (top) of a functioning storage expansion
enclosure drive loop, see|Figure 30 on page 76})
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The general cabling scheme for DS4000 external drive enclosures is described in
the IBM TotalStorage DS4000 Fibre Channel Cabling Guide available at:

www-3.ibm.com/pc/support/site.wss/document.do?Indocid=MIGR-4KELS5

See also [‘DS4000 Storage Server drive loop schemes” on page 25)

__Step 1.

__Step 2.

__Step 3.
__ Step 4.

__ Step 5.

__Step 6.

Insert the small form-factor pluggables (SFPs) or gigabit interface
converters (GBICs) into only those ports you intend to use. Do not
leave GBICs or SFPs inserted into port slots without connecting them to
other ports using cables.

Extend one of the drive loops (that is, drive loop B) in a DS4000
Storage Server redundant drive loop pair by connecting the IN port of
the first (existing) storage expansion enclosure to the OUT port of the
new storage expansion enclosure as shown in |Figure 34 on page 91|

Warning: Carefully reconfigure only one drive loop at a time, making
sure that the drive loop that you modify is properly connected and in
optimal state before you attempt to reconfigure another drive loop.
Take this precaution to prevent the arrays from being inadvertently
failed by the DS4000 Storage Server controllers. This happens when
two or more drives in the arrays cannot be reached through either drive
loop in the redundant drive loop pair.

Power on the newly added storage expansion enclosure unit.

Wait a few seconds; verify that the port bypass LEDs of all of the ports
in drive loop B, now extended to the new storage expansion enclosure,
are not lit. Using the DS4000 Storage Manager Client Subsystem
Management window, verify that the new storage expansion enclosure
is added and displayed in the Logical/Physical view of the window.

Correct any errors before proceeding to step For port bypass:

__a. Verify that the SFPs and GBICs or fibre cables are in good
condition.

b. Remove and reinsert SFPs, GBICs and fibre cables.

Make sure the new drive expansion enclosure speed switch is
set to the same speed as the existing drive expansion
enclosures and the DS4000 Storage Server speed setting.

d. Verify that the ESM is good by physically removing and
swapping it with the other ESM in the same drive expansion
enclosure. For enclosure ID conflict, set the drive expansion
enclosure ID switch to values unique from the current settings in
the existing drive expansion enclosures and storage server.

Call the IBM Help Center in your geography for assistance if the
problems persist.

In the other drive loop (that is, drive loop A) in a DS4000 Storage
Server redundant drive loop pair, remove the connection from the
DS4000 Storage Server drive loop port to the IN port of the first storage
expansion enclosure and connect it to the IN port of the new drive
enclosure as shown in [Figure 35 on page 92,

Wait a few seconds; verify that the port bypass LEDs of the two ports in
the connection between the storage subsystem drive loop port and the
IN port of the new drive enclosure are not lit. Using the DS4000
Storage Manager Client Subsystem Management window, verify that
the new drive enclosure does not indicate the drive enclosure lost
redundancy path error. See the preceding stepfor possible corrective
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actions, if needed. Until you establish the fibre channel cabling
connection described in step El the existing storage expansion
enclosures will appear in the Storage Manager Client Subsystem
Management window with drive enclosure lost redundancy path
errors.

__Step 7. In drive loop A, cable the new drive enclosure’s OUT port to the IN port
of the first enclosure in the already functioning storage expansion
enclosure drive loop as shown in |Figure 36 on page 93I

__ Step 8. Wait a few seconds; verify that the port bypass LEDs of all of the ports
in drive loop A to which you have added a new connection are not lit.
Using the DS4000 Storage Manager Client Subsystem Management
window, verify that all of the drive enclosures in the DS4000 redundant
drive loop pair to which the new enclosure was added does not report
the drive enclosure lost redundancy path error.
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Figure 34. Cabling a single drive enclosure to the beginning of a functioning drive loop (step
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Figure 36. Cabling a single drive enclosure to the beginning of a functioning drive loop (step

3 0f3)

Activity 6: Inserting hard drives and placing logical drives online

Note: When migrating hard drives from multiple DS4000 storage servers to a
single DS4000 Storage Server, move all of the hard drives from the first
DS4000 Storage Server as an independent 'set’ to the destination DS4000
Storage Server. Before moving hard drives as a ’set’ from subsequent
DS4000 storage servers, ensure that all of the hard drives from the previous
’set’ have been successfully transferred to the destination DS4000 Storage
Server. If you do not transfer hard drives as ’sets’ to the destination DS4000
Storage Server, the newly relocated array may not appear in the Subsystem
Management window.

Insert the drives into the empty drive slots in the new enclosure in pairs.
Wait until each drive pair has fully spun up and displayed in the
DS4000 Storage Subsystem Management window before inserting the

__Step 1.

__Step 2.

next drive pair.

For each additional enclosure that you intend to migrate to the
functioning drive loop pair, perform Activity 4: Installing and setting
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storage expansion unit IDs and speeds|step [1 on page 82| through step
3 on page 83 |Activity 5: Cabling, powering on, and verifying storagel
expansion unit operation| step [1 on page 84{through step|4 on page 84,
and step |1 on page 9§ of this activity. (See|Figure 28 on page 74})
When you have completed adding enclosures, proceed to step

__ Step 3. As the DS4000 Storage Server recognizes the drives, it reads and
displays the array and logical drive information on the drives in the
Logical/Physical view of the DS4000 Storage Subsystem Management
window. The storage subsystem places the array in offline state until it
recognizes that you have inserted all of the drives that comprise the
array.

__ Step 4. Once you insert all of the drives and the DS4000 Storage Server
recognizes them, change the state of the arrays or logical drives to the
online state by right-clicking on the array name in the Storage
Subsystem window and clicking Place » Online.

If any of the following conditions persist, contact the IBM Help Center in
your geography for assistance.

* The empty drive slot icon ( 1) displayed for the drive slot into which
you inserted the migrating drive.

* The Failed unconfigured drive icon ( @) or the Failed configured

drive icon ( g ) displayed for the drive slot into which you inserted
the migrating drive.

» Array configuration data on the drives you have added is incomplete.
* You cannot bring the array online.

Attention: Do not initialize a drive that you want to keep (by
right-clicking its icon and selecting Initialize from the pull-down menu) if
it contains configuration or user data. Initializing any of the drives in a
defined array causes all hard drives that comprise an array to return to
the Unconfigured Capacity storage pool, deleting their array definitions
from the DS4000 Storage Server configuration. The user data on such
drives is lost.

Result: Once the arrays are online, they are ready for you to configure
and map to host servers. You might also then recreate flashcopies and
remote mirror relationships.

__Step 5. Use the DS4000 Storage Manager program to view the storage
partitioning definitions and make any necessary corrections.

__Step 6. The DS4000 Storage Server that the drives are migrated from will
display the logical drives that are defined in these drives as “missing
LUNSs”. In order to remove these “missing LUNSs” entries, right-click on
each entry and select Delete from the pull-down menu.
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Chapter 7. Upgrading a storage server in a functioning
configuration

Note: When migrating hard drives from multiple DS4000 storage servers to a
single DS4000 Storage Server, move all of the hard drives from the first
DS4000 Storage Server as an independent ’set’ to the destination DS4000
Storage Server. Before moving hard drives as a ’set’ from subsequent
DS4000 storage servers, ensure that all of the hard drives from the previous
'set’” have been successfully transferred to the destination DS4000 Storage
Server. If you do not transfer hard drives as ’'sets’ to the destination DS4000
Storage Server, the newly relocated array may not appear in the Subsystem
Management window.

This procedure details the steps that are required to upgrade a DS4000 Storage
Server in a functioning DS4000 configuration. Where either an identical or newer
DS4000 Storage Server model is involved, this upgrade involves only the
replacement of the DS4000 storage controller to be upgraded. DS4000 storage
expansion enclosures that had been attached to drives containing configuration
data will be connected to the new DS4000 Storage Server. The upgraded (original)
DS4000 Storage Server being replaced will be either scrapped or returned to
operation (redeployed) at a later date with new drives and/or new storage
expansion enclosures.

|Table 26 on page 97| associates each DS4000 Storage Server with its supported
replacements.

Preliminary considerations: Server upgrade

While upgrading a storage server in a functioning configuration, remain aware of
these important considerations:

» Observe proper ESD handling procedures when handling electronic equipment.
See [‘Handling static-sensitive devices” on page 45 for additional information.

* IBM assigns premium feature entitlements only to specific DS4000 storage
servers. In order to enable premium features in a replacement DS4000 Storage
Server configuration that had been enabled in an original DS4000 Storage Server
configuration, you must purchase appropriate entitlements for the replacement
DS4000 Storage Server. In addition, IBM assigns host kits only to specific
DS4000 storage servers. You must also purchase the appropriate host kits for
new DS4000 storage servers.

» See the appropriate DS4000 storage controller’s installation and user’s guide for
information on the proper power on and power off sequences.

Note: The remainder of this topic pertains to the original DS4000 Storage Server
that is designated for replacement as either the original or old DS4000
Storage Server.

This task requires that you shutdown the DS4000 Storage Server configuration. In
addition, after the upgrade, premium features previously enabled in the original
DS4000 Storage Server along with the enable-by-default premium features in the
new DS4000 Storage Server will automatically be placed in Out-of-Compliance
state. Full data availability is retained, but you must generate new premium feature
SAFE keys in order to re-enable premium features. You can generate new SAFE
keys by contacting the IBM Help Center in your geography. Be sure to have the
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necessary proof of purchase. Alternately, you can also generate new SAFE keys by
using instructions located at the following Web site:

www.storage.ibm.com/pfeatures.html/|

The new DS4000 Storage Server controller identifies itself using a new Worldwide
Name (WWN) that is different from the WWN used by the original DS4000 Storage
Server controller. For this reason, additional tasks might be required after the
upgrade for any host applications or drivers that rely on the WWNs to identify
logical drives defined in a given DS4000 Storage Server. See your application
program’s documentation, your driver's user guide, or related documentation for
detailed instructions on how to update the WWN of the DS4000 Storage Server in
the application or driver. Additionally, review the readme file and the related /1BM
TotalStorage DS4000 Storage Manager installation and support guide for
information about any preparation tasks required in addition or operating
system-specific restrictions. IBM TotalStorage DS4000 Storage Manager installation
and support guides are located at the following Web site:

www.ibm.com/servers/storage/support/disk/|

Attention: Depending on your existing DS4000 Storage Server configuration, you
may not be able to migrate all of your drives and storage expansion enclosures to a
new DS4000 Storage Server configuration. For example, you cannot migrate 1
Gbps EXP500 drive expansion enclosures from a FAStT500 Storage Server to a
DS4300 Storage Server. See[Table 10 on page 4]and [Table 26 on page 97|for
additional information on DS4000 Storage Server and storage expansion enclosure
compatibility.

Contact your IBM technical support representative if you have questions regarding
the compatibility of drives and drive expansion enclosures in an existing DS4000
Storage Server configuration with a new DS4000 Storage Server configuration.

[Table 26 on page 97|associates each DS4000 Storage Server with its supported
replacements. Select View » Rotate View » Clockwise to optimize this chart’s
appearance.
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Preliminary considerations: Firmware behavior during server upgrade

This section describes technical considerations regarding basic DS4000 Storage
Server controller firmware behavior during a DS4000 Storage Server upgrade. It
covers firmware behavior during system upgrade, where a new DS4000 Storage
Server connects to functioning drives and storage expansion enclosures, as well as
firmware behavior during system redeployment, where the original (old) DS4000
Storage Server serves as a logically distinct entity, optionally, using some of the
drives from the original system.

DS4000 configuration behavior after upgrade and DS4000 Storage
Server replacement

The new DS4000 Storage Server that powers up in a functioning storage expansion
enclosure configuration as part of the DS4000 Storage Server upgrade process
impacts the following areas of the DS4000 Storage Server identification and
premium features:

1.

Worldwide Name (WWN):

The worldwide names that were used by the original DS4000 Storage Server
prior to the upgrade are not returned when the upgrade is complete. Rather, the
new DS4000 Storage Server begins to advertise itself using WWNSs that are
based on an embedded unique identifier from its controller blades. This
statement applies to both the port WWNs and the node WWNs. Consequently,
any hosts that were aware of the logical drives in the original DS4000 Storage
Server based on the original DS4000 storage server's WWN values will likely be
confused. The data volumes that resided behind the previously known WWNs
now reside behind a seemingly new device with different WWNSs.

Storage Array Identifier (SAI or SA Identifier):

The storage array identifier, or SA Identifier, is the identification value used by
the DS4000 Storage Manager host software (SMclient) to uniquely identify
managed storage servers. The DS4000 Storage Manager SMclient program
maintains SA Identifier records of previously discovered storage servers in the
host resident file, which allows it to retain discovery information in a persistent
fashion. This identifier is stored on DACstore, and persists across reboots,
power cycles, and so on. The new DS4000 Storage Server that powers up in a
functioning storage expansion enclosure configuration as part of the DS4000
Storage Server upgrade process continues to use the SA Identifier of the
original DS4000 Storage Server.

SAFE Premium Feature Identifier (SAFE ID) and Premium Feature Enable
Status:

The new DS4000 Storage Server retains the SAFE ID of the original DS4000
Storage Server. It also retains all of the features previously enabled on the
original DS4000 Storage Server. The feature states, however, are set to the
Out-of-Compliance state. As a result, the system sends alert notices and
establishes a Needs Attention condition. Also, any features that are marked in
the new controller's NVSRAM for automatic enablement are enabled, though
their feature states are also set to Out-of-Compliance. You must re-enable the
premium features by using premium feature SAFE key files.
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Redeployed DS4000 configuration behavior in an original (replaced)
DS4000 Storage Server

Important:
IBM Support is available to supply assistance and guidance to those who
choose to redeploy a replaced DS4000 Storage Server.

When you redeploy DS4000 Storage Server hardware in another DS4000 storage
server’'s configuration, identification and premium features of the redeployed system
behave somewhat differently from information described in|{“DS4000 configuration|
behavior after upgrade and DS4000 Storage Server replacement” on page 98.| This
section describes those relevant behavioral differences.

* Worldwide Name (WWN):

The worldwide names that were used by the original DS4000 Storage Server are
retained on the redeployed system. These values are based on an embedded
unique identifier from the original DS4000 Storage Server controller blades, and
are stored in the NVSRAM on each controller board within the controller blade.
Assuming that both controllers remain fully optimal after the redeployment, they
recognize the stored value and continue to use it. Consequently, any hosts that
were aware of the original DS4000 Storage Server, based on its WWN values,
will likely be confused. The logical drives that used to reside behind the
previously-known WWNs no longer reside there, because they are now part of
the new DS4000 Storage Server, which has a different WWN.

» Storage Array Identifier or SA Identifier:

If you return one or more drives that were originally moved from a DS4000
Storage Server back to the original DS4000 Storage Server configuration before
it is redeployed, it is possible that the SA Identifier that was used on the original
DS4000 Storage Server system will also be reused in the redeployed DS4000
Storage Server configuration. Whether or not this occurs depends on the specific
selection of transported drives. If certain conditions are met, however, the
redeployed unit adopts the same SA Identifier that was retained by the new
DS4000 Storage Server. Otherwise, or in cases in which only new drives are
used in the redeployed configuration, the redeployed DS4000 Storage Server
generates a new (and unique) SA Identifier that does not conflict with the one
that was retained by the upgraded unit.

If both the new and the redeployed DS4000 Storage Server have the same SA
Identifier, serious problems will result when you start the DS4000 Storage
Manager SMclient program. Since there will be two DS4000 storage servers with
the same SA Identifier, the DS4000 Storage Manager SMclient program will
respond by arbitrarily selecting either the new or the redeployed DS4000 Storage
Server. The storage server that the DS4000 Storage Manager SMclient program
arbitrarily selects will be manageable, and the other storage server will be
unmanageable.

* SAFE Premium Feature Identifier (SAFE ID)
Premium Feature Enable status:
If you return any drives from an original DS4000 Storage Server, along with the
original DS4000 Storage Server controllers, to a redeployed DS4000
configuration, the SAFE ID of the original DS4000 Storage Server will be
retained, and all enabled features will remain fully enabled and compliant.
If you do not move any drives from an original DS4000 Storage Server, it
generates a new SAFE ID when redeployed, enabling none of the premium
features from the original system. This new SAFE ID prevents the system from
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using any previously-acquired SAFE key files and re-enabling any premium
features. In cases where the original DS4000 Storage Server was pre-loaded
with NVSRAM codes to enable certain premium features, NVSRAM codes are
cleared from the DS4000 Storage Server when redeployed and powered on for
the first time. Therefore, premium features that were enabled as standard
features do not reactivate on the redeployed system. The system retains full data
availability, but you must generate new premium feature SAFE keys in order to
re-enable premium features. You can generate new SAFE keys by contacting the
IBM Help Center in your geography. Be sure to have the necessary proof of
purchase. Alternately, you can also generate new SAFE keys by using
instructions located at the following Web site:

[www.storage.ibm.com/pfeatures.html/|
» Controller IP addresses:

When the DS4000 Storage Server controllers were assigned static IP addresses,
the IP addresses were stored in the NVSRAM of the controller board as well as
the DACstore on the disks. If the new (replacement) DS4000 Storage Server
controllers were assigned the same IP addresses as the original (replaced)
DS4000 Storage Server controllers, network problem will arise when the original
(replaced) DS4000 Storage Server is eventually redeployed. The problem will
occur because two devices have the same IP address in the Ethernet network.
The best practice is to assign new unique IP addresses to new (replacement)
DS4000 Storage Server controllers instead of using the same IP addresses as
the DS4000 controllers that they replace.

Upgrading storage servers in functioning DS4000 configurations

Before you perform the following upgrade procedure, review and perform the steps
detailed in [Chapter 2, “Prerequisites to adding capacity and hard drive migration,’|

|9n page 37.|

Complete the following activities to upgrade your DS4000 Storage Server:

Activity 1: Preliminary activities
Perform the following steps before you disconnect storage expansion enclosures

from an original DS4000 Storage Server that is being replaced to ensure a
successful DS4000 Storage Server upgrade.

__Step 1. Verify that the original DS4000 storage server’s controller firmware and
NVSRAM are at the levels shown in{Table 24 on page 39

__Step 2. Verify that the firmware of the ESMs in the storage expansion
enclosures is at the levels shown in[Table 25 on page 40}

__Step 3. Disable or delete any flashcopies of the logical drives.
__Step 4. Delete any remote mirror relationships.

__Step 5. If the arrays (logical drives) are not in optimal state, perform the steps
necessary to bring the arrays (logical drives) into their optimal state
before you attempt their migration. See the DS4000 Problem
Determination Guide associated with your particular DS4000 hardware
model or [‘Bringing storage subsystems and drive loops into optimal|
[state” on page 43 for additional information on how to make this
determination.

__Step 6. If the drive enclosures are not in optimal state, perform the steps
necessary to bring them to optimal state before attempting migration.
Perform the following steps to verify that the drive loops are in optimal
state:
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__Step 7.

__ Step 8.

__ Step 9.

__ Step 10.

__ Step 11.

__ Step12.

__Step a. Physically trace the actual cable connections making sure
that connections are properly modified and that the cable
connectors are firmly inserted into the SFPs or GBICs.

__Step b. Verify that the following LEDs are not lit or briefly flashed
in the modified drive loop:

* ESM fault
* port bypass
* ID conflict

___Stepc. Verify that the controller drive loop LED remains lit. If the
controller drive loop LED becomes unlit momentary, there
are problems in the drive loop and the LIPs are generated
by the DS4000 Storage Server controller.

__Stepd. Inthe DS4000 Storage Manager Client Subsystem
Management window, verify that there are no loss of ESM
path redundancy errors in the drives expansion enclosures
that are not migrated.

Do not modify the second drive loop in a redundant drive
loop pair until you are sure that the first modified drive
loop is operating optimally. See the DS4000 Problem
Determination Guide associated with your particular
DS4000 hardware model or [‘Bringing storage subsystems|
land drive loops into optimal state” on page 43| for
additional information on how to make this determination.

Perform a full backup of the original DS4000 Storage Server and
schedule it for down time. This is necessary because you must power
down the DS4000 Storage Server configuration during the upgrade
procedure.

Save the DS4000 storage subsystem profile of the original DS4000
Storage Server configuration in a location other than that in which the
logical drives are defined in the original DS4000 Storage Server
configuration.

Stop all programs, services or processes in the host servers that
access the logical drives defined in the migrated hard drives. Make
sure that there are not any running background programs, services or
processes that write data to the logical drives. (For example, Microsoft
MSCS service periodically writes to the “Quorum” disk.)

Unmount the file systems to flush 1/O from the server cache to disks.

Notes:

a. In a Microsoft Windows environment, remove the drive letter or the
mount points of the mapped LUNs instead of unmounting the file
systems.

b. Consult documentation associated with your particular operating
system for detailed information regarding the Unmount procedure.

Place the arrays defined on the DS4000 Storage Server in offline
state. In the Storage Subsystem Management window, right-click on
the name of the array and select Place » Offline.

Retrieve proofs of purchase for both the original and new DS4000
storage servers and for the additional premium feature entitlements on
the new and original DS4000 storage servers. IBM support personnel
will require this information to regenerate premium feature SAFE key
files that were enabled in the original DS4000 Storage Server for use
on the new DS4000 Storage Server.
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Activity 2: Powering off the original DS4000 Storage Server

Power down the original DS4000 Storage Server and remove it from the DS4000
configuration. Do not redeploy this DS4000 Storage Server in the same
management domain as its upgrade (replacement) DS4000 Storage Server until
you regenerate its SA identifier using the instructions in|“Redeponing the original|
((replaced) DS4000 Storage Server” on page 104

Note: See the appropriate DS4000 storage controller’s installation and user’s guide
for details on the correct power off sequence.

Activity 3: Installing new DS4000 storage servers and setting minihub

speed

Install the new DS4000 Storage Server. For DS4400 and DS4500 storage servers,
set the drive minihub speed switch to the speed of the storage expansion enclosure
ports to which they are connected.

Note: The DS4300 drive loop port operates only at 2 Gbps. If you migrate storage
expansion enclosures from a 1 Gbps fibre channel environment to a 2 Gbps
fibre channel environment, do not automatically change the storage
expansion enclosure speed settings from 1 Gbps to 2 Gbps. Before you do,
verify that each fibre channel drive involved is capable of 2 Gbps operation
and that you have installed the latest firmware enabling them to work
properly in a 2 Gbps fibre channel environment.

Important: If the new DS4000 Storage Server is either a FAStT200 or DS4300
Storage Server, set the FAStT200 or DS4300 enclosure ID to a value unique from
other EXP storage expansion enclosures in the fibre channel drive loop. These IDs
are normally set to “0” at the factory.

Activity 4: Making connections

Insert the SFPs or GBICs into the DS4000 Storage Server drive port slots and
make the connections from the DS4000 Storage Server to the storage expansion
enclosures. For detailed information, see the appropriate DS4000 storage
controller’s installation and user guide.

Ensure that all of the DS4000 storage expansion enclosures are set to the correct
fibre channel speed for the drive loop of the new DS4000 Storage Server.

Activity 5: Powering on the expansion unit and setting IP addresses

___Step 1. Verify that all of the storage expansion enclosures are powered on and
in optimal state by examining the expansion enclosure LED states.
Then, power on the new DS4000 Storage Server. Using the DS4000
Storage Manager client program, verify that the DS4000 Storage Server
is operational and that all of the drives are recognized and in optimal
state. See the DS4000 Problem Determination Guide associated with
your particular DS4000 hardware model or[“Bringing storagel
|subsystems and drive loops into optimal state” on page 43|for additional
information on how to make this determination.

Notes:

a. Your storage subsystem will identify the new DS4000 Storage
Server as the machine type it replaced until you download the
appropriate NVSRAM file for the new storage server. For example, if
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__ Step2.

you replace a FAStT500 with a DS4500, the DS4500 will be
reported as a FAStT500 until you download the appropriate
NVSRAM file for the DS4500.

b. See the appropriate DS4000 storage controller’s installation and
user guide for information on the proper power on sequence.

If the new DS4000 Storage Server is managed out-of-band, perform the
steps for setting the IP addresses for new DS4000 Storage Server
controllers defined in the IBM TotalStorage DS4000 Storage Manager
installation and support guide associated with your operating system
environment. DS4000 Storage Manager installation and support guides
are located at the following Web site:

[www.ibm.com/servers/storage/support/disk/|

Changing DS4000 Storage Server IP addresses

__ Step 1.

__Step 2.

__ Step 3.

__ Step 4.

__Step
__Step
__ Step
__Step

__Step 9.
__ Step 10.
__ Step 11.
__ Step12.
__ Step 13.

__ Step 14.

___Step 15.
__ Step 16.
__ Step 17.
__ Step 18.

__ Step 19.

© N o o

Open the Storage Manager client program’s Enterprise Management
window.

Note: The new DS4000 Storage Server will have the same IP
addresses as the DS4000 Storage Server previously removed.

Select the entry of the DS4000 storage subsystem that you want to
manage.

Right click and select Manage Device from the pop-up menu. The
DS4000 Storage Manager Client Subsystem Management window
opens.

In the Logical/Physical view of the window, select Controller »
Change » Network Configuration. The Change Network
Configuration window opens.

Select the Slot A tab.

Select the radio button labeled Specify Configuration Setting.
Type in the new IP address, subnet mask, and gateway information.
Click OK.

Select the Slot B tab.

Select the radio button labeled Specify Configuration Setting.
Type in the new IP address, subnet mask, and gateway information.
Click OK to enable the IP address changes.

Close the DS4000 Storage Manager Client Subsystem Management
window.

Select the entry of the DS4000 storage subsystem whose IP address
you just changed. Right click.

Select Remove Device from the pop-up menu.
Click Yes to confirm removal of each device.
Select Edit » Add Device. The Add Device window opens.

Type in the name or new IP address of controller A and close the
window.

Type in the name or new IP address of controller B and close the
window.
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Activity 6: Downloading firmware and NVSRAM and returning arrays

online

__Step 1. Use the DS4000 Storage Manager client program to download the
firmware and the NVSRAM for the new DS4000 Storage Server.

__ Step 2. Return the offline arrays to online state by right-clicking on the array
and selecting Place » Online. If any of the following conditions persist,
contact the IBM Help Center in your geography for assistance:

* The empty drive slot icon ( izx!) displayed for the drive slot into which
you inserted the migrating drive.

* The Failed unconfigured drive icon ( @) or the Failed configured

drive icon ( &= ) displayed for the drive slot into which you inserted
the migrating drive.

» Array configuration data on the drives you have added is incomplete.
* You cannot bring the array online.

Activity 7: Generating and applying premium feature SAFE key files

Generate the new premium feature SAFE key files using the new DS4000 Storage
Server Feature Enable Identifier. Apply premium feature SAFE keys to remove
Out-of-CompTiance errors on enabled premium features.

Result: You are now able to recreate flashcopies and remote mirror relationships, if
required.

Redeploying the original (replaced) DS4000 Storage Server

Accessing the

As a safety measure, force generation of a new SA Ildentifier when you redeploy an
original (replaced) DS4000 Storage Server. Use the controller shell commands to
generate a new SA ldentifier. To gain access to the controller shell, you will require
a null modem cable and a terminal emulation program that is capable of sending a
BREAK signal. The setting for the terminal emulation session is 8-N-1 (8 data bits, no
parity bit and 1 stop bit). Once you enter the controller shell, use the following
command sequence to force the controller to generate a new SA Identifier:

1d </Debug
symbolGenerateNewSAIdentifier

Note: It is necessary for you to run this command sequence on only one controller.
Then, reset both DS4000 Storage Server controllers and proceed with the normal
DS4000 Storage Server installation and configuration process.

DS4000 Storage Server controller shell

The following steps describe how to access the DS4000 Storage Server controller
shell using the terminal emulation program of your choice. One example of such a
terminal emulation program for which IBM neither makes nor implies a warranty,
HyperTerminal, Private Edition; version 6.3 or higher, is available for your
consideration at the following Web site:

www.hilgraeve.com|

A generic version of steps involved in accessing the DS4000 Storage Server
controller shell using the terminal emulation program of your choice follows:
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__Step 1. Stop all I/O on the DS4000 Storage Server.

__Step 2. Connect a null modem serial cable from one of the DS4000 Storage
Server controller communications (COM) ports to a system with an
available terminal emulator.

__Step 3. Open the terminal emulation program of your choice, such as the
HyperTerminal, Private Edition program and from the menu bar, click
File » Properties » Configure. Establish the following property
settings:

» Bits per second: 57600
« Data bits: 8

» Parity: None

« Stop Bit: 1

* Flow Control: None

__Step 4. Connect to the DS4000 Storage Server controller shell by sending a
BREAK signal. (If you are using the HyperTerminal, Private Edition
program, press the Ctr1 and BREAK keys simultaneously to send the
BREAK signal.)

__Step 5. Repeat step@ until the following message displays:
“Press the space bar for baud rate within 5 seconds.”

__Step 6. Press the space bar within the time limit to establish the correct baud
rate setting.

__Step 7. Send another BREAK signal. The following message is displayed:
“Press within 5 seconds: ESC for SHELL, BREAK for baud rate.”
__ Step 8. Press the ESC key within the time limit to access the controller shell.
__Step 9. When prompted, type the following password:
infiniti
__Step 10. You are now accessing the DS4000 Storage Server controller shell.

Important: Be careful when entering commands in the DS4000
Storage Server controller shell. Improper use of DS4000 Storage
Server controller shell commands could result in loss of configuration
data.
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Notices

This publication was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM® may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this publication to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product, and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Trademarks

The following terms are trademarks of International Business Machines Corporation
in the United States, other countries, or both:

FlashCopy Netfinity
IBM ServerProven
IBMLink TotalStorage
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Intel is a trademark of Intel Corporation in the United States, other countries, or
both.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of
others.

Important notes

Processor speeds indicate the internal clock speed of the microprocessor; other
factors also affect application performance.

CD-ROM drive speeds list the variable read rate. Actual speeds vary and are often
less than the maximum possible.

When referring to processor storage, real and virtual storage, or channel volume,
KB stands for approximately 1000 bytes, MB stands for approximately 1 000 000
bytes, and GB stands for approximately 1 000 000 000 bytes.

When referring to hard disk drive capacity or communications volume, MB stands
for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total user-accessible
capacity may vary depending on operating environments.

Maximum internal hard disk drive capacities assume the replacement of any
standard hard disk drives and population of all hard disk drive bays with the largest
currently supported drives available from IBM.

Maximum memory may require replacement of the standard memory with an
optional memory module.

IBM makes no representation or warranties regarding non-IBM products and
services that are ServerProven®, including but not limited to the implied warranties
of merchantability and fitness for a particular purpose. These products are offered
and warranted solely by third parties.

IBM makes no representations or warranties with respect to non-IBM products.
Support (if any) for the non-IBM products is provided by the third party, not IBM.

Some software may differ from its retail version (if available), and may not include
user manuals or all program functionality.

Electronic emission notices

This section gives the electronic emission notices or statements for the United
States and other countries or regions.

Federal Communications Commission (FCC) statement

Note: This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio
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communications. Operation of this equipment in a residential area is likely to cause
harmful interference, in which case the user will be required to correct the
interference at his own expense.

Properly shielded and grounded cables and connectors must be used in order to
meet FCC emission limits. Properly shielded and grounded cables and connectors
must be used in order to meet FCC emission limits.IBM is not responsible for any
radio or television interference caused by using other than recommended cables
and connectors or by using other than recommended cables and connectors or by
unauthorized changes or modifications to this equipment. Unauthorized changes or
modifications could void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) this device may not cause harmful interference, and (2)
this device must accept any interference received, including interference that may
cause undesired operation.

Chinese class A compliance statement

Attention: This is a class A statement. In a domestic environment, this product
might cause radio interference in which case the user might be required to take
adequate measures.

i A RAFIE “Adl” EEEH

|
SNAS AR, EAFEREY, B RA RS ENTAET . EXHEAT,
T R E R PO TR RN AT A

Industry Canada Class A emission compliance statement
This Class A digital apparatus complies with Canadian ICES-003.

Avis de conformité a la réglementation d’Industrie Canada

Cet appareil numérique de la classe A est conforme a la norme NMB-003 du
Canada.

Australia and New Zealand Class A statement

Attention: This is a Class A product. In a domestic environment this product may
cause radio interference in which case the user may be required to take adequate
measures.

United Kingdom telecommunications safety requirement
Notice to Customers

This apparatus is approved under approval number NS/G/1234/J/100003 for indirect
connection to public telecommunication systems in the United Kingdom.

European Union EMC Directive conformance statement

This product is in conformity with the protection requirements of EU Council
Directive 89/336/EEC on the approximation of the laws of the Member States
relating to electromagnetic compatibility. IBM cannot accept responsibility for any
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failure to satisfy the protection requirements resulting from a nonrecommended
modification of the product, including the fitting of non-IBM option cards.

This product has been tested and found to comply with the limits for Class A
Information Technology Equipment according to CISPR 22/European Standard EN
55022. The limits for Class A equipment were derived for commercial and industrial
environments to provide reasonable protection against interference with licensed
communication equipment.

Attention: This is a Class A product. In a domestic environment this product may

cause radio interference in which case the user may be required to take adequate
measures.

Taiwan Class A warning statement

e

BATFTRAMATRAES &
AR IR P AE A B o 7T
RREdRAE TR A2
AEERT AR
P ETITETE

\.:

Japanese Voluntary Control Council for Interference (VCCI) statement

ZOLE T, F B E SRR EE A EAH#ES (VCC 1) DRUEL
$o< 7 77\Afﬁ§&&f’ﬁ %Tff Z OE  FRERET TIN5 LB E A
FISRIFTZLnDY 3, ZOLEITIIHHE R ED 20w/ 275 £ 9 2k
SNDHZLENHY ET,
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Glossary

This glossary provides definitions for the
terminology and abbreviations used in IBM
TotalStorage DS4000 publications.

If you do not find the term you are looking for, see
the IBM Glossary of Computing Terms located at
the following Web site:

www.ibm.com/ibm/terminology|

This glossary also includes terms and definitions
from:

» Information Technology Viocabulary by
Subcommittee 1, Joint Technical Committee 1,
of the International Organization for
Standardization and the International
Electrotechnical Commission (ISO/IEC
JTC1/SC1). Definitions are identified by the
symbol (l) after the definition; definitions taken
from draft international standards, committee
drafts, and working papers by ISO/IEC
JTC1/SC1 are identified by the symbol (T) after
the definition, indicating that final agreement
has not yet been reached among the
participating National Bodies of SC1.

* IBM Glossary of Computing Terms. New York:
McGraw-Hill, 1994.

The following cross-reference conventions are
used in this glossary:

See  Refers you to (a) a term that is the
expanded form of an abbreviation or
acronym, or (b) a synonym or more
preferred term.

See also
Refers you to a related term.

Abstract Windowing Toolkit (AWT). A Java graphical
user interface (GUI).

accelerated graphics port (AGP). A bus specification
that gives low-cost 3D graphics cards faster access to
main memory on personal computers than the usual
peripheral component interconnect (PCI) bus. AGP
reduces the overall cost of creating high-end graphics
subsystems by using existing system memory.

access volume. A special logical drive that allows the
host-agent to communicate with the controllers in the
storage subsystem.

adapter. A printed circuit assembly that transmits user
data input/output (I/O) between the internal bus of the

© Copyright IBM Corp. 2004

host system and the external fibre-channel (FC) link and
vice versa. Also called an I/O adapter, host adapter, or
FC adapter.

advanced technology (AT) bus architecture. A bus
standard for IBM compatibles. It extends the XT bus
architecture to 16 bits and also allows for bus
mastering, although only the first 16 MB of main
memory are available for direct access.

agent. A server program that receives virtual
connections from the network manager (the client
program) in a Simple Network Management
Protocol-Transmission Control Protocol/Internet Protocol
(SNMP-TCP/IP) network-managing environment.

AGP. See accelerated graphics port.
AL_PA. See arbitrated loop physical address.

arbitrated loop. One of three existing fibre-channel
topologies, in which 2 - 126 ports are interconnected
serially in a single loop circuit. Access to the Fibre
Channel-Arbitrated Loop (FC-AL) is controlled by an
arbitration scheme. The FC-AL topology supports all
classes of service and guarantees in-order delivery of
FC frames when the originator and responder are on
the same FC-AL. The default topology for the disk array
is arbitrated loop. An arbitrated loop is sometimes
referred to as a Stealth Mode.

arbitrated loop physical address (AL_PA). An 8-bit
value that is used to uniquely identify an individual port
within a loop. A loop can have one or more AL_PAs.

array. A collection of fibre-channel or SATA hard drives
that are logically grouped together. All the drives in the
array are assigned the same RAID level. An array is
sometimes referred to as a "RAID set.” See also
redundant array of independent disks (RAID), RAID
level.

asynchronous write mode. In remote mirroring, an
option that allows the primary controller to return a write
I/0 request completion to the host server before data
has been successfully written by the secondary
controller. See also synchronous write mode, remote
mirroring, Global Copy,Global Mirroring.

AT. See advanced technology (AT) bus architecture.
ATA. See AT-attached.

AT-attached. Peripheral devices that are compatible
with the original IBM AT computer standard in which
signals on a 40-pin AT-attached (ATA) ribbon cable
followed the timings and constraints of the Industry
Standard Architecture (ISA) system bus on the IBM PC
AT computer. Equivalent to integrated drive electronics
(IDE).
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auto-volume transfer/auto-disk transfer (AVT/ADT).
A function that provides automatic failover in case of
controller failure on a storage subsystem.

AVT/ADT. See auto-volume transfer/auto-disk transfer.
AWT. See Abstract Windowing Toolkit.

basic input/output system (BIOS). The personal
computer code that controls basic hardware operations,
such as interactions with diskette drives, hard disk
drives, and the keyboard.

BIOS. See basic input/output system.
BOOTP. See bootstrap protocol.

bootstrap protocol (BOOTP). In Transmission Control
Protocol/Internet Protocol (TCP/IP) networking, an
alternative protocol by which a diskless machine can
obtain its Internet Protocol (IP) address and such
configuration information as IP addresses of various
servers from a BOOTP server.

bridge. A storage area network (SAN) device that
provides physical and transport conversion, such as
fibre channel to small computer system interface (SCSI)
bridge.

bridge group. A bridge and the collection of devices
connected to it.

broadcast. The simultaneous transmission of data to
more than one destination.

cathode ray tube (CRT). A display device in which
controlled electron beams are used to display
alphanumeric or graphical data on an
electroluminescent screen.

client. A computer system or process that requests a
service of another computer system or process that is
typically referred to as a server. Multiple clients can
share access to a common server.

command. A statement used to initiate an action or
start a service. A command consists of the command
name abbreviation, and its parameters and flags if
applicable. A command can be issued by typing it on a
command line or selecting it from a menu.

community string. The name of a community
contained in each Simple Network Management
Protocol (SNMP) message.

concurrent download. A method of downloading and
installing firmware that does not require the user to stop
I/O to the controllers during the process.

CRC. See cyclic redundancy check.
CRT. See cathode ray tube.

CRU. See customer replaceable unit.

customer replaceable unit (CRU). An assembly or
part that a customer can replace in its entirety when any
of its components fail. Contrast with field replaceable
unit (FRU).

cyclic redundancy check (CRC). (1) A redundancy
check in which the check key is generated by a cyclic
algorithm. (2) An error detection technique performed at
both the sending and receiving stations.

dac. See disk array controller.

dar. See disk array router.

DASD. See direct access storage device.
data striping. See striping.

default host group. A logical collection of discovered
host ports, defined host computers, and defined host
groups in the storage-partition topology that fulfill the
following requirements:

= Are not involved in specific logical drive-to-LUN
mappings

+ Share access to logical drives with default logical
drive-to-LUN mappings

device type. Identifier used to place devices in the
physical map, such as the switch, hub, or storage.

DHCP. See Dynamic Host Configuration Protocol.

direct access storage device (DASD). A device in
which access time is effectively independent of the
location of the data. Information is entered and retrieved
without reference to previously accessed data. (For
example, a disk drive is a DASD, in contrast with a tape
drive, which stores data as a linear sequence.) DASDs
include both fixed and removable storage devices.

direct memory access (DMA). The transfer of data
between memory and an input/output (I/O) device
without processor intervention.

disk array controller (dac). A disk array controller
device that represents the two controllers of an array.
See also disk array router.

disk array router (dar). A disk array router that
represents an entire array, including current and
deferred paths to all logical unit numbers (LUNSs) (hdisks
on AIX). See also disk array controller.

DMA. See direct memory access.

domain. The most significant byte in the node port
(N_port) identifier for the fibre-channel (FC) device. It is
not used in the fibre channel-small computer system
interface (FC-SCSI) hardware path ID. It is required to
be the same for all SCSI targets logically connected to
an FC adapter.

DRAM. See dynamic random access memory.
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Dynamic Host Configuration Protocol (DHCP). A
protocol defined by the Internet Engineering Task Force
that is used for dynamically assigning Internet Protocol
(IP) addresses to computers in a network.

dynamic random access memory (DRAM). A
storage in which the cells require repetitive application
of control signals to retain stored data.

ECC. See error correction coding.

EEPROM. See electrically erasable programmable
read-only memory.

EISA. See Extended Industry Standard Architecture.

electrically erasable programmable read-only
memory (EEPROM). A type of memory chip which can
retain its contents without consistent electrical power.
Unlike the PROM which can be programmed only once,
the EEPROM can be erased electrically. Because it can
only be reprogrammed a limited number of times before
it wears out, it is appropriate for storing small amounts
of data that are changed infrequently.

electrostatic discharge (ESD). The flow of current
that results when objects that have a static charge
come into close enough proximity to discharge.

environmental services monitor (ESM) canister. A
component in a drive enclosure that monitors the
environmental condition of the components in that
enclosure. Not all storage subsystems have ESM
canisters.

E_port. See expansion port.

error correction coding (ECC). A method for
encoding data so that transmission errors can be
detected and corrected by examining the data on the
receiving end. Most ECCs are characterized by the
maximum number of errors they can detect and correct.

ESD. See electrostatic discharge.

ESM canister. See environmental services monitor
canister.

EXP. See expansion unit.

expansion port (E_port). A port that connects the
switches for two fabrics.

expansion unit (EXP). A feature that can be
connected to a system unit to provide additional storage
and processing capacity.

Extended Industry Standard Architecture (EISA). A
bus standard for IBM compatibles that extends the
Industry Standard Architecture (ISA) bus architecture to
32 bits and allows more than one central processing
unit (CPU) to share the bus. See also Industry Standard
Architecture.

fabric. A Fibre Channel entity which interconnects and
facilitates logins of N_ports attached to it. The fabric is
responsible for routing frames between source and
destination N_ports using address information in the
frame header. A fabric can be as simple as a
point-to-point channel between two N-ports, or as
complex as a frame-routing switch that provides multiple
and redundant internal pathways within the fabric
between F_ports.

fabric port (F_port). In a fabric, an access point for
connecting a user's N_port. An F_port facilitates N_port
logins to the fabric from nodes connected to the fabric.
An F_port is addressable by the N_port connected to it.
See also fabric.

FAStT MSJ. See FAS!T Management Suite Java.

FAStT Management Suite Java (FASIT MSJ). A
diagnostic and configuration utility that can be used on
Linux, Microsoft Windows, and Novell NetWare host
systems. In Linux, it is also used with the QLRemote
agent to define preferred and non-preferred paths for
logical drives.

FC. See fibre channel.
FC-AL. See arbitrated loop.

feature enable identifier. A unique identifier for the
storage subsystem, which is used in the process of
generating a premium feature key. See also premium
feature key.

fibre channel (FC). A set of standards for a serial
input/output (I/0O) bus capable of transferring data
between two ports at up to 100 Mbps, with standards
proposals to go to higher speeds. FC supports
point-to-point, arbitrated loop, and switched topologies.

Fibre Channel-Arbitrated Loop (FC-AL). See
arbitrated loop.

Fibre Channel Protocol (FCP) for small computer
system interface (SCSI). A high-level fibre-channel
mapping layer (FC-4) that uses lower-level fibre-channel
(FC-PH) services to transmit SCSI commands, data,
and status information between a SCSI initiator and a
SCSI target across the FC link by using FC frame and
sequence formats.

field replaceable unit (FRU). An assembly that is
replaced in its entirety when any one of its components
fails. In some cases, a field replaceable unit might
contain other field replaceable units. Contrast with
customer replaceable unit (CRU).

FlashCopy. A premium feature for DS4000 that can
make an instantaneous copy of the data in a volume.

F_port. See fabric port.

FRU. See field replaceable unit.
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GBIC. See gigabit interface converter

gigabit interface converter (GBIC). A transceiver that
performs serial, optical-to-electrical, and
electrical-to-optical signal conversions for high-speed
networking. A GBIC can be hot swapped. See also
small form-factor pluggable.

Global Copy. Refers to a remote logical drive mirror
pair that is set up using asynchronous write mode
without the write consistency group option. This is also
referred to as "Asynchronous Mirroring without
Consistency Group.” Global Copy does not ensure that
write requests to multiple primary logical drives are
carried out in the same order on the secondary logical
drives as they are on the primary logical drives. If it is
critical that writes to the primary logical drives are
carried out in the same order in the appropriate
secondary logical drives, Global Mirroring should be
used instead of Global Copy. See also asynchronous
write mode, Global Mirroring, remote mirroring, Metro
Mirroring.

Global Mirroring. Refers to a remote logical drive
mirror pair that is set up using asynchronous write mode
with the write consistency group option. This is also
referred to as "Asynchronous Mirroring with Consistency
Group.” Global Mirroring ensures that write requests to
multiple primary logical drives are carried out in the
same order on the secondary logical drives as they are
on the primary logical drives, preventing data on the
secondary logical drives from becoming inconsistent
with the data on the primary logical drives. See also
asynchronous write mode, Global Copy, remote
mirroring, Metro Mirroring.

graphical user interface (GUI). A type of computer
interface that presents a visual metaphor of a real-world
scene, often of a desktop, by combining high-resolution
graphics, pointing devices, menu bars and other menus,
overlapping windows, icons, and the object-action
relationship.

GUI. See graphical user interface.
HBA. See host bus adapter.

hdisk. An AIX term representing a logical unit number
(LUN) on an array.

host. A system that is directly attached to the storage
subsystem through a fibre-channel input/output (1/0)
path. This system is used to serve data (typically in the
form of files) from the storage subsystem. A system can
be both a storage management station and a host
simultaneously.

host bus adapter (HBA). An interface between the
fibre-channel network and a workstation or server.

host computer. See host.

host group. An entity in the storage partition topology
that defines a logical collection of host computers that
require shared access to one or more logical drives.

host port. Ports that physically reside on the host
adapters and are automatically discovered by the
DS4000 Storage Manager software. To give a host
computer access to a partition, its associated host ports
must be defined.

hot swap. To replace a hardware component without
turning off the system.

hub. In a network, a point at which circuits are either
connected or switched. For example, in a star network,
the hub is the central node; in a star/ring network, it is
the location of wiring concentrators.

IBMSAN driver. The device driver that is used in a
Novell NetWare environment to provide multipath
input/output (1/O) support to the storage controller.

IC. See integrated circuit.
IDE. See integrated drive electronics.

in-band. Transmission of management protocol over
the fibre-channel transport.

Industry Standard Architecture (ISA). Unofficial
name for the bus architecture of the IBM PC/XT
personal computer. This bus design included expansion
slots for plugging in various adapter boards. Early
versions had an 8-bit data path, later expanded to 16
bits. The "Extended Industry Standard Architecture”
(EISA) further expanded the data path to 32 bits. See
also Extended Industry Standard Architecture.

initial program load (IPL). The initialization procedure
that causes an operating system to commence
operation. Also referred to as a system restart, system
startup, and boot.

integrated circuit (IC). A microelectronic
semiconductor device that consists of many
interconnected transistors and other components. ICs
are constructed on a small rectangle cut from a silicon
crystal or other semiconductor material. The small size
of these circuits allows high speed, low power
dissipation, and reduced manufacturing cost compared
with board-level integration. Also known as a chip.

integrated drive electronics (IDE). A disk drive
interface based on the 16-bit IBM personal computer
Industry Standard Architecture (ISA) in which the
controller electronics reside on the drive itself,
eliminating the need for a separate adapter card. Also
known as an Advanced Technology Attachment
Interface (ATA).
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Internet Protocol (IP). A protocol that routes data
through a network or interconnected networks. IP acts
as an intermediary between the higher protocol layers
and the physical network.

Internet Protocol (IP) address. The unique 32-bit
address that specifies the location of each device or
workstation on the Internet. For example, 9.67.97.103 is
an IP address.

interrupt request (IRQ). A type of input found on
many processors that causes the processor to suspend
normal processing temporarily and start running an
interrupt handler routine. Some processors have several
interrupt request inputs that allow different priority
interrupts.

IP. See Internet Protocol.

IPL. See initial program load.

IRQ. See interrupt request.

ISA. See Industry Standard Architecture.

Java Runtime Environment (JRE). A subset of the
Java Development Kit (JDK) for end users and
developers who want to redistribute the Java Runtime
Environment (JRE). The JRE consists of the Java virtual
machine, the Java Core Classes, and supporting files.

JRE. See Java Runtime Environment.

label. A discovered or user entered property value that
is displayed underneath each device in the Physical and
Data Path maps.

LAN. See local area network.
LBA. See logical block address.

local area network (LAN). A computer network
located on a user’'s premises within a limited geographic
area.

logical block address (LBA). The address of a logical
block. Logical block addresses are typically used in
hosts’ /0 commands. The SCSI disk command
protocol, for example, uses logical block addresses.

logical partition (LPAR). (1) A subset of a single
system that contains resources (processors, memory,
and input/output devices). A logical partition operates as
an independent system. If hardware requirements are
met, multiple logical partitions can exist within a system.
(2) A fixed-size portion of a logical volume. A logical
partition is the same size as the physical partitions in its
volume group. Unless the logical volume of which it is a
part is mirrored, each logical partition corresponds to,
and its contents are stored on, a single physical
partition. (3) One to three physical partitions (copies).
The number of logical partitions within a logical volume
is variable.

logical unit number (LUN). An identifier used on a
small computer system interface (SCSI) bus to
distinguish among up to eight devices (logical units) with
the same SCSI ID.

loop address. The unique ID of a node in
fibre-channel loop topology sometimes referred to as a
loop ID.

loop group. A collection of storage area network
(SAN) devices that are interconnected serially in a
single loop circuit.

loop port. A node port (N_port) or fabric port (F_port)
that supports arbitrated loop functions associated with
an arbitrated loop topology.

LPAR. See logical partition.
LUN. See logical unit number.
MAC. See medium access control.

management information base (MIB). The
information that is on an agent. It is an abstraction of
configuration and status information.

man pages. In UNIX-based operating systems, online
documentation for operating system commands,
subroutines, system calls, file formats, special files,
stand-alone utilities, and miscellaneous facilities.
Invoked by the man command.

MCA. See micro channel architecture.

media scan. A media scan is a background process
that runs on all logical drives in the storage subsystem
for which it has been enabled, providing error detection
on the drive media. The media scan process scans all
logical drive data to verify that it can be accessed, and
optionally scans the logical drive data also.

medium access control (MAC). In local area
networks (LANSs), the sublayer of the data link control
layer that supports medium-dependent functions and
uses the services of the physical layer to provide
services to the logical link control sublayer. The MAC
sublayer includes the method of determining when a
device has access to the transmission medium.

Metro Mirroring. This term is used to refer to a
remote logical drive mirror pair which is set up with
synchronous write mode. See also remote mirroring,
Global Mirroring.

MIB. See management information base.

micro channel architecture (MCA). Hardware that is
used for PS/2 Model 50 computers and above to
provide better growth potential and performance
characteristics when compared with the original
personal computer design.
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Microsoft Cluster Server (MSCS). MSCS, a feature
of Windows NT Server (Enterprise Edition), supports the
connection of two servers into a cluster for higher
availability and easier manageability. MSCS can
automatically detect and recover from server or
application failures. It can also be used to balance
server workload and provide for planned maintenance.

mini hub. An interface card or port device that
receives short-wave fiber channel GBICs or SFPs.
These devices enable redundant fibre channel
connections from the host computers, either directly or
through a fibre channel switch or managed hub, over
optical fiber cables to the DS4000 Storage Server
controllers. Each DS4000 controller is responsible for
two mini hubs. Each mini hub has two ports. Four host
ports (two on each controller) provide a cluster solution
without use of a switch. Two host-side mini hubs are
shipped as standard. See also host port, gigabit
interface converter (GBIC), small form-factor pluggable
(SFP).

mirroring. A fault-tolerance technique in which
information on a hard disk is duplicated on additional
hard disks. See also remote mirroring.

model. The model identification that is assigned to a
device by its manufacturer.

MSCS. See Microsoft Cluster Server.

network management station (NMS). In the Simple
Network Management Protocol (SNMP), a station that
runs management application programs that monitor
and control network elements.

NMI. See non-maskable interrupt.
NMS. See network management station.

non-maskable interrupt (NMI). A hardware interrupt
that another service request cannot overrule (mask). An
NMI bypasses and takes priority over interrupt requests
generated by software, the keyboard, and other such
devices and is issued to the microprocessor only in
disastrous circumstances, such as severe memory
errors or impending power failures.

node. A physical device that allows for the
transmission of data within a network.

node port (N_port). A fibre-channel defined hardware
entity that performs data communications over the
fibre-channel link. It is identifiable by a unique worldwide
name. It can act as an originator or a responder.

nonvolatile storage (NVS). A storage device whose
contents are not lost when power is cut off.

N_port. See node port.

NVS. See nonvolatile storage.

NVSRAM. Nonvolatile storage random access
memory. See nonvolatile storage.

Object Data Manager (ODM). An AIX proprietary
storage mechanism for ASCII stanza files that are
edited as part of configuring a drive into the kernel.

ODM. See Object Data Manager.

out-of-band. Transmission of management protocols
outside of the fibre-channel network, typically over
Ethernet.

partitioning. See storage partition.

parity check. (1) A test to determine whether the
number of ones (or zeros) in an array of binary digits is
odd or even. (2) A mathematical operation on the
numerical representation of the information
communicated between two pieces. For example, if
parity is odd, any character represented by an even
number has a bit added to it, making it odd, and an
information receiver checks that each unit of information
has an odd value.

PCl local bus. See peripheral component interconnect
local bus.

PDF. See portable document format.

performance events. Events related to thresholds set
on storage area network (SAN) performance.

peripheral component interconnect local bus (PCI
local bus). A local bus for PCs, from Intel, that
provides a high-speed data path between the CPU and
up to 10 peripherals (video, disk, network, and so on).
The PCI bus coexists in the PC with the Industry
Standard Architecture (ISA) or Extended Industry
Standard Architecture (EISA) bus. ISA and EISA boards
plug into an IA or EISA slot, while high-speed PCI
controllers plug into a PCI slot. See also Industry
Standard Architecture, Extended Industry Standard
Architecture.

polling delay. The time in seconds between
successive discovery processes during which discovery
is inactive.

port. A part of the system unit or remote controller to
which cables for external devices (such as display
stations, terminals, printers, switches, or external
storage units) are attached. The port is an access point
for data entry or exit. A device can contain one or more
ports.

portable document format (PDF). A standard
specified by Adobe Systems, Incorporated, for the
electronic distribution of documents. PDF files are
compact; can be distributed globally by e-mail, the Web,
intranets, or CD-ROM; and can be viewed with the
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Acrobat Reader, which is software from Adobe Systems
that can be downloaded at no cost from the Adobe
Systems home page.

premium feature key. A file that the storage
subsystem controller uses to enable an authorized
premium feature. The file contains the feature enable
identifier of the storage subsystem for which the
premium feature is authorized, and data about the
premium feature. See also feature enable identifier.

private loop. A freestanding arbitrated loop with no
fabric attachment. See also arbitrated loop.

program temporary fix (PTF). A temporary solution or
bypass of a problem diagnosed by IBM in a current
unaltered release of the program.

PTF. See program temporary fix.

RAID. See redundant array of independent disks
(RAID).

RAID level. An array’s RAID level is a number that
refers to the method used to achieve redundancy and
fault tolerance in the array. See also array, redundant
array of independent disks (RAID).

RAID set. See array.
RAM. See random-access memory.

random-access memory (RAM). A temporary storage
location in which the central processing unit (CPU)
stores and executes its processes. Contrast with DASD.

RDAC. See redundant disk array controller.

read-only memory (ROM). Memory in which stored
data cannot be changed by the user except under
special conditions.

recoverable virtual shared disk (RVSD). A virtual
shared disk on a server node configured to provide
continuous access to data and file systems in a cluster.

redundant array of independent disks (RAID). A
collection of disk drives (array) that appears as a single
volume to the server, which is fault tolerant through an
assigned method of data striping, mirroring, or parity
checking. Each array is assigned a RAID level, which is
a specific number that refers to the method used to
achieve redundancy and fault tolerance. See also array,
parity check, mirroring, RAID level, striping.

redundant disk array controller (RDAC). (1) In
hardware, a redundant set of controllers (either
active/passive or active/active). (2) In software, a layer
that manages the input/output (1/O) through the active
controller during normal operation and transparently
reroutes 1/Os to the other controller in the redundant set
if a controller or 1/0 path fails.

remote mirroring. Online, real-time replication of data
between storage subsystems that are maintained on
separate media. The Enhanced Remote Mirror Option is
a DS4000 premium feature that provides support for
remote mirroring. See also Global Mirroring, Metro
Mirroring.

ROM. See read-only memory.

router. A computer that determines the path of
network traffic flow. The path selection is made from
several paths based on information obtained from
specific protocols, algorithms that attempt to identify the
shortest or best path, and other criteria such as metrics
or protocol-specific destination addresses.

RVSD. See recoverable virtual shared disk.
SAl. See Storage Array Identifier.

SA Identifier. See Storage Array Identifier.
SAN. See storage area network.

SATA. See serial ATA.

scope. Defines a group of controllers by their Internet
Protocol (IP) addresses. A scope must be created and
defined so that dynamic IP addresses can be assigned
to controllers on the network.

SCSI. See small computer system interface.

segmented loop port (SL_port). A port that allows
division of a fibre-channel private loop into multiple
segments. Each segment can pass frames around as
an independent loop and can connect through the fabric
to other segments of the same loop.

sense data. (1) Data sent with a negative response,
indicating the reason for the response. (2) Data
describing an I/O error. Sense data is presented to a
host system in response to a sense request command.

serial ATA. The standard for a high-speed alternative
to small computer system interface (SCSI) hard drives.
The SATA-1 standard is equivalent in performance to a
10 000 RPM SCSiI drive.

serial storage architecture (SSA). An interface
specification from IBM in which devices are arranged in
a ring topology. SSA, which is compatible with small
computer system interface (SCSI) devices, allows
full-duplex packet multiplexed serial data transfers at
rates of 20 Mbps in each direction.

server. A functional hardware and software unit that
delivers shared resources to workstation client units on
a computer network.

server/device events. Events that occur on the server
or a designated device that meet criteria that the user
sets.
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SFP. See small form-factor pluggable.

Simple Network Management Protocol (SNMP). In
the Internet suite of protocols, a network management
protocol that is used to monitor routers and attached
networks. SNMP is an application layer protocol.
Information on devices managed is defined and stored
in the application’s Management Information Base
(MIB).

SL_port. See segmented loop port.

SMagent. The DS4000 Storage Manager optional
Java-based host-agent software, which can be used on
Microsoft Windows, Novell NetWare, HP-UX, and
Solaris host systems to manage storage subsystems
through the host fibre-channel connection.

SMclient. The DS4000 Storage Manager client
software, which is a Java-based graphical user interface
(GUI) that is used to configure, manage, and
troubleshoot storage servers and expansion units in a
DS4000 storage subsystem. SMclient can be used on a
host system or on a storage management station.

SMruntime. A Java compiler for the SMclient.

SMutil. The DS4000 Storage Manager utility software
that is used on Microsoft Windows, HP-UX, and Solaris
host systems to register and map new logical drives to
the operating system. In Microsoft Windows, it also
contains a utility to flush the cached data of the
operating system for a particular drive before creating a
FlashCopy.

small computer system interface (SCSI). A standard
hardware interface that enables a variety of peripheral
devices to communicate with one another.

small form-factor pluggable (SFP). An optical
transceiver that is used to convert signals between
optical fiber cables and switches. An SFP is smaller
than a gigabit interface converter (GBIC). See also
gigabit interface converter.

SNMP. See Simple Network Management Protocol and
SNMPv1.

SNMP trap event. (1) (2) An event notification sent by
the SNMP agent that identifies conditions, such as
thresholds, that exceed a predetermined value. See
also Simple Network Management Protocol.

SNMPv1. The original standard for SNMP is now
referred to as SNMPv1, as opposed to SNMPv2, a
revision of SNMP. See also Simple Network
Management Protocol.

SRAM. See static random access memory.
SSA. See serial storage architecture.

static random access memory (SRAM). Random
access memory based on the logic circuit know as

flip-flop. It is called static because it retains a value as
long as power is supplied, unlike dynamic random
access memory (DRAM), which must be regularly
refreshed. It is however, still volatile, meaning that it can
lose its contents when the power is turned off.

storage area network (SAN). A dedicated storage
network tailored to a specific environment, combining
servers, storage products, networking products,
software, and services. See also fabric.

Storage Array ldentifier (SAI or SA Identifier). The
Storage Array Identifier is the identification value used
by the DS4000 Storage Manager host software
(SMClient) to uniquely identify each managed storage
server. The DS4000 Storage Manager SMClient
program maintains Storage Array Identifier records of
previously-discovered storage servers in the host
resident file, which allows it to retain discovery
information in a persistent fashion.

storage management station. A system that is used
to manage the storage subsystem. A storage
management station does not need to be attached to
the storage subsystem through the fibre-channel
input/output (1/0O) path.

storage partition. Storage subsystem logical drives
that are visible to a host computer or are shared among
host computers that are part of a host group.

storage partition topology. In the DS4000 Storage
Manager client, the Topology view of the Mappings
window displays the default host group, the defined host
group, the host computer, and host-port nodes. The
host port, host computer, and host group topological
elements must be defined to grant access to host
computers and host groups using logical drive-to-LUN
mappings.

striping. Splitting data to be written into equal blocks
and writing blocks simultaneously to separate disk
drives. Striping maximizes performance to the disks.
Reading the data back is also scheduled in parallel, with
a block being read concurrently from each disk then
reassembled at the host.

subnet. An interconnected but independent segment
of a network that is identified by its Internet Protocol (IP)
address.

sweep method. A method of sending Simple Network
Management Protocol (SNMP) requests for information
to all the devices on a subnet by sending the request to
every device in the network.

switch. A fibre-channel device that provides full
bandwidth per port and high-speed routing of data by
using link-level addressing.

switch group. A switch and the collection of devices
connected to it that are not in other groups.
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switch zoning. See Zzoning.

synchronous write mode. In remote mirroring, an
option that requires the primary controller to wait for the
acknowledgment of a write operation from the
secondary controller before returning a write 1/0 request
completion to the host. See also asynchronous write
mode, remote mirroring, Metro Mirroring.

system name. Device name assigned by the vendor’s
third-party software.

TCP. See Transmission Control Protocol.

TCP/IP. See Transmission Control Protocol/Internet
Protocol.

terminate and stay resident program (TSR
program). A program that installs part of itself as an
extension of DOS when it is executed.

topology. The physical or logical arrangement of
devices on a network. The three fibre-channel
topologies are fabric, arbitrated loop, and point-to-point.
The default topology for the disk array is arbitrated loop.

TL_port. See translated loop port.

transceiver. A device that is used to transmit and
receive data. Transceiver is an abbreviation of
transmitter-receiver.

translated loop port (TL_port). A port that connects
to a private loop and allows connectivity between the
private loop devices and off loop devices (devices not
connected to that particular TL_port).

Transmission Control Protocol (TCP). A
communication protocol used in the Internet and in any
network that follows the Internet Engineering Task Force
(IETF) standards for internetwork protocol. TCP
provides a reliable host-to-host protocol between hosts
in packed-switched communication networks and in
interconnected systems of such networks. It uses the
Internet Protocol (IP) as the underlying protocol.

Transmission Control Protocol/Internet Protocol
(TCP/IP). A set of communication protocols that
provide peer-to-peer connectivity functions for both local
and wide-area networks.

trap. In the Simple Network Management Protocol
(SNMP), a message sent by a managed node (agent
function) to a management station to report an
exception condition.

trap recipient. Receiver of a forwarded Simple
Network Management Protocol (SNMP) trap.
Specifically, a trap receiver is defined by an Internet
Protocol (IP) address and port to which traps are sent.
Presumably, the actual recipient is a software
application running at the IP address and listening to
the port.

TSR program. See terminate and stay resident
program.

uninterruptible power supply. A source of power
from a battery that is installed between a computer
system and its power source. The uninterruptible power
supply keeps the system running if a commercial power
failure occurs, until an orderly shutdown of the system
can be performed.

user action events. Actions that the user takes, such
as changes in the storage area network (SAN), changed
settings, and so on.

worldwide name (WWN). A unique identifier for a
switch on local and global networks.

WORM. See write-once read-many.

write-once read many (WORM). Any type of storage
medium to which data can be written only a single time,
but can be read from any number of times. After the
data is recorded, it cannot be altered.

WWN. See worldwide name.

zoning. (1) In Fibre Channel environments, the
grouping of multiple ports to form a virtual, private,
storage network. Ports that are members of a zone can
communicate with each other, but are isolated from
ports in other zones. (2) A function that allows
segmentation of nodes by address, name, or physical
port and is provided by fabric switches or hubs.
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Index
A

access controller shell 104
add
new hard drives 47
single drive enclosure
final connection 67, 71, 74, 75, 87, 92
first connection 65, 70, 85, 90
second connection 66, 70, 86, 91
storage expansion enclosures 61
storage expansion units
license requirement 1
used hard drives 47
AppWare 38
array
cannot bring online 57
configuration data for drives incomplete 57
RAID-level modification 44
redundancy checking 44
return online 104
arrays, migrating 57
attention 48, 57, 62, 76, 79, 81, 94
automatically reset controllers 48, 49, 73, 77

B

backup
logical drives 54, 81
storage server data 37, 101
bag or container, ESD 95

beginning of drive loop, connect storage expansion

enclosures 68, 88

BootWare 38

bottom of drive loop, connect storage expansion
enclosures 64, 83

C

cable

connections 66, 67, 70, 71, 74, 75, 86, 87, 91, 92

EXP500 to EXP700 7
EXP700 to EXP500 7
new storage expansion enclosures 63
trace connections 82, 100
cabling instructions  xviii
cabling, incorrect 25
cannot bring array online 57
catastrophic failure 44
change fibre channel speed settings 6
change storage server IP address 103
check drive firmware level 43
check for configuration data 48
on newly discovered drives 76
Class A electronic emission notice 108
clear configuration data 73
complete SM SW installation  xviii
compliant state 99
concepts guide  xviii

© Copyright IBM Corp. 2004

Concepts Guide xxv
concurrent firmware download 41
configuration
behavior after replacement 98
data, clear 73
configuration data 53
configurations, fibre channel/SATA intermix 20
configure drives 49
configure storage hardware xviii
configure storage subsystems on host  xviii
connect power  xviii
container or bag, ESD 95
controller
blade, embedded unique identifier 99
drive loop LED 82, 101
firmware download during /0 40
firmware version 37
by machine type 38
by model number 38
by NVSRAM version 38
current 39
firmware, verify level 37, 39, 54, 80, 100
reset automatically 48, 49, 73, 77
shell, accessing 104
controller firmware 38
controller IP addresses 100
Copy Services Guide xxv
copyback, logical drive 44

customize storage partitioning information 54, 80

D

DACstore 98, 100
DCE 44
delete
FlashCopy 81
remote mirror relationships 81
storage partition mappings 80
determine management method  xviii
disable drive migration settings 48, 72
become effective 49
DisableDriveMigration.scr script 50
documentation
DS4000 Storage Manager xxv
related xxiv
download firmware with I/O 41
downloading drive firmware 41
drive displays as unconfigured 76
drive expansion enclosure weight 82
drive firmware
downloading 41
drive firmware download 41
drive firmware levels, determining 34
drive firmware, level 43
drive ID and model, determining 35
drive loop
optimal state 43
pairs, maximum allowable 1
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drive loop (continued)
speed change procedure 6
drive loop pairs, maximum 8
drive loop schemes 25
drive loop state, determine 37
drive loops A and B 64, 65, 69, 70, 84, 85, 89, 90
drive migration
prerequisites 37
settings
disable 48, 72
enable 76
re-enable 48, 73
drives
CRU assembly 55
do not appear marked as Failed 57
do not display 57
maximum allowable 1
remove
configuration data 48
will not spin up 47, 53, 61
DS4000 Problem Determination Guide 100
DS4000 Storage Manager
related documents  xxiv
DS4000 Storage Manager 9
user tasks xxv
DS4000 Storage Manager publications 36
DS4000 Storage Server
firmware 38
NVSRAM 38
profile 38
DS4000 support
Web site 39
DS4100 dual controller replacement with single
controller 97
DS4100 single controller replacement with dual
controller 97
DS4100 Storage Server library  xxii
DS4300
1 Gbps fibre channel drives 61
enclosure IDs 63
Storage Server firmware and NVSRAM 38
Turbo Storage Server firmware and NVSRAM 38
DS4300 Fibre Channel Storage Server library  xxii
DS4300 Storage Server migration 97
DS4400 Storage Server firmware and NVSRAM 38
DS4400 Storage Server library  xxi
DS4500 Fibre Channel Storage Server library  xix
DS4500 Storage Server firmware and NVSRAM 38
dual controller replacement with single controller 97
dual drive loop 1
DVE 44
dynamic
capacity expansion, DCE 44
volume expansion, DVE 44

E

electronic emission Class A notice 108
Electronic emission notices
Australia and New Zealand Class A statement 109

Electronic emission notices (continued)
European Union EMC Directive conformance
statement 109
Federal Communications Commission (FCC)
statement 108
Industry Canada Class A emission compliance
statement 109
Japanese Voluntary Control Council for Interference
(VCCI) statement 110
Taiwanese Class A warning statement 110
United Kingdom telecommunications safety
requirement 109
electrostatic discharge (ESD) bags 56
electrostatic discharge (ESD) procedure 47
electrostatic discharge procedure 44
empty drive icon 57
emulation program, sample 104
EnableDriveMigration.scr script 48, 49, 76
enclosure ID 30
end of drive loop, connect storage expansion
enclosures 64, 83
entittlement, intermix feature 14
environmental service module (ESM) firmware 7
errors
drive enclosure lost redundancy path 64, 65, 69,
70, 84, 85, 89, 90
loss of ESM path redundancy 82, 101
management event log (MEL) 37
out-of-compliance 104
ESD bag or container 82, 95
ESD procedures 44
ESM Fault LED 82, 101
ESM firmware
EXP500 39
EXP700 39
upgrade during I/0 38
version, current 39
version, upgrade 40
version, upgrade during I/O 40
ESM firmware levels 20
ESM firmware levels, determining 34
event logs, interpreting 43
execute script 48, 72, 76

EXP100
ID settings 31

EXP500
and EXP700 in a redundant drive loop pair 5
cabling 7

drive loop pair maximum 8

ESM firmware 39

ID settings 31

ID switch location 62, 83

maximum per drive loop pairs 8
EXP500 and EXP700 enclosure ID settings 32
EXP500 drive expansion enclosure accommodation 97
EXP700

1 Gbps fibre channel drives 61

and EXP500 in a redundant drive loop pair 5

cabling 7

drive loop pair maximum 8

ESM firmware 39
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EXP700 (continued)

ID settings 32

ID switch location 62, 83

maximum per drive loop pairs 8
EXP700 and EXP710 enclosure ID settings 33
EXP700 migration to DS4300 97
expansion enclosure

ID setting 30
expansion enclosure and storage server

compatibility 4

expansion enclosure compatibility, mixed 3
expansion enclosure speed setting 98, 102
expansion enclosures

cabling mixed 7

ESM firmware version 39

ID setting 62, 83, 102

LED state 102

migrate 79

speeds restriction 5
expansion unit enclosure speed setting 83
expansion unit firmware levels, determining 34
expansion units

ID setting 83

migrate 79
external drive enclosure, benefits 3

F

Failed icons 57
false storage server identification, example 102
FAStT200
enclosure IDs 63
HA Storage Server firmware and NVSRAM 38
Storage Server firmware and NVSRAM 38
FAStT500 RAID Controller Enclosure firmware and
NVSRAM 38
FC cabling instructions  xviii
FC HW maintenance and problem determination
guide  xviii
FC planning and integration user’s guide and service
information  xviii
FC storage server installation guide  xviii
FC Worldwide Name (WWN) 96
FCC Class A notice 108
fibre channel
connections cabling 66, 67, 70, 71, 74, 75, 86, 87,
91, 92
drive firmware 41
insert drives 47, 48, 53, 56, 61, 62, 73, 93
remove connection 64, 69, 84, 89
trace cable connections 82, 100
Worldwide Name (WWN) storage 96, 98, 99
fibre channel controller replacement with SATA 97
Fibre Channel/SATA Intermix Premium Feature 21
firmware
compatibility 38
controller 38
controller and NVSRAM levels 54, 80
controller, NVSRAM, and ESM levels 37
current 38
download 104

firmware (continued)
ESM, version by expansion enclosure 39
updates 39
verify controller and NVSRAM levels 100
firmware and NVSRAM
DS4300
Storage Server 38
Turbo Storage Server 38
DS4400 Storage Server 38
DS4500 Storage Server 38
FAStT200
HA Storage Server 38
Storage Server 38
FAStT500 RAID Controller Enclosure 38
firmware download with I/O 41
firmware levels, determining 34
FlashCopy
delete 55, 81, 100
recreate 57, 94, 104
flush I/0 38, 101
flush server-cached I/O 38
force generation SA Identifier 104

G

GBIC 63, 82, 100, 102
generate
new premium feature SAFE keys 95, 104
SA Identifier 104
gigabit interface converter 63, 82, 100, 102
glossary 111
grouping expansion enclosures 5

H

handling static-sensitive devices 44
hard drives
add new 47
add storage expansion enclosures containing 61
add used 47
ID/Model Number 47, 53, 61
migrate 53
newly discovered 73
prerequisites 37
removal 55
will not spin up 47, 53, 61
hardware installation process xviii
hardware maintenance and problem determination xviii
HBA installation and user’s guide  xviii
help
center 43
online 44
prevent data loss 44
host bus adapter installation and user’s guide xviii
host group names, unique 54, 80
host kits, purchase 98
host names, unique 54, 80
host ports, unique 54, 80
HyperTerminal, Private Edition 104
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| listing (continued)
EnableDriveMigration.scr script file 49
:/BOM flush 38, 101 load script 48, 76

Help Center, contact 43 logical drive

. backup 54, 81
:E;\:I]SAN.CDM multi-path software 40 copyback 44

. creation, FlashCopy 44
empty drive 57 .
Failed 57,94, 104 creation, VolumeCopy 44

. dynamic capacity expansion 44
o Subsystem Management window 57, 94, 104 flashcopies, delete 55

. reconstruction 44
conflict LED = 82, 101 segment size modification 44
switch location 62 sparing 44

ID settings 31 e

. synchronization, remote mirror 44
_ID/m_odeI number, hard drive 47, 53, 61 verify name 54
identify

. Loop Initialization Primitive (LIP) 82
1. Gbps FC drives - 47, 53, 61 loss of ESM path redundancy error 82, 101
firmware updates 39

ignore
configuration data setting 48 M
configuration information 72
impact of new storage server
on identification 98 Model 60U 1, 38
on premium features 98 Model 60X 1, 38
IN port 64, 65, 69, 84, 85, 89, 90 Model 6LU 1, 38

incorrect cabling schemes 25 Model 6LX 1, 38
initialize a drive 94 machine type 1740

machine type 1722

insert drives 73, 93 Model 1RU 40
insert fibre channel drives 56 Model 1RX 40
insert SATA drives 56 machine type 1742

Model 1RU 1, 38
Model 1RX 1, 38
Model 90U 1, 38
Model 90X 1, 38
machine type 3542
Model 1RU 1, 38
Model 1RX 1, 38
Model 2RU 1, 38
Model 2RX 1, 38

install and verify SM SW on host and workstation  xviii
install network hardware  xuviii

install storage expansion unit  xviii

install storage server/RAID enclosures in rack xviii
installation and support OS guides  xviii

installation guide, storage server xviii

installation planning  xviii

installation process  xviii

intermix expansion units 6

intermix SATA/fibre channel 14 machine type 3552
intermixed enclosure ID settings 32, 33 Model 1RU 1, 38
intermixing EXP500s and EXP700s 7 Model 1RX 1, 38
intermixing EXP700s and EXP710s 8 machine type 3560
intermixing storage expansion enclosures 2 Model 1RU 40
IP address, change 103 Model 1RX 40
IP addresses 100 make FC connections  xviii
issues, FC/SATA intermix 23 management event log errors 37
map drives 49
maximum
L allowable drives 1

drive expansion enclosures 8
drives per redundant drive loop pair 8
storage expansion enclosures 8

MEL errors 37

menu option
Advanced » Reset Controller 48, 49, 77
Array » Check Redundancy 44
Execute 73,77

LED
controller drive loop 82, 101
expansion enclosure states 102
ID conflict 82, 101
port bypass 82, 101
license requirements 1
limitations, FC/SATA intermix 23
Linux failover adapter driver

- Script 48, 76
; t.m“'t"path software 40 File > Load Script 48, 72, 76
Isting Initialize 57

DisableDriveMigration.scr script file 50 Place » Offline 55, 81, 101
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menu option (continued)

Place » Online 57, 94

Tools » Verify and Execute 48, 49, 73, 77
migrate drives 41
migrate hard drives 53

migrate storage expansion enclosures with drives 79

migrating arrays 57

migrating from 2 Gbps to 1 Gbps configuration 97

migration guide  xviii
migration to DS4300 Storage Server 97
minihub speed, set 102
mix expansion enclosures 5
mix expansion units 6
mixed configuration
EXP500 to EXP700 cabling 7
EXP700 to EXP500 cabling 7
model and product ID, determining 35
model number
DS4000 EXP500
1RU 40
1RX 40
DS4000 EXP700
1RU 40
1RX 40
DS4000 EXP710
710 40
DS4100
100 38
DS4300
60U 1,38
60X 1, 38
DS4300 Single Controller
6LU 1,38
6LX 1,38
DS4300 Turbo
60U 1,38
60X 1, 38
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1RU 1, 38
1RX 1, 38
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90U 1,38
90X 1, 38
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1RU 1, 38
1RX 1, 38
2RU 1, 38
2RX 1,38
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1RU 1, 38
1RX 1, 38
move drives 41
multi-path software
IBMSAN.CDM 40
Linux failover adapter driver 40
RDAC 40
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condition 98

Needs Attention (continued)
state 43
new storage server impact 98
notes, important 108
notices
electronic emission 108
FCC, Class A 108
null modem serial cable 104
NVSRAM
clear codes 99
codes pre-loaded 99
DS4000 Storage Server 38
stores IP addresses 100
verify level 37, 39, 80, 100
version, by controller firmware version 38
NVSRAM and controller firmware
DS4300
Storage Server 38
Turbo Storage Server 38
DS4400 Storage Server 38
DS4500 Storage Server 38
FAStT200
HA Storage Server 38
Storage Server 38
FAStT500 RAID Controller Enclosure 38

)

offline state 57, 81, 93, 101
online help  xviii, 44
online state 57, 94, 104

optimal state 37, 43, 54, 55, 57, 62, 79, 81, 100, 102

orientation

hard drives 56
OUT port 64, 65, 69, 84, 85, 89, 90
out-of-band storage server IP addresses 103
out-of-compliance state 95, 98

P

place drive online 93

port bypass LED 64, 65, 69, 70, 82, 84, 85, 89, 90,

101
post-replacement configuration behavior 98
post-upgrade configuration behavior 98
power on
drive expansion enclosure 6
storage expansion enclosure 6
storage server 6
premium feature
enable status 98, 99
generate new SAFE keys 95, 104
IBM assigns entitlements 98
identifier 98
impact of new storage server on 98
re-enable 98
premium features
enabled as standard 99
prepare for SM SW installation  xviii
prepare network connection  xviii
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prerequisites
adding capacity 37
drive migration 37
prevent
data loss 44, 48, 76
shock 30, 56, 82
procedure
access controller shell 104
add new hard drives 47
add storage expansion enclosures 61
disable drive migration settings 48
electrostatic discharge (ESD) 47
enable drive migration settings 48
flush server-cached I/O 38
migrate hard drives 53
migrate storage expansion enclosures with
drives 79
redeploy original (replaced) storage server 104
save a module profile report 44
save a storage subsystem profile 44
unmount file systems 38
upgrade
storage server 95, 100
procedures, fibre channel/SATA intermix 18
product ID and model, determining 35
profile
DS4000 Storage Server 44
proofs of purchase 95, 99, 101
publications, DS4000 Storage Manager 36
purchase
entittements 1, 95, 98
host kits 95, 98

Q

Quorum disk 101

R

RAID controller enclosure unit installation guide  xviii
RAID-level modification 44
re-enable

drive migration settings 48

premium features 95, 98
Read_Link_Status

function 37, 43
readme file 40, 62, 79, 96
recommended cabling scheme 25
reconstruction, logical drive 44
Recovery Guru 37
redeploy original (replaced) storage server 104
redistributing data 57
redundancy checking 44
redundant disk array controller [RDAC]

multi-path software 40
redundant drive loop pair 1, 8
remote mirror

logical drive synchronization 44

relationships

delete 81, 100
recreate 94, 104

remote mirror (continued)
relationships (continued)
remove 55
remove
configuration data 48
connection 64, 69, 84, 89
drive expansion enclosure 81
drives 54, 82
hard drives 55
out-of-compliance errors 104
remote mirror relationships 55, 81
storage components 47, 53, 61, 79
storage expansion enclosure 81
storage server 100, 102
reordering data 57
replacement servers 96
reset
controllers 49, 72, 104
automatically 73
controllers automatically 77
storage subsystem setting 48, 49
restore a storage subsystem configuration 44

S

SA Identifier 98
force generation 104

SAFE
ID 98
key 101

Premium Feature Identifier 98
safety information iii
SAl 98
SATA
insert drives 53, 56, 93
Worldwide Name (WWN) storage 98, 99
SATA controller replacement with fibre channel 97
Saving a module profile report and state capture
information to help prevent data loss 44
scenarios, fibre channel/SATA intermix 18
schedule upgrades 40, 62, 79, 101
script
DisableDriveMigration.scr 50
editor window 48, 72, 76
EnableDriveMigration.scr 49
execute 48, 72, 76
load 48, 72, 76
server replacements, DS4000 96
set drive expansion enclosure ID 83
set enclosure ID 30
set link speed  xviii
set minihub speed 102
set storage expansion enclosure ID 83
setting
out-of-band storage server IP addresses 103
settings
disable drive migration
become effective 49
drive migration
disable 48, 72
enable 76
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settings (continued)
drive migration (continued)
re-enable 48, 73
expansion enclosure speed 102
fibre channel speed 6
SFP 63, 82, 100, 102
shutdown
drive expansion enclosure 6
storage expansion enclosure 6
storage server 6
single controller replacement with dual controller 97
SM concepts guide  xviii
SM installation and support guide for Linux  xviii
SM installation and support guide for Novell
NetWare  xviii
SM installation and support guide for Windows
2000  xviii
SM installation and support guide for Windows NT  xviii
small form-factor pluggable 63, 82, 100, 102
SMclient 98
software compatibility
Web site 40
software installation process xviii
sparing, logical drive 44
speed restriction
drive expansion enclosure 5
storage expansion enclosure 5
speed settings
drive loop 6
expansion enclosure 102
start server xviii
state
compliant 99
expansion enclosure LED 102
Needs Attention 43
offine 54, 57, 81, 93, 101
online 57, 94, 104
optimal 37, 43, 47, 54, 55, 57, 62, 79, 81, 100, 102
out-of-compliance 95, 98
static IP address
storage 100
static-sensitive devices, handling 44
storage
components removal 79
DS4000 Storage Server profile 38, 44
static IP address 100
Worldwide Name (WWN) 98, 99
Storage Array Identifier 98
storage expansion enclosure weight 82
storage expansion enclosures, intermixing 2
storage expansion unit installation guide  xviii
Storage Manager
installation and support guide 40, 44, 62, 79, 96,
103
installation CD 48, 72, 76
Storage Manager version 8.x drive firmware,
download 43
Storage Manager version 9.10 drive firmware
download 41
Storage Manager version 9.10 drive firmware,
download 41

storage partition mappings
delete 80
storage partitioning definitions, view 57, 94
storage pool, unconfigured capacity 94
storage server
configuration behavior after
redeployment 99
upgrade and replacement 98
configuration migration 44
controller firmware behavior after upgrade 98
controller firmware version 38
false identification example 102
identification 98
physical configuration, alter 47, 53, 61, 79
redeploy 104
status 43
upgrade NVSRAM version 38
storage server and expansion enclosure
compatibility 4
storage server firmware levels, determining 34
storage server installation guide  xviii
storage server replacements 96
storage subsystem
optimal state 43
restore configuration 44
storage subsystem profile
restore 44
save 38, 44
storage 38, 44
striping data 57
Subsystem Management window icon 57
supported replacements, DS4000 96
suspend I/O from hosts during drive firmware
upgrade 41
switches
ID 62
synchronization
remote mirror logical drive 44

T

technical background on storage server controller
firmware behavior 98

terminal emulation program, sample 104

top of drive loop, connect storage expansion
enclosures 68, 88

trace cable connections 82, 100

U

unconfigured capacity storage pool 94
United States electronic emission Class A notice 108
United States FCC Class A notice 108
unmount file systems 38, 54, 81, 101
upgrade
drive firmware 41
ESM firmware 40
schedule 38, 40, 62, 79, 101
storage server 100
important considerations 95
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related documents  xxiv
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verify server operation w/ LEDs  xviii

W

Web site 44
DS4000 documentation 36
DS4000 support 39
software compatibility 40
support 44
weight of drive expansion enclosure 82
window
Client Subsystem Management 44, 64, 65, 69, 70,
82, 84, 85, 89, 90, 101
Enterprise Management 48, 72, 76
Load Script file selection 48, 72, 76
Read_Link_Status 43
Reset Controller 48, 49, 73, 77
script editor 48, 72, 76
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56, 57, 73, 77, 81, 93, 101, 104
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